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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage 
to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices 
referring only to property damage have no safety alert symbol. These notices shown below are graded according to 
the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance 
are required to ensure that the products operate safely and without any problems. The permissible ambient 
conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may 
be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in this 
publication is reviewed regularly and any necessary corrections are included in subsequent editions.
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Information Server - Installation Notes 1
1.1 Licenses

License types 
The following products are available:

Products for PCS 7
The SIMATIC Information Server provides the following products for PCS 7:

Product Order number (MLFB)
Information Server Basic Package 6ES7652-7EX68-2YB0

6ES7652-7EX68-2YH0
Information Server (1 Client) 6ES7652-7YA00-2YB0

6ES7652-7YA00-2YH0
Information Server (3 Clients) 6ES7652-7YB00-2YB0

6ES7652-7YB00-2YH0
Information Server (5 Clients) 6ES7652-7YC00-2YB0

6ES7652-7YC00-2YH0
Information Server Datasource Access (1 Source) 6ES7652-7YE00-2YB0

6ES7652-7YE00-2YH0
Information Server Datasource Access (3 Sources) 6ES7652-7YF00-2YB0

6ES7652-7YF00-2YH0
Upgrade Package Process Historian and Informa‐
tion Server, V9.0 to V9.1

6ES7652-8AX68-2YE0
6ES7652-8AX68-2YH0

Products for WinCC
The SIMATIC Information Server provides the following products for WinCC:

Product Order number (MLFB)
Process Historian und Information Server 2020 SP1,
Software Media Package

6ES7652-7AX68-0YT8
6ES7652-7AX68-0YH8

Note
MLFB numbers
MLFB numbers ending with 2YB0/2YE0/2YT8 are goods deliveries. 
MLFB numbers ending with 2YH0/0YH8 are OSD deliveries (downloads). 

SIMATIC Information Server
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Products for PCS neo
The SIMATIC Information Server provides the following products for PCS neo:

Product Order number (MLFB)
Information Server 6DL8906-0AC10-0AB5
Information Server Client Access 6DL8906-0BC10-0AB5

List of clients
The clients include:
• Any browser when connected to the Information Server

License count for client access
Each active client connection of the Information Server requires a license. The number of clients 
depends on the number of PCs, not on the number of applications that are open on a PC. Even 
when multiple report clients are connected to the Information Server from a PC, only one license 
is required.
Assignment of a client license:
• Connection with the Information Server via Internet browser/Web application
• Use of various URLs which the server cannot identify as one source
Release of a client license:
• Logout from the Web application 
• Inactivity after 20 minutes

Trial license
The setup of the Information Server also installs a trial license. The trial license can be selected 
in the license query.
• 14-day validity
• Start of 14 day period on the day of first use
The trial version becomes a full version when you install a full license. Reinstallation is not 
necessary.

Information Server - Installation Notes
1.1 Licenses
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1.2 System requirement

1.2.1 Checking system requirements

Requirement
You check the requirements on the computer on which the Information Server is installed.

Procedure
1. Check if the hardware requirements for your installation are met.

Hardware requirements for a Process Historian and Information Server installation on a 
system (Page 10)

2. Ensure you are using an approved operating system.
Operating systems (Page 11)

3. Ensure you are using an approved SQL Server.
SQL Server (Page 11)

4. Check which data sources are allowed for use with the Information Server.
Data sources (Page 11)

5. Ensure you are using an approved browser.
Browser (Page 12)

6. Check whether all relevant security settings have been made.
Security settings (Page 12)

7. Check whether all relevant certificates are assigned.
Certificates (Page 15)

Result
The system requirements for an Information Server installation are fulfilled.

Information Server - Installation Notes
1.2 System requirement
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1.2.2 Hardware requirements

1.2.2.1 Hardware requirements for Process Historian and Information Server installation on 
a single system

Definition
Medium Minimal Recommended
CPU INTEL XEON E3-1268L V3; 2.3 

GHz
IPC 647E
MLFB: 6ES7661-0PU57-1RA4
Xeon E-2278GE (8C/16T, 3.3 (4.7) GHz, 16 MB 
cache, TB, AMT)

CPU INTEL XEON E3-1268L V3; 2.3 
GHz

IPC 847E
MLFB: 6ES7661-1PW67-1RA4
Xeon E-2278GE (8C/16T, 3.3 (4.7) GHz, 16 MB 
cache, TB, AMT) 

Work memory (RAM) 16 GB (64-bit operating system) 64 GB (64-bit operating system)
Storage medium ≥ 500 GB SATA 1024 GB SSD M.2 (for operating system and appli‐

cations) 
RAID 5, ~5.7 TB (4 x 1920 GB SSD 2.5" SATA) (for 
transaction log and database)

Note
The hardware requirements are covered by the current SIMATIC industrial PCs.

Sequence of the installation of Process Historian and Information Server on a system
If you want to install Process Historian and Information Server on the same computer, they must 
be installed in the same SQL Server instance. You must install the Process Historian first.

Cleanup of the corrupt Information Server installation
If you did not install the Information Server together with the Process Historian but did so at a 
later time, use the following procedure to clean up the faulty installation:
1. Create a full SQL Server backup of the existing PH database. 

Details are available in the section "Creating a Full PH Database Backup" in the FAQ: Backup 
and restore of a Process Historian database (https://support.industry.siemens.com/cs/
attachments/66579062/66579062_pcs7_ph_backup_restore_en.pdf)
The procedure described there also applies to the SQL Server 2017.
When you use SIMATIC BATCH, the data provided by the batches are backed up separately in 
the Process Historian and must therefore be taken into account during the full backup.

2. Perform a complete new installation of the operating system.
3. Start the general setup and select the installation for Process Historian and Information 

Server.

Information Server - Installation Notes
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4. A new, empty Process Historian database is created. Use the same configuration settings for 
the newly created database. 

5. Once the functionality is completed and verified, restore the previously created SQL Server 
backup of the Process Historian database in Microsoft SQL Server Management Studio. 
Details are available in the section "Restore Historian Storage Database" in the FAQ: Backup 
and restore of a Process Historian database (https://support.industry.siemens.com/cs/
attachments/66579062/66579062_pcs7_ph_backup_restore_en.pdf)

1.2.3 Software requirements

1.2.3.1 Operating systems
Server operating system:

Version Note
Windows Server 2019 64-bit

Desktop operating system:

Version Note
Windows 10 LTSC 1809 or later 64-bit

1.2.3.2 SQL Server
When the SIMATIC Information Server is installed, the Microsoft SQL Server is automatically 
installed.

SQL Server Comment
Microsoft SQL Server 2017 64-bit

1.2.3.3 Data sources

Data source Version
Process Historian 2020 or higher
PCS neo 3.1 or higher
WinCC / PCS 7 OS 7.4 SP1

7.5 SP1
7.5 SP2

PMO 7.4 SP1
7.5 SP1
7.5 SP2

PCS neo Batch 3.1 or higher

Information Server - Installation Notes
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Note
Each data source is only compatible with the most recent update of the corresponding version.

1.2.3.4 Browser

Browser Version Link to the download
Mozilla Firefox Current version Mozilla Firefox Download 

(https://www.mozilla.org/de/
firefox/new/)

Google Chrome Current version Google Chrome Download 
(https://www.google.de/chrome/
browser/desktop/)

Microsoft Edge Current version Integrated

Note
Browser selection
It is recommended to use Google Chrome.

1.2.3.5 Security settings

Settings of the internal firewall for the Information Server
The firewall settings for the Information Server are automatically changed during the setup. The 
changes are listed during the setup and can be saved.

Note
The security settings of the firewall are the basis of the security concept.

Name Protocol Port Recommended manual restrictions
IS Network Discovery UDP 137 No
IS Web Access https TCP 443 No
IS Data Host TCP 49081 Yes, see note
IS DiscoverServiceInstaller UDP 5049 No
Scheduler TCP 49082 Yes, see note

Information Server - Installation Notes
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Note
Note on recommended manual restrictions
Case 1: If the Information Server is installed on the same computer as the Process Historian 
without connection to other external data sources, it is recommended to disable this rule.
Case 2:  If a connection to additional external data sources is planned on which the IS Ready is 
installed, it is recommended that the range of the rule is adjusted so that only the remote IP 
addresses of the data sources are allowed.

When IS Ready is installed on a computer, the following firewall settings are changed:

Name Protocol Port Recommended manual restric‐
tions

IS Ready Update plugin TCP 1200 Yes, see note
IS Ready Archive Plugin TCP 1201 Yes, see note

Note
Note on recommended manual restrictions
Case 1: If IS Ready is installed on the same computer as the Information Server, this rule should 
be disabled.
Case 2: When installing IS Ready on a computer other than the Information Server, it is 
recommended that you adjust the scope of the rule to allow only the remote IP address of the 
Information Server.

Firewall settings when using different subnets
When using different subnets, you need to adapt certain firewall settings accordingly:

Computer Action Name Protocol Port
Process Histori‐
an

Adapt rule PH SQL server port TCP 3723

Process Histori‐
an

Adapt rule PH Discovery Services TCP 5048

Process Histori‐
an

Create new rule IS SQL Server Browsing UDP 1434

Information 
Server

Adapt rule Scheduler TCP 49082

Note
Create the rule on the respective computer.

Information Server - Installation Notes
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1. To modify the rules, open the "Windows Firewall with Advanced Security" dialog. 
2. Go to the corresponding rule and open "Properties > Area" via the shortcut menu. 
3. Select "IP Addresses" under "Remote IP Address".
4. Click "Add...".

Note
Here you can enter the IP addresses or the subnet.

5. Confirm the dialog.

Note
You must manually remove the firewall ports that have been opened by installing Information 
Server and IS-Ready after uninstalling.

Measures for communication on the Internet
Configure the server in such a way that only HTTPS connections are supported. You need a digital 
certificate for the Information Server.
For the communication of the database and application servers in a shared area use a 
demilitarized zone to exchange confidential data.
For the communication of the database and application servers in a shared area use, for 
example, a Private Network Tunnel (VPN), to establish trustworthy communication.

Avoidance of cross-site request forgery for the web server
Avoid working with other applications or services on the Internet. Always immediately log off 
from the application after using the Web server.
More information on IIS security can be found under the following link. IIS security (https://
msdn.microsoft.com/en-us/library/ms172965(v=sql.105).aspx)

Security architecture "defense in depth"
Note the following information from Siemens on the topic "Industrial Security". The Web site 
contains information on the universal protection concept in accordance with recommendations 
of the leading standard for security in industrial automation ISA99/IEC 62443.
Link: Industrial Security  (http://www.industry.siemens.com/topics/global/en/industrial-security/
Pages/default.aspx)

Information Server - Installation Notes
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Mitigation of "Denial of Service" attacks
The SIMATIC Web Configurator activates the dynamic IP security feature of the Microsoft Internet 
Information Services page created for the Information Server to mitigate "Denial of Service" 
attacks on the Information Server. Only up to 50 connections to the site are allowed in total, with 
no more than 2000 requests per connection in 10 seconds. If the request limit is exceeded, 
renewed access is temporarily prevented.

See also
Setting up an HTTPS service in IIS (https://support.microsoft.com/en-us/kb/324069)
Creating a DMZ network with Proxyserver 2.0 (https://support.microsoft.com/en-us/kb/191146)
Creating a VPN connection (https://technet.microsoft.com/en-us/library/
cc726062(v=ws.10).aspx)

1.2.3.6 Certificates
You need a certificate for securing the connection between the server and client.
You have the option of creating a temporary self-signed certificate or importing an existing 
certificate on the computer. You then assign the provided certificate to the corresponding server. 

Creating a self-signed certificate:
1. Open "Start > Control Panel > System and Security > Administration".

The dialog "Administration" opens.
2. Double-click the link "Internet Information Services (IIS) Manager".

The dialog box "Internet Information Services (IIS) Manager" opens.
3. Select the server under "Connections" on the left. 

4. In the overview, double-click the "Server Certificates" feature in the "IIS" area.
5. Select the option "Create a self-signed certificate..." on the right under "Actions…".

The "Create self-signed certificate..." dialog opens.
6. Select the display name for the certificate and confirm the entry with "OK".

The certificate created is located in the overview "Server certificates". 

Importing a certificate
Ensure that a certificate is saved on the computer.
1. Open "Start > Control Panel > System and Security > Administration".

The dialog "Administration" opens.
2. Double-click the link "Internet Information Services (IIS) Manager".

The dialog box "Internet Information Services (IIS) Manager" opens.

Information Server - Installation Notes
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3. Select the server under "Connections" on the left.

4. Double-click the feature "Server certificates" in the overview in the "IIS" area.
5. Select the option "Import..." under "Actions" on the right.

The dialog "Import certificate…" opens.
6. Click "…" .

A dialog opens with which you navigate to the certificate on your computer.
7. Load the certificate into the dialog by double-clicking it and click "OK".

Assigning a certificate
1. Open "Start > Control Panel > System and Security > Administration".

The dialog "Administration" opens.
2. Double-click the link "Internet Information Services (IIS) Manager".

The dialog box "Internet Information Services (IIS) Manager" opens.
3. Select the server under "Connections" on the left.

4. Double-click on "Sites" and select "Siemens".
5. In the area on the right under "Actions > Edit Site" select the option "Bindings…".

The dialog "Site Bindings" opens.
6. Select the HTTPS binding and click "Edit...".

The "Edit Site Binding" dialog opens.
7. Select the corresponding SSL certificate and confirm with "OK".

Exporting a certificate
1. Open "Start > Control Panel > System and Security > Administrative Tools".

The "Administrative Tools" dialog opens.
2. Double-click the "Internet Information Services (IIS) Manager" link.

The "Internet Information Services (IIS) Manager" dialog opens.
3. Select the server under "Connections" on the left.

4. In the overview, double-click the "Server Certificates" feature in the "IIS" area.
5. Right under "Actions", select the "Export…" option.

The "Export certificate…" dialog opens.

Information Server - Installation Notes
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6. Click on the "…" button.
A dialog opens in which you can select the storage location.

7. Confirm the backup.

Note
Reports from SIMATIC Batch
If reports from the SIMATIC Batch Server are to be generated with the Information Server, the 
generated certificate must be exported and imported onto the server or client.

1.2.4 Requirements for installing the Office add-in

Microsoft Office versions
One of the following Microsoft Office versions (including Service Packs of the version) is installed 
on your computer.

Product Note
Microsoft Office 2019 64-bit
Microsoft Office 365 64-bit

Note
Parallel use of different Office versions on one computer is not supported. 

Microsoft Visual Studio Tools for Office Runtime 
The Microsoft Visual Studio Tools for Office Runtime (MS VSTO RT) are installed on your 
computer. 
If you have not yet installed MS VSTO RT, install the program with the same language you have 
selected for the Information Server.

Microsoft.NET Framework
Microsoft.NET Framework 4.8 is installed on your computer. 
If you have not yet installed Microsoft.NET Framework 4.8, install the program with the same 
language you have selected for the Information Server.

Information Server - Installation Notes
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See also
Microsoft Visual Studio Tools for Office Runtime (https://www.microsoft.com/en-US/download/
details.aspx?id=48217)
Microsoft .NET Framework 4.5.1 (https://www.microsoft.com/en-US/download/details.aspx?
id=40779)

1.3 Installation of the Information Server

1.3.1 Installing the Information Server

Requirement
• The required hardware and software requirements for the installation of the Information 

Server are fulfilled.
Check system requirements (Page 9)

• Close all Windows programs before running the setup.
• The specified user information must match on the different systems: PH Server. Password 

changes must be tracked in all systems.

Procedure

Note
Depending on the contents of the installation, you might be prompted to restart one or more 
times during the installation process. 
During the installation process, additional setup dialogs can be opened automatically. If the 
setup does not continue after a while, use the key combination "Alt+Tab" to change the view. 
This is how you check whether there is another setup dialog in the background that requires 
additional input.

1. Start the setup of the Information Server.
Starting the Information Server setup for PCS 7 (Page 19) 
Starting the Information Server setup for PCS neo (Page 20)

2. Configure the Information Server.
Configuring the Information Server (Page 22)

3. Configure the browser settings before using the Information Server.
Configuring browser settings for the Information Server (Page 23)

4. Install the Information Server database.
Installing the Information Server database (Page 25)
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5. Install and configure the IS Ready.
Installing IS Ready (Page 28)
Note
The installation of IS Ready is necessary for PCS 7, OS, WinCC and PH installations. This is 
necessary to connect the data sources in the Information Server.
In the case of a PCS neo or PCS neo Batch installation, IS Ready is only installed on the PH.
We recommend installing IS Ready during the setup of the products specified above as 
standard.

6. Configure a project on the Information Server.
Configuring a project on the Information Server (Page 26)

Result
The Information Server is installed.

1.3.2 Starting the Information Server setup for PCS 7

Requirement
• The required hardware and software requirements for the installation of the Information 

Server are fulfilled.
Check system requirements (Page 9)

• Close all Windows programs before running the setup.
• The specified user information must match on the different systems: PH Server. Password 

changes must be tracked in all systems.

Procedure

Note
Depending on the contents of the installation, you might be prompted to restart one or more 
times during the installation process. 
During the installation process, additional setup dialogs can be opened automatically. If the 
setup does not continue after a while, use the key combination "Alt+Tab" to change the view. 
This is how you check whether there is another setup dialog in the background that requires 
additional input.

1. Start the PCS 7 setup from the DVD "PCS 7 V9.1 SP1".
2. Select the setup language.
3. Read the installation instructions.
4. Accept the license agreement.
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5. Select the installation content.
Note
It is recommended to install the IS Ready as part of the Information Server setup. 
If you want to install Process Historian and Information Server on a system, use the 
installation package "Process Historian and Information Server".

6. Accept the license agreement.
7. Accept the changes to the system settings.
8. After completion, conclude the setup with a restart.

Result
The setup of the Information Server is started. The "SIMATIC Web Configurator" dialog open.

1.3.3 Starting the Information Server setup for PCS neo

Requirement
• The required hardware and software requirements for the installation of the Information 

Server are fulfilled.
Check system requirements (Page 9)

• Close all Windows programs before running Setup.
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• The specified user information must match on the different systems: PH Server. Password 
changes must be tracked in all systems.

• Before manually installing the Process Historian/Information Server, the target computer 
must be configured in the Administration Console:
Note
Configuration of the target computer in the Administration Console 
Before manually installing the Process Historian/Information Server, the target computer 
must be configured in the Administration Console: 
1. Install AC Agent via "AdditionalProducts\AC Agent" of the PCS neo setup or a remote 

installation of the AC agent from the AC Server to the Process Historian-Server/
Information Server.

2. Add the Process Historian Server/Information Server to the Administration Console.
3. Create an AC server certificate for the Process Historian Server/Information Server.
To do so, follow the instructions in the PUD for the Administration Console: 
• Administration > SIMATIC PCS neo Administration Console > Getting Started > Use cases 

> Create setup definition for AC agent
• Administration > SIMATIC PCS neo Administration Console > Communication > Adding 

target computer to AC
• Administration > SIMATIC PCS neo Administration Console > Communication > Use cases 

> Create certificate for target computer
After successful local installation of Process Historian/Information Server, perform the 
following advanced steps in the Administration Console:
1. Connect the PH/IS computer to the UMC domain.
2. Determine the inventory data for the PH/IS computer.
3. Update the distribution of the configuration.
Follow the instructions in the PUD: "Administration > SIMATIC PCS neo Administration 
Console > Inventory > Inventory of target computers"

Procedure

Note
Depending on the contents of the installation, you might be prompted to restart one or more 
times during the installation process. 
During the installation process, additional setup dialogs can be opened automatically. If the 
setup does not continue after a while, use the key combination "Alt+Tab" to change the view. 
This is how you check whether there is another setup dialog in the background that requires 
additional input.
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1. In the PCS neo setup, select the installation of the Information Server in the module 
overview: "SIMATIC PCS neo Information Server".
Note
Selecting installation contents
Only a combined installation of the Process Historian and Information Server is released for 
PCS neo.

2. Select the setup language.
3. Select the installation content.
4. Accept the license agreement.
5. Accept the changes of the system settings.
6. After completion, conclude the setup with a restart.

Result
The setup of the Information Server is started. The "SIMATIC Web Configurator" dialog open.

1.3.4 Configuring the Information Server

Requirement
• The required hardware and software requirements for the installation of the Information 

Server are fulfilled.
• Close all Windows programs before running the setup.
• The specified user information must match on the different systems: PH Server. Password 

changes must be tracked in all systems.
• Installation of the Information Server in combination with PCS neo requires a configuration 

of the target computer in the Administration Console. 

Configuration
1. The "SIMATIC Web Configurator" dialog opens.

You see an overview of the configuration procedure.
The "IIS configuration" dialog opens.

2. In the "IIS Configuration" dialog, enter a name under "Application name" or accept the pre-
selection, "Information Server".
Note
Upgrade installation
If an installation has already been performed on this computer, a dialog opens with which 
you can skip steps 2-4.
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3. In the "IIS Configuration" dialog, select the option: "Create a virtual directory":
Note
Do not change the default.

4. Confirm with "OK". 
5. Enter a user name and password in the "Change Service Account" dialog.

Leave option enabled if you want the user information to be used for all services.
Note
The user must have local administrator rights and be a system administrator on the local SQL 
Server instance.
If the computer is part of a domain, the user must be a domain user; otherwise a local user 
must be used.

6. Confirm with "Log on as".
7. After completing the configuration, restart the computer.

Result
The Information Server configuration is complete.

1.3.5 Configuring browser settings for the Information Server

Requirement
• The required hardware and software requirements for the installation of the Information 

Server are fulfilled.
• Close all Windows programs before running the setup.
• The specified user information must match on the different systems: PH Server. Password 

changes must be tracked in all systems.
• The user that you log on to the "Change Service Account" dialog during configuration must 

have the following rights for each of the following services:
– Information Server Scheduler: Access to the WebHost database, access to the configured 

data sources (e.g. PH), permissions to send e-mails
– Information Server DataHost Service: Access to the configured data sources (e.g. PH)
– InfSrvPool:  Access to the WebHost database, access to the configured data sources (e.g. 

PH)
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Browser settings
Adapt the settings of your browser for the Information Server . 

Note
Do not change the following settings until after the initial commissioning of the Information 
Server.

1. Open the "Internet options" dialog from the Start menu.
2. In the "Internet Properties" dialog, select the "Security" tab. 
3. For the current zone, disable the "Enable Protected Mode" setting. 
4. Select the "Trusted sites" > "Sites" zone. 
5. Add the following web page to the "Web pages" list: "https://<Common Name (CN) of the 

X.509 certificate>". 
Note
Common Name of the certificate
1. Open the "Internet Information Services (IIS) Manager".
2. Under "Connections" "Sites", select the "Siemens" site.
3. Select "Edit Site" > "Bindings".
4. In the "Site bindings" dialog, select the https connection and select "Edit".
5. Select the SSL certificate and select "View".
6. The Common Name can be found in the "Details" > "Subject" tab.

6. Select "Custom Level".
7. Under "User Authentication > Logon" in the "Security Settings" dialog, select the "Automatic 

logon with user name and password" option.

Note
HTTP Proxy
This configuration must be performed additionally for all computers that require an HTTP proxy 
and use the Information Server web application or the Information Server Excel add-in.
1. Open the "Internet options" dialog from the Start menu.
2. In the "Internet Properties" dialog, select the "Connections" tab. 
3. Select "LAN Settings".
4. Activate the option "Proxy server". 
5. Select "Advanced".
6. For "Exceptions", enter the complete FQDN name of the Information Server computer.

This name must match the CN of the HTTPS certificate (see above).
7. Confirm your entry.

Information Server - Installation Notes
1.3 Installation of the Information Server

SIMATIC Information Server
24 System Manual, 02/2022, A5E51661636-AA



Result
The browser settings are configured.

1.3.6 Installing the Information Server database

Requirement
• The required hardware and software requirements for the installation of the Information 

Server are fulfilled.
• Close all Windows programs before running the setup.
• The specified user information must match on the different systems: PH Server. Password 

changes must be tracked in all systems.
• The browser settings must have been defined correctly.
• The user that you log on to the "Change Service Account" dialog during configuration must 

have the following rights for each of the following services:
– Information Server Scheduler: Access to the WebHost database, access to the configured 

data sources (e.g. PH), permissions to send e-mails
– Information Server DataHost Service: Access to the configured data sources (e.g. PH)
– InfSrvPool:  Access to the WebHost database, access to the configured data sources (e.g. 

PH)

Installation of the Information Server database
1. Open the browser.
2. Enter the previously defined URL in the browser bar or use the Information Server shortcut on 

the desktop
The Information Server web application opens.

3. From the drop-down list, select a Microsoft SQL Server instance in which the Information 
Server stores its data.
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4. Select an option: 
– Enter a database file path

Note
Enter a database file path
If you want to select a location, select the "Enter database file path" option and add the 
destination path.
If you do not select a storage location, the database files are stored by default in the SQL 
directory "Data" (e.g. C:\Program Files\Microsoft SQL Server\MSSQL14.HISTORIAN\MSSQL
\DATA). 

– Enter a path to migration files
Note
Select the folder where you saved the backup files using the IS Backup tool.
Create backup files for migration (Page 37)

5. Confirm with "Install or update".
6. When the installation is complete, select "Continue".
7. Add a project.

Add project (Page 215) (SIMATIC Information Server > Functions > Web application > 
Administration > Project configuration > Step by step instructions > Add project)

Result
A database is installed on the Information Server.

1.3.7 Configuring a project in the Information Server

Requirement
• The required hardware and software requirements for the installation of the Information 

Server are fulfilled.
• Close all Windows programs before running the setup.
• The specified user information must match on the different systems: PH Server. Password 

changes must be tracked in all systems.
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• During the initial installation, the "Automatic logon with user name and password" option 
must be selected in your browser under "Options > Internet Options > Security > Privacy Level 
> User Authentication > Logon".

• The user that you log on to the "Change Service Account" dialog during configuration must 
have the following rights for each of the following services:
– Information Server Scheduler: Access to the WebHost database, access to the configured 

data sources (e.g. PH), permissions to send e-mails
– Information Server DataHost Service: Access to the configured data sources (e.g. PH)
– InfSrvPool:  Access to the WebHost database, access to the configured data sources (e.g. 

PH)

Project configuration in the Information Server
1. Open the administration area of the web application.
2. Open the project configuration.
3. Select "Add project".
4. Select the data source type of the project you want to add and confirm with "Continue".
5. Enter the "Host name" or the "Server IP" with which you want to connect.
6. Select "Select projects".
7. Select the projects you want to add and enter their names.

Note
SIMATIC PCS neo host name 
Enter here the FQDN name of the PCS neo Engineering station which is used in the PCS neo 
Portal certificate so that you can switch to the Information Server in the PCS neo Engineering 
Portal.
If this name is not entered correctly, the Information Server cannot be successfully integrated 
into the portal.

8. Select "Add".

Result
A project is configured in the Information Server.
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1.3.8 Installing Information Server Ready
It is recommended to install the IS Ready during the installation in the setup.

Note
Configuration of the IS Ready
The configuration of the IS Ready must be performed in any case.

It is only necessary to install IS Ready manually/later if the service was not selected during the 
setup.

The IS Ready service is required for:
• Direct connection of WinCC (non-redundant): IS Ready is only installed on WinCC.
• Direct connection of WinCC (redundant): IS Ready is installed on every WinCC computer.
• Direct connection of a PCS 7 project: IS Ready is installed on every OS.
• Indirect connection of WinCC or PCS 7 projects via the PH as long-term archive: IS Ready is 

installed on the PH, installation on WinCC or PCS 7 OS computers is not necessary.
• Indirect connection of PCS neo via the PH as long-term archive (direct connection is planned, 

but not yet possible at this time): IS Ready is only installed on the PH, installation on PCS neo 
itself is not possible.

• Connection of PCS 7 Batch via the PH: IS Ready is only installed on the PH.
• Connection of PCS neo Batch via the PH: IS Ready is only installed on the PH.

Requirement
• The required hardware and software requirements for the installation of the Information 

Server are fulfilled.
• Close all Windows programs before running the setup.
• The specified user information must match on the different systems. Password changes must 

be tracked in all systems.
• For using IS Ready: The IS Ready Service user must be a Windows administrator and be 

created as system administrator on the SQL Server instance.

Manual post-installation of the Information Server Ready 

Note
It is only necessary to install IS Ready manually later if the service was not selected during the 
setup.

1. Open the "ISReady\Setup" directory on your installation medium. 
2. Select the "Start.exe" file of the component to be installed.
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3. Select the language.
4. Read the installation instructions.
5. Accept the license agreement.
6. Select the installation content.

You see an overview of the setup for the installation process.
7. The installation is completed.

Restart the system now or at a later time.

Configuration of the IS Ready
1. Open "Start > All Programs > Siemens Automation > SIMATIC > IS Ready".
2. Select "IS Ready Configuration".

The "IS Ready Configurator" opens.
3. Select "Next".
4. Enter your logon information.

You see an overview of the setup for the installation process.
5. Select "Finish".

Note
Check the configuration
The configuration was successful if you have been assigned to the "SIMATIC Reporting 
Services" group under "Local Users and Groups" on your computer.

Result
Information Server Ready is installed.

1.3.9 Installing Information Server Batch Reports for PCS 7

Requirement
The latest version of the Information Server is installed on the PC.

Procedure
1. Start the PCS 7 setup from the DVD "PCS 7 V9.1 SP1".
2. Select the setup language. 
3. Read the installation instructions. 
4. Accept the license agreement. 
5. Select the installation content: "Custom installation".
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6. In the "Archiving and Reporting" category, select the "Information Server Batch Reports" 
component.

7. Accept the license agreement. 
8. Accept the changes to the system settings. 
9. After completion, conclude the setup with a restart.

Result
The Information Server Batch Reports component is installed.

1.4 Installation of the Office Add-In Excel

1.4.1 Installing Office add-in

Requirement
You are a member of the Windows user group SIMATIC Report Administrators.

Procedure
Install the Office add-in with the setup or from the web application.
Installing Office add-in with setup (Page 31)
Installing Office add-in with the web application (Page 32)

Note
HTTP Proxy
This configuration must be performed additionally for all computers that require an HTTP proxy 
and use the Information Server web application or the Information Server Excel add-in.
1. Open the "Internet options" dialog from the Start menu.
2. In the "Internet Properties" dialog, select the "Connections" tab. 
3. Select "LAN Settings".
4. Activate the option "Proxy server". 
5. Select "Advanced".
6. For "Exceptions", enter the complete FQDN name of the Information Server computer.

This name must match the CN of the HTTPS certificate (see above).
7. Confirm your entry.

Result
The Office add-in has been installed.
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1.4.2 Installing Office add-in with setup

Requirement
You are a member of the Windows user group SIMATIC Report Administrators.

Procedure
1. Check if all requirements for installing the add-in are met.

Requirements for installing the Office add-in (Page 57)
Note
Close all Windows programs before running setup for the Office add-in.

2. Perform the setup for the installation of the add-in.
3. Select the Office add-in as installation content.
4. Select the setup language. 
5. Select the installation content. 
6. Accept the license agreement. 
7. Accept the changes to the system settings. 
8. After completion, conclude the setup with a restart.
9. Connect the Office add-in to the Information Server.

Connecting Office add-in with a stored certificate to the Information Server (Page 73)

Note
HTTP Proxy
This configuration must be performed additionally for all computers that require an HTTP proxy 
and use the Information Server web application or the Information Server Excel add-in.
1. Open the "Internet options" dialog from the Start menu.
2. In the "Internet Properties" dialog, select the "Connections" tab. 
3. Select "LAN Settings".
4. Activate the option "Proxy server". 
5. Select "Advanced".
6. For "Exceptions", enter the complete FQDN name of the Information Server computer.

This name must match the CN of the HTTPS certificate (see above).
7. Confirm your entry.

Result
The Office add-in has been installed.
Opening an Office add-in (Page 227)
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See also
Starting the Information Server setup for PCS 7 (Page 19)
Starting the Information Server setup for PCS neo (Page 20)

1.4.3 Installing Office add-in with the web application

Requirement
You are a member of the Windows user group SIMATIC Report Administrators.

Procedure
1. Check if all requirements for installing the add-in are met.

Requirements for installing the Office add-in (Page 17)
Note
Close all Windows programs before running setup for the Office add-in.

2. Download the Office add-in from the Web application.
Downloading the Office add-in from the Web application (Page 33)

3. Perform the setup for the installation of the add-in.
4. Connect the Office add-in to the Information Server.

Connecting Office add-in with a stored certificate to the Information Server (Page 33)

Result
The Office add-in has been installed.
Opening an Office add-in (Page 227)

Note
HTTP Proxy
This configuration must be performed additionally for all computers that require an HTTP proxy 
and use the Information Server web application or the Information Server Excel add-in.
1. Open the "Internet options" dialog from the Start menu.
2. In the "Internet Properties" dialog, select the "Connections" tab. 
3. Select "LAN Settings".
4. Activate the option "Proxy server". 
5. Select "Advanced".
6. For "Exceptions", enter the complete FQDN name of the Information Server computer.

This name must match the CN of the HTTPS certificate (see above).
7. Confirm your entry.
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1.4.4 Download Office add-in from the Web application

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• The requirements for installing the Office add-in are met.

Procedure
1. Open the "Download" app in the web application.  
2. Select "Download".

Result
The Office add-in has been downloaded.

1.4.5 Connecting Office add-in with a stored certificate to the Information Server

Requirement
• One of the approved Microsoft Office versions is installed on your computer.
• The Information Server is installed.
• The Office add-in has been downloaded. 
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

Procedure
1. Save the certificate in the folder "Trusted roots certification authorities".
2. Open Microsoft Excel.
3. Navigate to the "Information Server" tab.
4. In the "Configuration" area, select "Server".

The "Server settings" dialog opens.
5. Enter the URL of the Information Server.
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6. Select the port corresponding to that of the Information Server.
7. Confirm the dialog.

A logon dialog for authentication dialog opens.
8. Enter your logon data and confirm the dialog with "OK".

Note
Repeat this process for each Office add-in that you use to create and edit reports.
The last five server connections are stored in order of their use. In the "Server Settings" dialog, 
you can check the server settings or select another server. 

Result
The add-in is connected to the Information Server.
In the Excel Office add-in, the connection status is visible in the footer.

Note
No connection to the Information Server
If there is no connection to the Information Server, check if an appropriate license is available or 
if there are network problems. If necessary, repeat the connection procedure. 
If there is no existing connection to the Information Server, the commands in the quick access 
toolbar are not enabled. 

1.5 Upgrade installation of the Information Server

1.5.1 Overview of the upgrade installation for PCS 7
You can upgrade a previous version of the Information Server to the current version using the 
upgrade installation.

Note
Order of the software update of PCS 7 and Process Historian
You need to update the Process Historian server to the corresponding Process Historian version 
of the new PCS 7 version first before you update the PCS 7 plant.
In this context, also observe the instructions "SIMATIC Process Control System PCS 7 Software 
update" with the section "How to update the Process Historian and Information Server".
SIMATIC Process Control System PCS 7 Software update (https://support.industry.siemens.com/
cs/document/109767557/simatic-process-control-system-pcs-7-software-update-with-
utilization-of-new-functions-v9-0-sp2?dti=0&lc=en-WW)
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Procedure of the upgrade installation
Depending on the installed version, the upgrade installation may need to take place via 
intermediate versions, as shown in the following table:

From version Via version To version
2014 SP3 2014 SP3 Update 6 2020 SP2
2014 SP3 Update 1 2014 SP3 Update 6 2020 SP2
2014 SP3 Update 2 2014 SP3 Update 6 2020 SP2
2014 SP3 Update 3 2014 SP3 Update 6 2020 SP2
2014 SP3 Update 4 2014 SP3 Update 6 2020 SP2
2014 SP3 Update 5 2014 SP3 Update 6 2020 SP2
2014 SP3 Update 6 - 2020 SP2
2020 - 2020 SP2
2020 SP1 - 2020 SP2

Note
After the upgrade installation, check the settings of the "Information Server Ready" component 
(IS-ready).

Installation of the upgrade
To upgrade the Information Server , follow the instructions in the Information Server Installation 
Notes. 
Upgrading Information Server (Page 36)

Install the upgrade on all computers on which the following components are installed: 
• Information Server
• IS-ready component of the Information Server
• Information Server Office add-in
• Information Server Batch

Uninstalling the update
The upgrade cannot be uninstalled.

1.5.2 Overview of the upgrade installation for PCS neo
You can upgrade a previous version of the Information Server to the current version using the 
upgrade installation.
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Procedure of the upgrade installation
Depending on the installed version, the upgrade installation may need to take place via 
intermediate versions, as shown in the following table:

From version Via version To version
2020 Update 1 2020 Update 2 2020 SP2
2020 Update 2 - 2020 SP2

Note
After the upgrade installation, check the settings of the "Information Server Ready" component 
(IS-ready).

Installation of the upgrade
To upgrade the Information Server , follow the instructions in the Information Server Installation 
Notes. 
Upgrading Information Server (Page 36)

Install the upgrade on all computers on which the following components are installed: 
• Information Server
• IS-ready component of the Information Server
• Information Server Office add-in
• Information Server Batch

Uninstalling the update
The upgrade cannot be uninstalled.

1.5.3 Upgrading Information Server
You can upgrade a previous version of the Information server to the current version using the 
upgrade installation.

Requirement
• The backup files for the migration have been created with the IS Backup Tool (only necessary 

when changing the operating system or new hardware).
Create backup files for migration (Page 37)

• The data sources have been upgraded.
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• The IS Ready was installed again after the PH was upgraded.
• The operating system meets the software requirements.

Operating systems (Page 11)

Procedure
Follow the installation instructions.
Installing the Information Server (Page 18)

Note
Installing the Information Server database
In step 4, store the file path you specified for the backup files for the migration.

Result
The Information Server is updated.

1.5.4 Create backup files for migration
The IS backup tool (Siemens.InformationServer.ISBackup.exe) backs up all files required for a 
migration to the current version of the Information Server. 
The tool is installed with Version 2014 SP3 Update 6 and with all versions from 2020 Update 1 
and is located in the installation directory in the "Tools" folder.

Note
Copy the tool to another computer
If you need the IS Backup tool on another computer, it is necessary to copy the entire "IS Backup" 
folder.

Requirement
A previous version of Information Server is installed (e.g. 2014 SP3 Update 6 or from 2020).
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Procedure
1. As administrator, open the command line/prompt of your computer (e.g. Command Shell, 

DOS).
2. Run the IS Backup tool: 

/backup <"path">
Note
Example: 
Siemens.InformationServer.ISBackup.exe /backup "C:\Test"
Siemens.InformationServer.ISBackup.exe /backup "C:\Test Backup"
File storage
The folder for file storage should be placed on a network drive, if possible.

Result
In the command line/prompt of your computer there is an overview of the exported folders and a 
confirmation if the backup was successful.

The following structure should be displayed in the destination directory: 
IS migration
• Webframe.mdf (database file)
• Webframe_log.ldf (log file)
• RDLs (root directory for the exported report templates)

– MetaData.xml
– Templates (directory)

Public (directory)
     Tags (directory)
     Messages (directory)

– .... (User directories with report templates)

1.5.5 Upgrading Information Server Ready
After the upgrade installation of the Information Server, upgrade all computers of the system on 
which the IS Ready service is installed.

Check the settings of IS Ready after every installation of an update or upgrade.
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Requirement
• The required hardware and software requirements for the installation of the Information 

Server are fulfilled.
• Close all Windows programs before running the setup.
• The specified user information must match on the different systems. Password changes must 

be tracked in all systems.
• For using IS Ready: The IS Ready Service user must be a Windows administrator and be 

created as system administrator on the SQL Server instance.

Upgrading Information Server Ready
1. Open the "ISReady" directory on your installation medium. 
2. Select the "Start.exe" file of the component to be installed.
3. Select the language.
4. Read the installation instructions.
5. Accept the license agreement.
6. Select the installation content.

You see an overview of the setup for the installation process.
7. The installation is completed.

Restart the system now or at a later time.

Configuration of the service

1. Open "Start > All Programs > Siemens Automation > SIMATIC > IS Ready".
2. Select "IS Ready Configuration".

The "IS Ready Configurator" opens.
3. Select "Next".
4. Enter your logon information.

You see an overview of the setup for the installation process.
5. Select "Finish".

Note
Check the configuration
The configuration was successful if you have been assigned to the "SIMATIC Reporting 
Services" group under "Local Users and Groups" on your computer.

Result
The Information Server Ready has been upgraded.
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1.5.6 Upgrading the Information Server Batch Reports for PCS 7

Introduction
If you use the Information Server Batch Reports for PCS 7 to create reports for SIMATIC Batch, you 
need to install the Batch Reports.
Follow the steps below:
1. Installing or upgrading Information Server.
2. Installing or upgrading Information Server Batch Reports.

Requirement
The latest version of the Information Server is installed on the PC.

Procedure
1. Start the setup from the PCS 7 DVD.
2. Follow the instructions of the installation wizard.

Read the License Agreement and the Open Source License Agreement.
3. Select the "Custom installation" type of installation.
4. In the "Archiving and Reporting" category, select the "Information Server Batch Reports" 

component.
5. To complete the installation, reboot the system.

Procedure for upgrading the Information Server

Note
Upgrade installation
Depending on the installed version, the Information Server Batch Reports must be upgraded via 
intermediate versions, as the table in chapter Overview of the upgrade installation for PCS 7 
(Page 34) shows.

1. Insert the PCS 7 DVD.
2. Open the "Additional_Products" folder and re-install the installed Information Server Batch 

Reports .
3. To complete the installation, reboot the system.
4. Configure the Information Server:

– Start the Internet browser as an administrator. 
Enter the URL defined in the browser settings during the installation from step 5.
Configuring browser settings for the Information Server (Page 23)

– Select the report server instance and start the configuration.
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5. When the configuration is complete, start the setup from the PCS 7 DVD.
6. Follow the instructions of the installation wizard.

Read the License Agreement and the Open Source License Agreement.
7. Select the "Custom installation" type of installation.
8. In the "Archiving and Reporting" category, select the "Information Server Batch Reports" 

component.
9. To complete the installation, reboot the system.

Result
The Information Server Batch Reports component has been installed or updated.

1.6 Uninstallation of the Information Server

1.6.1 Uninstalling the Information Server

Requirement
• An Information Server is installed.

Procedure
1. Go to "Control Panel > Programs and Features".
2. Select the item SIMATIC Information Server.
3. Select the "Uninstall" menu command.
4. Accept the uninstallation.

Result
The Information Server is uninstalled.

Note
During uninstallation, no generated reports or the database are deleted.
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Information Server - Release Notes 2
2.1 Security information

Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks.
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security 
concept. Siemens’ products and solutions constitute one element of such a concept.
Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. Such systems, machines and components should only be connected to 
an enterprise network or the internet if and to the extent such a connection is necessary and only 
when appropriate security measures (e.g. firewalls and/or network segmentation) are in place.
For additional information on industrial security measures that may be implemented, please 
visit 
https://www.siemens.com/industrialsecurity (https://www.siemens.com/industrialsecurity). 
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customer’s exposure to cyber 
threats.
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
under 
https://www.siemens.com/industrialsecurity (https://www.siemens.com/industrialsecurity). 

2.2 Release Notes

Contents
These release notes contain important notes for the SIMATIC Information Server and Process 
Historian. The information in these Release Notes takes precedence over statements in the 
manuals and in the online help. Read these Release Notes carefully because they contain useful 
information for you.

2.3 Customer Support

SIMATIC Hotline
You can reach the SIMATIC hotlines at the times specified in the following table. The languages 
of the SIMATIC hotlines are generally German and English. The Authorization Hotline also speaks 
French, Italian or Spanish.
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Technical Support

Nuremberg (GMT + 1:00)
Office hours Mo. - Fr. from 8:00 am - 5:00 pm (CET/CEST)
Phone +49 (0)911 895 7222
Fax +49 (0)911 895 7223
E-mail Support request (https://

support.industry.siemens.com/My/ww/en/requests)

Automation Value Card (AVC)
The Automation Value Card (AVC) provides you with extended technical support, e.g. 24-hour 
availability seven days a week. You can find information about the AVC at the following URL:
Automation Value Card (https://support.industry.siemens.com/cs/sc/2021/automation-value-
card?lc=en-WW)

SIMATIC Customer Online Support
Service and Support
You can find an overview of the support offerings for our products at the following URL:
Online support (https://support.industry.siemens.com/cs/start?lc=en-WW)

Support app
For Siemens support on the go, get the app: 
Support app (https://support.industry.siemens.com/cs/sc/2067/mobile-use-via-app?lc=en-WW)

Documentation
Technical Forum
The Technical Forum supports exchange with other SIMATIC users. You can find it at the 
following URL:
Technical Forum (https://support.industry.siemens.com/tf/)

Technical documentation for SIMATIC products
You can find a guide to the technical documentation offered for the individual SIMATIC products 
and systems at the following URL:
Technical documentation portal (https://support.industry.siemens.com/cs/document/
109742705/documentation?dti=0&lc=en-WW)

FAQ
The following FAQs are available to help you use the Information Server:
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• Creation of report templates for the Information Server based on the Process Historian data 
in the WinCC and PCS 7 environment.
FAQ creation of report templates.  (https://support.industry.siemens.com/cs/document/
64906050/creation-of-report-templates-for-the-information-server-based-on-process-
historian-data-in-the-wincc-und-pcs-7-environment?dti=0&lc=en-US)

• How can you update the SQL Server Reporting Services (SSRS)?
FAQ Update SQL Server Reporting Services (https://support.industry.siemens.com/cs/
document/109748195/what-should-you-watch-out-for-when-installing-simatic-process-
historian-simatic-information-server-2014-sp2-upd3-when-wincc-is-already-installed-?
dti=0&lc=en-US)

• How can you update the SQL Server on at SIMATIC Process Historian/ Information Server?
FAQ Update SQL Server for SIMATIC PH/IS (https://support.industry.siemens.com/cs/
document/109748200/how-do-you-update-the-sql-server-with-simatic-process-historian-
information-server-?dti=0&lc=en-US)

• How can you correctly display Information Server reports in Asian languages under Windows 
10? 
FAQ correct presentation of reports in Asian languages under Windows 10. (https://
support.industry.siemens.com/cs/document/109748197/in-windows-10-how-do-you-
correctly-display-information-server-reports-in-asian-languages-?dti=0&lc=en-US)

Product information
SIMATIC products
You can find general information on SIMATIC products at the following URL:
Overview of SIMATIC products (http://w3.siemens.com/mcms/topics/en/simatic/Pages/
default.aspx)

Information Server
You can find general information about the Information Server at the following URL:
SIMATIC Information Server (http://w3.siemens.com/mcms/automation-software/en/scada-
software/scada-options/simatic-information-server/Pages/Default.aspx)
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SIMATIC Information Server 3
3.1 Security information

Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks.
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security 
concept. Siemens’ products and solutions constitute one element of such a concept.
Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. Such systems, machines and components should only be connected to 
an enterprise network or the internet if and to the extent such a connection is necessary and only 
when appropriate security measures (e.g. firewalls and/or network segmentation) are in place.
For additional information on industrial security measures that may be implemented, please 
visit 
https://www.siemens.com/industrialsecurity (https://www.siemens.com/industrialsecurity). 
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customer’s exposure to cyber 
threats.
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
under 
https://www.siemens.com/industrialsecurity (https://www.siemens.com/industrialsecurity). 

3.2 Installation of the Information Server

3.2.1 Licenses

License types 
The following products are available:

SIMATIC Information Server
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Products for PCS 7
The SIMATIC Information Server provides the following products for PCS 7:

Product Order number (MLFB)
Information Server Basic Package 6ES7652-7EX68-2YB0

6ES7652-7EX68-2YH0
Information Server (1 Client) 6ES7652-7YA00-2YB0

6ES7652-7YA00-2YH0
Information Server (3 Clients) 6ES7652-7YB00-2YB0

6ES7652-7YB00-2YH0
Information Server (5 Clients) 6ES7652-7YC00-2YB0

6ES7652-7YC00-2YH0
Information Server Datasource Access (1 Source) 6ES7652-7YE00-2YB0

6ES7652-7YE00-2YH0
Information Server Datasource Access (3 Sources) 6ES7652-7YF00-2YB0

6ES7652-7YF00-2YH0
Upgrade Package Process Historian and Informa‐
tion Server, V9.0 to V9.1

6ES7652-8AX68-2YE0
6ES7652-8AX68-2YH0

Products for WinCC
The SIMATIC Information Server provides the following products for WinCC:

Product Order number (MLFB)
Process Historian und Information Server 2020 SP1,
Software Media Package

6ES7652-7AX68-0YT8
6ES7652-7AX68-0YH8

Note
MLFB numbers
MLFB numbers ending with 2YB0/2YE0/2YT8 are goods deliveries. 
MLFB numbers ending with 2YH0/0YH8 are OSD deliveries (downloads). 

Products for PCS neo
The SIMATIC Information Server provides the following products for PCS neo:

Product Order number (MLFB)
Information Server 6DL8906-0AC10-0AB5
Information Server Client Access 6DL8906-0BC10-0AB5

List of clients
The clients include:
• Any browser when connected to the Information Server
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License count for client access
Each active client connection of the Information Server requires a license. The number of clients 
depends on the number of PCs, not on the number of applications that are open on a PC. Even 
when multiple report clients are connected to the Information Server from a PC, only one license 
is required.
Assignment of a client license:
• Connection with the Information Server via Internet browser/Web application
• Use of various URLs which the server cannot identify as one source
Release of a client license:
• Logout from the Web application 
• Inactivity after 20 minutes

Trial license
The setup of the Information Server also installs a trial license. The trial license can be selected 
in the license query.
• 14-day validity
• Start of 14 day period on the day of first use
The trial version becomes a full version when you install a full license. Reinstallation is not 
necessary.

3.2.2 System requirement

3.2.2.1 Checking system requirements

Requirement
You check the requirements on the computer on which the Information Server is installed.

Procedure
1. Check if the hardware requirements for your installation are met.

Hardware requirements for a Process Historian and Information Server installation on a 
system (Page 50)

2. Ensure you are using an approved operating system.
Operating systems (Page 51)

3. Ensure you are using an approved SQL Server.
SQL Server (Page 51)

4. Check which data sources are allowed for use with the Information Server.
Data sources (Page 52)
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5. Ensure you are using an approved browser.
Browser (Page 52)

6. Check whether all relevant security settings have been made.
Security settings (Page 52)

7. Check whether all relevant certificates are assigned.
Certificates (Page 55)

Result
The system requirements for an Information Server installation are fulfilled.

3.2.2.2 Hardware requirements

Hardware requirements for Process Historian and Information Server installation on a single system

Definition
Medium Minimal Recommended
CPU INTEL XEON E3-1268L V3; 2.3 

GHz
IPC 647E
MLFB: 6ES7661-0PU57-1RA4
Xeon E-2278GE (8C/16T, 3.3 (4.7) GHz, 16 MB 
cache, TB, AMT)

CPU INTEL XEON E3-1268L V3; 2.3 
GHz

IPC 847E
MLFB: 6ES7661-1PW67-1RA4
Xeon E-2278GE (8C/16T, 3.3 (4.7) GHz, 16 MB 
cache, TB, AMT) 

Work memory (RAM) 16 GB (64-bit operating system) 64 GB (64-bit operating system)
Storage medium ≥ 500 GB SATA 1024 GB SSD M.2 (for operating system and appli‐

cations) 
RAID 5, ~5.7 TB (4 x 1920 GB SSD 2.5" SATA) (for 
transaction log and database)

Note
The hardware requirements are covered by the current SIMATIC industrial PCs.

Sequence of the installation of Process Historian and Information Server on a system
If you want to install Process Historian and Information Server on the same computer, they must 
be installed in the same SQL Server instance. You must install the Process Historian first.
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Cleanup of the corrupt Information Server installation
If you did not install the Information Server together with the Process Historian but did so at a 
later time, use the following procedure to clean up the faulty installation:
1. Create a full SQL Server backup of the existing PH database. 

Details are available in the section "Creating a Full PH Database Backup" in the FAQ: Backup 
and restore of a Process Historian database (https://support.industry.siemens.com/cs/
attachments/66579062/66579062_pcs7_ph_backup_restore_en.pdf)
The procedure described there also applies to the SQL Server 2017.
When you use SIMATIC BATCH, the data provided by the batches are backed up separately in 
the Process Historian and must therefore be taken into account during the full backup.

2. Perform a complete new installation of the operating system.
3. Start the general setup and select the installation for Process Historian and Information 

Server.
4. A new, empty Process Historian database is created. Use the same configuration settings for 

the newly created database. 
5. Once the functionality is completed and verified, restore the previously created SQL Server 

backup of the Process Historian database in Microsoft SQL Server Management Studio. 
Details are available in the section "Restore Historian Storage Database" in the FAQ: Backup 
and restore of a Process Historian database (https://support.industry.siemens.com/cs/
attachments/66579062/66579062_pcs7_ph_backup_restore_en.pdf)

3.2.2.3 Software requirements

Operating systems
Server operating system:

Version Note
Windows Server 2019 64-bit

Desktop operating system:

Version Note
Windows 10 LTSC 1809 or later 64-bit

SQL Server
When the SIMATIC Information Server is installed, the Microsoft SQL Server is automatically 
installed.

SQL Server Comment
Microsoft SQL Server 2017 64-bit
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Data sources
Data source Version
Process Historian 2020 or higher
PCS neo 3.1 or higher
WinCC / PCS 7 OS 7.4 SP1

7.5 SP1
7.5 SP2

PMO 7.4 SP1
7.5 SP1
7.5 SP2

PCS neo Batch 3.1 or higher

Note
Each data source is only compatible with the most recent update of the corresponding version.

Browser
Browser Version Link to the download
Mozilla Firefox Current version Mozilla Firefox Download 

(https://www.mozilla.org/de/
firefox/new/)

Google Chrome Current version Google Chrome Download 
(https://www.google.de/chrome/
browser/desktop/)

Microsoft Edge Current version Integrated

Note
Browser selection
It is recommended to use Google Chrome.

Security settings

Settings of the internal firewall for the Information Server
The firewall settings for the Information Server are automatically changed during the setup. The 
changes are listed during the setup and can be saved.

Note
The security settings of the firewall are the basis of the security concept.
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Name Protocol Port Recommended manual restrictions
IS Network Discovery UDP 137 No
IS Web Access https TCP 443 No
IS Data Host TCP 49081 Yes, see note
IS DiscoverServiceInstaller UDP 5049 No
Scheduler TCP 49082 Yes, see note

Note
Note on recommended manual restrictions
Case 1: If the Information Server is installed on the same computer as the Process Historian 
without connection to other external data sources, it is recommended to disable this rule.
Case 2:  If a connection to additional external data sources is planned on which the IS Ready is 
installed, it is recommended that the range of the rule is adjusted so that only the remote IP 
addresses of the data sources are allowed.

When IS Ready is installed on a computer, the following firewall settings are changed:

Name Protocol Port Recommended manual restric‐
tions

IS Ready Update plugin TCP 1200 Yes, see note
IS Ready Archive Plugin TCP 1201 Yes, see note

Note
Note on recommended manual restrictions
Case 1: If IS Ready is installed on the same computer as the Information Server, this rule should 
be disabled.
Case 2: When installing IS Ready on a computer other than the Information Server, it is 
recommended that you adjust the scope of the rule to allow only the remote IP address of the 
Information Server.

Firewall settings when using different subnets
When using different subnets, you need to adapt certain firewall settings accordingly:

Computer Action Name Protocol Port
Process Histori‐
an

Adapt rule PH SQL server port TCP 3723

Process Histori‐
an

Adapt rule PH Discovery Services TCP 5048
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Computer Action Name Protocol Port
Process Histori‐
an

Create new rule IS SQL Server Browsing UDP 1434

Information 
Server

Adapt rule Scheduler TCP 49082

Note
Create the rule on the respective computer.

1. To modify the rules, open the "Windows Firewall with Advanced Security" dialog. 
2. Go to the corresponding rule and open "Properties > Area" via the shortcut menu. 
3. Select "IP Addresses" under "Remote IP Address".
4. Click "Add...".

Note
Here you can enter the IP addresses or the subnet.

5. Confirm the dialog.

Note
You must manually remove the firewall ports that have been opened by installing Information 
Server and IS-Ready after uninstalling.

Measures for communication on the Internet
Configure the server in such a way that only HTTPS connections are supported. You need a digital 
certificate for the Information Server.
For the communication of the database and application servers in a shared area use a 
demilitarized zone to exchange confidential data.
For the communication of the database and application servers in a shared area use, for 
example, a Private Network Tunnel (VPN), to establish trustworthy communication.

Avoidance of cross-site request forgery for the web server
Avoid working with other applications or services on the Internet. Always immediately log off 
from the application after using the Web server.
More information on IIS security can be found under the following link. IIS security (https://
msdn.microsoft.com/en-us/library/ms172965(v=sql.105).aspx)
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Security architecture "defense in depth"
Note the following information from Siemens on the topic "Industrial Security". The Web site 
contains information on the universal protection concept in accordance with recommendations 
of the leading standard for security in industrial automation ISA99/IEC 62443.
Link: Industrial Security  (https://new.siemens.com/global/en/products/automation/topic-areas/
industrial-security.html)

Mitigation of "Denial of Service" attacks
The SIMATIC Web Configurator activates the dynamic IP security feature of the Microsoft Internet 
Information Services page created for the Information Server to mitigate "Denial of Service" 
attacks on the Information Server. Only up to 50 connections to the site are allowed in total, with 
no more than 2000 requests per connection in 10 seconds. If the request limit is exceeded, 
renewed access is temporarily prevented.

Certificates
You need a certificate for securing the connection between the server and client.
You have the option of creating a temporary self-signed certificate or importing an existing 
certificate on the computer. You then assign the provided certificate to the corresponding server. 

Creating a self-signed certificate:
1. Open "Start > Control Panel > System and Security > Administration".

The dialog "Administration" opens.
2. Double-click the link "Internet Information Services (IIS) Manager".

The dialog box "Internet Information Services (IIS) Manager" opens.
3. Select the server under "Connections" on the left. 

4. In the overview, double-click the "Server Certificates" feature in the "IIS" area.
5. Select the option "Create a self-signed certificate..." on the right under "Actions…".

The "Create self-signed certificate..." dialog opens.
6. Select the display name for the certificate and confirm the entry with "OK".

The certificate created is located in the overview "Server certificates". 

Importing a certificate
Ensure that a certificate is saved on the computer.
1. Open "Start > Control Panel > System and Security > Administration".

The dialog "Administration" opens.
2. Double-click the link "Internet Information Services (IIS) Manager".

The dialog box "Internet Information Services (IIS) Manager" opens.
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3. Select the server under "Connections" on the left.

4. Double-click the feature "Server certificates" in the overview in the "IIS" area.
5. Select the option "Import..." under "Actions" on the right.

The dialog "Import certificate…" opens.
6. Click "…" .

A dialog opens with which you navigate to the certificate on your computer.
7. Load the certificate into the dialog by double-clicking it and click "OK".

Assigning a certificate
1. Open "Start > Control Panel > System and Security > Administration".

The dialog "Administration" opens.
2. Double-click the link "Internet Information Services (IIS) Manager".

The dialog box "Internet Information Services (IIS) Manager" opens.
3. Select the server under "Connections" on the left.

4. Double-click on "Sites" and select "Siemens".
5. In the area on the right under "Actions > Edit Site" select the option "Bindings…".

The dialog "Site Bindings" opens.
6. Select the HTTPS binding and click "Edit...".

The "Edit Site Binding" dialog opens.
7. Select the corresponding SSL certificate and confirm with "OK".

Exporting a certificate
1. Open "Start > Control Panel > System and Security > Administrative Tools".

The "Administrative Tools" dialog opens.
2. Double-click the "Internet Information Services (IIS) Manager" link.

The "Internet Information Services (IIS) Manager" dialog opens.
3. Select the server under "Connections" on the left.

4. In the overview, double-click the "Server Certificates" feature in the "IIS" area.
5. Right under "Actions", select the "Export…" option.

The "Export certificate…" dialog opens.
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6. Click on the "…" button.
A dialog opens in which you can select the storage location.

7. Confirm the backup.

Note
Reports from SIMATIC Batch
If reports from the SIMATIC Batch Server are to be generated with the Information Server, the 
generated certificate must be exported and imported onto the server or client.

3.2.2.4 Requirements for installing the Office add-in

Microsoft Office versions
One of the following Microsoft Office versions (including Service Packs of the version) is installed 
on your computer.

Product Note
Microsoft Office 2019 64-bit
Microsoft Office 365 64-bit

Note
Parallel use of different Office versions on one computer is not supported. 

Microsoft Visual Studio Tools for Office Runtime 
The Microsoft Visual Studio Tools for Office Runtime (MS VSTO RT) are installed on your 
computer. 
If you have not yet installed MS VSTO RT, install the program with the same language you have 
selected for the Information Server.

Microsoft.NET Framework
Microsoft.NET Framework 4.8 is installed on your computer. 
If you have not yet installed Microsoft.NET Framework 4.8, install the program with the same 
language you have selected for the Information Server.

See also
Microsoft Visual Studio Tools for Office Runtime (https://www.microsoft.com/en-US/download/
details.aspx?id=48217)
Microsoft .NET Framework 4.5.1 (https://www.microsoft.com/en-US/download/details.aspx?
id=40779)
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3.2.3 Installation of the Information Server

3.2.3.1 Installing the Information Server

Requirement
• The required hardware and software requirements for the installation of the Information 

Server are fulfilled.
Check system requirements (Page 9)

• Close all Windows programs before running the setup.
• The specified user information must match on the different systems: PH Server. Password 

changes must be tracked in all systems.

Procedure

Note
Depending on the contents of the installation, you might be prompted to restart one or more 
times during the installation process. 
During the installation process, additional setup dialogs can be opened automatically. If the 
setup does not continue after a while, use the key combination "Alt+Tab" to change the view. 
This is how you check whether there is another setup dialog in the background that requires 
additional input.

1. Start the setup of the Information Server.
Starting the Information Server setup for PCS 7 (Page 59) 
Starting the Information Server setup for PCS neo (Page 60)

2. Configure the Information Server.
Configuring the Information Server (Page 62)

3. Configure the browser settings before using the Information Server.
Configuring browser settings for the Information Server (Page 63)

4. Install the Information Server database.
Installing the Information Server database (Page 65)
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5. Install and configure the IS Ready.
Installing IS Ready (Page 67)
Note
The installation of IS Ready is necessary for PCS 7, OS, WinCC and PH installations. This is 
necessary to connect the data sources in the Information Server.
In the case of a PCS neo or PCS neo Batch installation, IS Ready is only installed on the PH.
We recommend installing IS Ready during the setup of the products specified above as 
standard.

6. Configure a project on the Information Server.
Configuring a project on the Information Server (Page 66)

Result
The Information Server is installed.

3.2.3.2 Starting the Information Server setup for PCS 7

Requirement
• The required hardware and software requirements for the installation of the Information 

Server are fulfilled.
Check system requirements (Page 49)

• Close all Windows programs before running the setup.
• The specified user information must match on the different systems: PH Server. Password 

changes must be tracked in all systems.

Procedure

Note
Depending on the contents of the installation, you might be prompted to restart one or more 
times during the installation process. 
During the installation process, additional setup dialogs can be opened automatically. If the 
setup does not continue after a while, use the key combination "Alt+Tab" to change the view. 
This is how you check whether there is another setup dialog in the background that requires 
additional input.

1. Start the PCS 7 setup from the DVD "PCS 7 V9.1 SP1".
2. Select the setup language.
3. Read the installation instructions.
4. Accept the license agreement.
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5. Select the installation content.
Note
It is recommended to install the IS Ready as part of the Information Server setup. 
If you want to install Process Historian and Information Server on a system, use the 
installation package "Process Historian and Information Server".

6. Accept the license agreement.
7. Accept the changes to the system settings.
8. After completion, conclude the setup with a restart.

Result
The setup of the Information Server is started. The "SIMATIC Web Configurator" dialog open.

3.2.3.3 Starting the Information Server setup for PCS neo

Requirement
• The required hardware and software requirements for the installation of the Information 

Server are fulfilled.
Check system requirements (Page 49)

• Close all Windows programs before running Setup.
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• The specified user information must match on the different systems: PH Server. Password 
changes must be tracked in all systems.

• Before manually installing the Process Historian/Information Server, the target computer 
must be configured in the Administration Console:
Note
Configuration of the target computer in the Administration Console 
Before manually installing the Process Historian/Information Server, the target computer 
must be configured in the Administration Console: 
1. Install AC Agent via "AdditionalProducts\AC Agent" of the PCS neo setup or a remote 

installation of the AC agent from the AC Server to the Process Historian-Server/
Information Server.

2. Add the Process Historian Server/Information Server to the Administration Console.
3. Create an AC server certificate for the Process Historian Server/Information Server.
To do so, follow the instructions in the PUD for the Administration Console: 
• Administration > SIMATIC PCS neo Administration Console > Getting Started > Use cases 

> Create setup definition for AC agent
• Administration > SIMATIC PCS neo Administration Console > Communication > Adding 

target computer to AC
• Administration > SIMATIC PCS neo Administration Console > Communication > Use cases 

> Create certificate for target computer
After successful local installation of Process Historian/Information Server, perform the 
following advanced steps in the Administration Console:
1. Connect the PH/IS computer to the UMC domain.
2. Determine the inventory data for the PH/IS computer.
3. Update the distribution of the configuration.
Follow the instructions in the PUD: "Administration > SIMATIC PCS neo Administration 
Console > Inventory > Inventory of target computers"

Procedure

Note
Depending on the contents of the installation, you might be prompted to restart one or more 
times during the installation process. 
During the installation process, additional setup dialogs can be opened automatically. If the 
setup does not continue after a while, use the key combination "Alt+Tab" to change the view. 
This is how you check whether there is another setup dialog in the background that requires 
additional input.
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1. In the PCS neo setup, select the installation of the Information Server in the module 
overview: "SIMATIC PCS neo Information Server".
Note
Selecting installation contents
Only a combined installation of the Process Historian and Information Server is released for 
PCS neo.

2. Select the setup language.
3. Select the installation content.
4. Accept the license agreement.
5. Accept the changes of the system settings.
6. After completion, conclude the setup with a restart.

Result
The setup of the Information Server is started. The "SIMATIC Web Configurator" dialog open.

3.2.3.4 Configuring the Information Server

Requirement
• The required hardware and software requirements for the installation of the Information 

Server are fulfilled.
• Close all Windows programs before running the setup.
• The specified user information must match on the different systems: PH Server. Password 

changes must be tracked in all systems.
• Installation of the Information Server in combination with PCS neo requires a configuration 

of the target computer in the Administration Console. 

Configuration
1. The "SIMATIC Web Configurator" dialog opens.

You see an overview of the configuration procedure.
The "IIS configuration" dialog opens.

2. In the "IIS Configuration" dialog, enter a name under "Application name" or accept the pre-
selection, "Information Server".
Note
Upgrade installation
If an installation has already been performed on this computer, a dialog opens with which 
you can skip steps 2-4.
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3. In the "IIS Configuration" dialog, select the option: "Create a virtual directory":
Note
Do not change the default.

4. Confirm with "OK". 
5. Enter a user name and password in the "Change Service Account" dialog.

Leave option enabled if you want the user information to be used for all services.
Note
The user must have local administrator rights and be a system administrator on the local SQL 
Server instance.
If the computer is part of a domain, the user must be a domain user; otherwise a local user 
must be used.

6. Confirm with "Log on as".
7. After completing the configuration, restart the computer.

Result
The Information Server configuration is complete.

3.2.3.5 Configuring browser settings for the Information Server

Requirement
• The required hardware and software requirements for the installation of the Information 

Server are fulfilled.
• Close all Windows programs before running the setup.
• The specified user information must match on the different systems: PH Server. Password 

changes must be tracked in all systems.
• The user that you log on to the "Change Service Account" dialog during configuration must 

have the following rights for each of the following services:
– Information Server Scheduler: Access to the WebHost database, access to the configured 

data sources (e.g. PH), permissions to send e-mails
– Information Server DataHost Service: Access to the configured data sources (e.g. PH)
– InfSrvPool:  Access to the WebHost database, access to the configured data sources (e.g. 

PH)
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Browser settings
Adapt the settings of your browser for the Information Server . 

Note
Do not change the following settings until after the initial commissioning of the Information 
Server.

1. Open the "Internet options" dialog from the Start menu.
2. In the "Internet Properties" dialog, select the "Security" tab. 
3. For the current zone, disable the "Enable Protected Mode" setting. 
4. Select the "Trusted sites" > "Sites" zone. 
5. Add the following web page to the "Web pages" list: "https://<Common Name (CN) of the 

X.509 certificate>". 
Note
Common Name of the certificate
1. Open the "Internet Information Services (IIS) Manager".
2. Under "Connections" "Sites", select the "Siemens" site.
3. Select "Edit Site" > "Bindings".
4. In the "Site bindings" dialog, select the https connection and select "Edit".
5. Select the SSL certificate and select "View".
6. The Common Name can be found in the "Details" > "Subject" tab.

6. Select "Custom Level".
7. Under "User Authentication > Logon" in the "Security Settings" dialog, select the "Automatic 

logon with user name and password" option.

Note
HTTP Proxy
This configuration must be performed additionally for all computers that require an HTTP proxy 
and use the Information Server web application or the Information Server Excel add-in.
1. Open the "Internet options" dialog from the Start menu.
2. In the "Internet Properties" dialog, select the "Connections" tab. 
3. Select "LAN Settings".
4. Activate the option "Proxy server". 
5. Select "Advanced".
6. For "Exceptions", enter the complete FQDN name of the Information Server computer.

This name must match the CN of the HTTPS certificate (see above).
7. Confirm your entry.
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Result
The browser settings are configured.

3.2.3.6 Installing the Information Server database

Requirement
• The required hardware and software requirements for the installation of the Information 

Server are fulfilled.
• Close all Windows programs before running the setup.
• The specified user information must match on the different systems: PH Server. Password 

changes must be tracked in all systems.
• The browser settings must have been defined correctly.
• The user that you log on to the "Change Service Account" dialog during configuration must 

have the following rights for each of the following services:
– Information Server Scheduler: Access to the WebHost database, access to the configured 

data sources (e.g. PH), permissions to send e-mails
– Information Server DataHost Service: Access to the configured data sources (e.g. PH)
– InfSrvPool:  Access to the WebHost database, access to the configured data sources (e.g. 

PH)

Installation of the Information Server database
1. Open the browser.
2. Enter the previously defined URL in the browser bar or use the Information Server shortcut on 

the desktop
The Information Server web application opens.

3. From the drop-down list, select a Microsoft SQL Server instance in which the Information 
Server stores its data.

SIMATIC Information Server
3.2 Installation of the Information Server

SIMATIC Information Server
System Manual, 02/2022, A5E51661636-AA 65



4. Select an option: 
– Enter a database file path

Note
Enter a database file path
If you want to select a location, select the "Enter database file path" option and add the 
destination path.
If you do not select a storage location, the database files are stored by default in the SQL 
directory "Data" (e.g. C:\Program Files\Microsoft SQL Server\MSSQL14.HISTORIAN\MSSQL
\DATA). 

– Enter a path to migration files
Note
Select the folder where you saved the backup files using the IS Backup tool.
Create backup files for migration (Page 77)

5. Confirm with "Install or update".
6. When the installation is complete, select "Continue".
7. Add a project.

Add project (Page 215) (SIMATIC Information Server > Functions > Web application > 
Administration > Project configuration > Step by step instructions > Add project)

Result
A database is installed on the Information Server.

3.2.3.7 Configuring a project in the Information Server

Requirement
• The required hardware and software requirements for the installation of the Information 

Server are fulfilled.
• Close all Windows programs before running the setup.
• The specified user information must match on the different systems: PH Server. Password 

changes must be tracked in all systems.
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• During the initial installation, the "Automatic logon with user name and password" option 
must be selected in your browser under "Options > Internet Options > Security > Privacy Level 
> User Authentication > Logon".

• The user that you log on to the "Change Service Account" dialog during configuration must 
have the following rights for each of the following services:
– Information Server Scheduler: Access to the WebHost database, access to the configured 

data sources (e.g. PH), permissions to send e-mails
– Information Server DataHost Service: Access to the configured data sources (e.g. PH)
– InfSrvPool:  Access to the WebHost database, access to the configured data sources (e.g. 

PH)

Project configuration in the Information Server
1. Open the administration area of the web application.
2. Open the project configuration.
3. Select "Add project".
4. Select the data source type of the project you want to add and confirm with "Continue".
5. Enter the "Host name" or the "Server IP" with which you want to connect.
6. Select "Select projects".
7. Select the projects you want to add and enter their names.

Note
SIMATIC PCS neo host name 
Enter here the FQDN name of the PCS neo Engineering station which is used in the PCS neo 
Portal certificate so that you can switch to the Information Server in the PCS neo Engineering 
Portal.
If this name is not entered correctly, the Information Server cannot be successfully integrated 
into the portal.

8. Select "Add".

Result
A project is configured in the Information Server.

3.2.3.8 Installing Information Server Ready
It is recommended to install the IS Ready during the installation in the setup.

Note
Configuration of the IS Ready
The configuration of the IS Ready must be performed in any case.
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It is only necessary to install IS Ready manually/later if the service was not selected during the 
setup.

The IS Ready service is required for:
• Direct connection of WinCC (non-redundant): IS Ready is only installed on WinCC.
• Direct connection of WinCC (redundant): IS Ready is installed on every WinCC computer.
• Direct connection of a PCS 7 project: IS Ready is installed on every OS.
• Indirect connection of WinCC or PCS 7 projects via the PH as long-term archive: IS Ready is 

installed on the PH, installation on WinCC or PCS 7 OS computers is not necessary.
• Indirect connection of PCS neo via the PH as long-term archive (direct connection is planned, 

but not yet possible at this time): IS Ready is only installed on the PH, installation on PCS neo 
itself is not possible.

• Connection of PCS 7 Batch via the PH: IS Ready is only installed on the PH.
• Connection of PCS neo Batch via the PH: IS Ready is only installed on the PH.

Requirement
• The required hardware and software requirements for the installation of the Information 

Server are fulfilled.
• Close all Windows programs before running the setup.
• The specified user information must match on the different systems. Password changes must 

be tracked in all systems.
• For using IS Ready: The IS Ready Service user must be a Windows administrator and be 

created as system administrator on the SQL Server instance.

Manual post-installation of the Information Server Ready 

Note
It is only necessary to install IS Ready manually later if the service was not selected during the 
setup.

1. Open the "ISReady\Setup" directory on your installation medium. 
2. Select the "Start.exe" file of the component to be installed.
3. Select the language.
4. Read the installation instructions.
5. Accept the license agreement.
6. Select the installation content.

You see an overview of the setup for the installation process.
7. The installation is completed.

Restart the system now or at a later time.

SIMATIC Information Server
3.2 Installation of the Information Server

SIMATIC Information Server
68 System Manual, 02/2022, A5E51661636-AA



Configuration of the IS Ready
1. Open "Start > All Programs > Siemens Automation > SIMATIC > IS Ready".
2. Select "IS Ready Configuration".

The "IS Ready Configurator" opens.
3. Select "Next".
4. Enter your logon information.

You see an overview of the setup for the installation process.
5. Select "Finish".

Note
Check the configuration
The configuration was successful if you have been assigned to the "SIMATIC Reporting 
Services" group under "Local Users and Groups" on your computer.

Result
Information Server Ready is installed.

3.2.3.9 Installing Information Server Batch Reports for PCS 7

Requirement
The latest version of the Information Server is installed on the PC.

Procedure
1. Start the PCS 7 setup from the DVD "PCS 7 V9.1 SP1".
2. Select the setup language. 
3. Read the installation instructions. 
4. Accept the license agreement. 
5. Select the installation content: "Custom installation".
6. In the "Archiving and Reporting" category, select the "Information Server Batch Reports" 

component.
7. Accept the license agreement. 
8. Accept the changes to the system settings. 
9. After completion, conclude the setup with a restart.

Result
The Information Server Batch Reports component is installed.
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3.2.4 Installation of the Excel Office add-in

3.2.4.1 Installing Office add-in

Requirement
You are a member of the Windows user group SIMATIC Report Administrators.

Procedure
Install the Office add-in with the setup or from the web application.
Installing Office add-in with setup (Page 70)
Installing Office add-in with the web application (Page 71)

Note
HTTP Proxy
This configuration must be performed additionally for all computers that require an HTTP proxy 
and use the Information Server web application or the Information Server Excel add-in.
1. Open the "Internet options" dialog from the Start menu.
2. In the "Internet Properties" dialog, select the "Connections" tab. 
3. Select "LAN Settings".
4. Activate the option "Proxy server". 
5. Select "Advanced".
6. For "Exceptions", enter the complete FQDN name of the Information Server computer.

This name must match the CN of the HTTPS certificate (see above).
7. Confirm your entry.

Result
The Office add-in has been installed.

3.2.4.2 Installing Office add-in with setup

Requirement
You are a member of the Windows user group SIMATIC Report Administrators.
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Procedure
1. Check if all requirements for installing the add-in are met.

Requirements for installing the Office add-in (Page 57)
Note
Close all Windows programs before running setup for the Office add-in.

2. Perform the setup for the installation of the add-in.
3. Select the Office add-in as installation content.
4. Select the setup language. 
5. Select the installation content. 
6. Accept the license agreement. 
7. Accept the changes to the system settings. 
8. After completion, conclude the setup with a restart.
9. Connect the Office add-in to the Information Server.

Connecting Office add-in with a stored certificate to the Information Server (Page 73)

Note
HTTP Proxy
This configuration must be performed additionally for all computers that require an HTTP proxy 
and use the Information Server web application or the Information Server Excel add-in.
1. Open the "Internet options" dialog from the Start menu.
2. In the "Internet Properties" dialog, select the "Connections" tab. 
3. Select "LAN Settings".
4. Activate the option "Proxy server". 
5. Select "Advanced".
6. For "Exceptions", enter the complete FQDN name of the Information Server computer.

This name must match the CN of the HTTPS certificate (see above).
7. Confirm your entry.

Result
The Office add-in has been installed.
Opening an Office add-in (Page 227)

3.2.4.3 Installing Office add-in with the web application

Requirement
You are a member of the Windows user group SIMATIC Report Administrators.
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Procedure
1. Check if all requirements for installing the add-in are met.

Requirements for installing the Office add-in (Page 57)
Note
Close all Windows programs before running setup for the Office add-in.

2. Download the Office add-in from the Web application.
Downloading the Office add-in from the Web application (Page 72)

3. Perform the setup for the installation of the add-in.
4. Connect the Office add-in to the Information Server.

Connecting Office add-in with a stored certificate to the Information Server (Page 73)

Result
The Office add-in has been installed.
Opening an Office add-in (Page 227)

Note
HTTP Proxy
This configuration must be performed additionally for all computers that require an HTTP proxy 
and use the Information Server web application or the Information Server Excel add-in.
1. Open the "Internet options" dialog from the Start menu.
2. In the "Internet Properties" dialog, select the "Connections" tab. 
3. Select "LAN Settings".
4. Activate the option "Proxy server". 
5. Select "Advanced".
6. For "Exceptions", enter the complete FQDN name of the Information Server computer.

This name must match the CN of the HTTPS certificate (see above).
7. Confirm your entry.

3.2.4.4 Download Office add-in from the Web application

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• The requirements for installing the Office add-in are met.
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Procedure
1. Open the "Download" app in the web application.  
2. Select "Download".

Result
The Office add-in has been downloaded.

3.2.4.5 Connecting Office add-in with a stored certificate to the Information Server

Requirement
• One of the approved Microsoft Office versions is installed on your computer.
• The Information Server is installed.
• The Office add-in has been downloaded. 
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

Procedure
1. Save the certificate in the folder "Trusted roots certification authorities".
2. Open Microsoft Excel.
3. Navigate to the "Information Server" tab.
4. In the "Configuration" area, select "Server".

The "Server settings" dialog opens.
5. Enter the URL of the Information Server.
6. Select the port corresponding to that of the Information Server.
7. Confirm the dialog.

A logon dialog for authentication dialog opens.
8. Enter your logon data and confirm the dialog with "OK".

Note
Repeat this process for each Office add-in that you use to create and edit reports.
The last five server connections are stored in order of their use. In the "Server Settings" dialog, 
you can check the server settings or select another server. 
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Result
The add-in is connected to the Information Server.
In the Excel Office add-in, the connection status is visible in the footer.

Note
No connection to the Information Server
If there is no connection to the Information Server, check if an appropriate license is available or 
if there are network problems. If necessary, repeat the connection procedure. 
If there is no existing connection to the Information Server, the commands in the quick access 
toolbar are not enabled. 

3.2.5 Upgrade installation of the Information Server

3.2.5.1 Overview of the upgrade installation for PCS 7
You can upgrade a previous version of the Information Server to the current version using the 
upgrade installation.

Note
Order of the software update of PCS 7 and Process Historian
You need to update the Process Historian server to the corresponding Process Historian version 
of the new PCS 7 version first before you update the PCS 7 plant.
In this context, also observe the instructions "SIMATIC Process Control System PCS 7 Software 
update" with the section "How to update the Process Historian and Information Server".
SIMATIC Process Control System PCS 7 Software update (https://support.industry.siemens.com/
cs/document/109767557/simatic-process-control-system-pcs-7-software-update-with-
utilization-of-new-functions-v9-0-sp2?dti=0&lc=en-WW)

Procedure of the upgrade installation
Depending on the installed version, the upgrade installation may need to take place via 
intermediate versions, as shown in the following table:

From version Via version To version
2014 SP3 2014 SP3 Update 6 2020 SP2
2014 SP3 Update 1 2014 SP3 Update 6 2020 SP2
2014 SP3 Update 2 2014 SP3 Update 6 2020 SP2
2014 SP3 Update 3 2014 SP3 Update 6 2020 SP2
2014 SP3 Update 4 2014 SP3 Update 6 2020 SP2
2014 SP3 Update 5 2014 SP3 Update 6 2020 SP2
2014 SP3 Update 6 - 2020 SP2
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From version Via version To version
2020 - 2020 SP2
2020 SP1 - 2020 SP2

Note
After the upgrade installation, check the settings of the "Information Server Ready" component 
(IS-ready).

Installation of the upgrade
To upgrade the Information Server , follow the instructions in the Information Server Installation 
Notes. 
Upgrading Information Server (Page 36)

Install the upgrade on all computers on which the following components are installed: 
• Information Server
• IS-ready component of the Information Server
• Information Server Office add-in
• Information Server Batch

Uninstalling the update
The upgrade cannot be uninstalled.

3.2.5.2 Overview of the upgrade installation for PCS neo
You can upgrade a previous version of the Information Server to the current version using the 
upgrade installation.

Procedure of the upgrade installation
Depending on the installed version, the upgrade installation may need to take place via 
intermediate versions, as shown in the following table:

From version Via version To version
2020 Update 1 2020 Update 2 2020 SP2
2020 Update 2 - 2020 SP2

Note
After the upgrade installation, check the settings of the "Information Server Ready" component 
(IS-ready).
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Installation of the upgrade
To upgrade the Information Server , follow the instructions in the Information Server Installation 
Notes. 
Upgrading Information Server (Page 76)

Install the upgrade on all computers on which the following components are installed: 
• Information Server
• IS-ready component of the Information Server
• Information Server Office add-in
• Information Server Batch

Uninstalling the update
The upgrade cannot be uninstalled.

3.2.5.3 Upgrading Information Server
You can upgrade a previous version of the Information server to the current version using the 
upgrade installation.

Requirement
• The backup files for the migration have been created with the IS Backup Tool (only necessary 

when changing the operating system or new hardware).
Create backup files for migration (Page 77)

• The data sources have been upgraded.
• The IS Ready was installed again after the PH was upgraded.
• The operating system meets the software requirements.

Operating systems (Page 51)

Procedure
Follow the installation instructions.
Installing the Information Server (Page 58)

Note
Installing the Information Server database
In step 4, store the file path you specified for the backup files for the migration.

Result
The Information Server is updated.
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3.2.5.4 Create backup files for migration
The IS backup tool (Siemens.InformationServer.ISBackup.exe) backs up all files required for a 
migration to the current version of the Information Server. 
The tool is installed with Version 2014 SP3 Update 6 and with all versions from 2020 Update 1 
and is located in the installation directory in the "Tools" folder.

Note
Copy the tool to another computer
If you need the IS Backup tool on another computer, it is necessary to copy the entire "IS Backup" 
folder.

Requirement
A previous version of Information Server is installed (e.g. 2014 SP3 Update 6 or from 2020).

Procedure
1. As administrator, open the command line/prompt of your computer (e.g. Command Shell, 

DOS).
2. Run the IS Backup tool: 

/backup <"path">
Note
Example: 
Siemens.InformationServer.ISBackup.exe /backup "C:\Test"
Siemens.InformationServer.ISBackup.exe /backup "C:\Test Backup"
File storage
The folder for file storage should be placed on a network drive, if possible.

Result
In the command line/prompt of your computer there is an overview of the exported folders and a 
confirmation if the backup was successful.

The following structure should be displayed in the destination directory: 
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IS migration
• Webframe.mdf (database file)
• Webframe_log.ldf (log file)
• RDLs (root directory for the exported report templates)

– MetaData.xml
– Templates (directory)

Public (directory)
     Tags (directory)
     Messages (directory)

– .... (User directories with report templates)

3.2.5.5 Upgrading Information Server Ready
After the upgrade installation of the Information Server, upgrade all computers of the system on 
which the IS Ready service is installed.

Check the settings of IS Ready after every installation of an update or upgrade.

Requirement
• The required hardware and software requirements for the installation of the Information 

Server are fulfilled.
• Close all Windows programs before running the setup.
• The specified user information must match on the different systems. Password changes must 

be tracked in all systems.
• For using IS Ready: The IS Ready Service user must be a Windows administrator and be 

created as system administrator on the SQL Server instance.

Upgrading Information Server Ready
1. Open the "ISReady" directory on your installation medium. 
2. Select the "Start.exe" file of the component to be installed.
3. Select the language.
4. Read the installation instructions.
5. Accept the license agreement.
6. Select the installation content.

You see an overview of the setup for the installation process.
7. The installation is completed.

Restart the system now or at a later time.
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Configuration of the service

1. Open "Start > All Programs > Siemens Automation > SIMATIC > IS Ready".
2. Select "IS Ready Configuration".

The "IS Ready Configurator" opens.
3. Select "Next".
4. Enter your logon information.

You see an overview of the setup for the installation process.
5. Select "Finish".

Note
Check the configuration
The configuration was successful if you have been assigned to the "SIMATIC Reporting 
Services" group under "Local Users and Groups" on your computer.

Result
The Information Server Ready has been upgraded.

See also
Overview of the upgrade installation for PCS neo (Page 75)

3.2.5.6 Upgrading the Information Server Batch Reports for PCS 7

Introduction
If you use the Information Server Batch Reports for PCS 7 to create reports for SIMATIC Batch, you 
need to install the Batch Reports.
Follow the steps below:
1. Installing or upgrading Information Server.
2. Installing or upgrading Information Server Batch Reports.

Requirement
The latest version of the Information Server is installed on the PC.

Procedure
1. Start the setup from the PCS 7 DVD.
2. Follow the instructions of the installation wizard.

Read the License Agreement and the Open Source License Agreement.
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3. Select the "Custom installation" type of installation.
4. In the "Archiving and Reporting" category, select the "Information Server Batch Reports" 

component.
5. To complete the installation, reboot the system.

Procedure for upgrading the Information Server

Note
Upgrade installation
Depending on the installed version, the Information Server Batch Reports must be upgraded via 
intermediate versions, as the table in chapter Overview of the upgrade installation for PCS 7 
(Page 34) shows.

1. Insert the PCS 7 DVD.
2. Open the "Additional_Products" folder and re-install the installed Information Server Batch 

Reports .
3. To complete the installation, reboot the system.
4. Configure the Information Server:

– Start the Internet browser as an administrator. 
Enter the URL defined in the browser settings during the installation from step 5.
Configuring browser settings for the Information Server (Page 23)

– Select the report server instance and start the configuration.
5. When the configuration is complete, start the setup from the PCS 7 DVD.
6. Follow the instructions of the installation wizard.

Read the License Agreement and the Open Source License Agreement.
7. Select the "Custom installation" type of installation.
8. In the "Archiving and Reporting" category, select the "Information Server Batch Reports" 

component.
9. To complete the installation, reboot the system.

Result
The Information Server Batch Reports component has been installed or updated.
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3.2.6 Uninstalling the Information Server

3.2.6.1 Uninstalling the Information Server

Requirement
• An Information Server is installed.

Procedure
1. Go to "Control Panel > Programs and Features".
2. Select the item SIMATIC Information Server.
3. Select the "Uninstall" menu command.
4. Accept the uninstallation.

Result
The Information Server is uninstalled.

Note
During uninstallation, no generated reports or the database are deleted.

3.3 Concepts

3.3.1 Information Server overview
You need the following information to work with the Information Server:
Useful information about the Information Server (Page 82)

Some customizations are necessary to fully use the functions of the Information Server. Check 
if all the required components are fully and correctly installed and specify other settings.
Installing the Information Server (Page 58)
You can use the Web application to access the apps of the Information Server.
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Working with the Web application (Page 83)
You can insert, create and edit reports in the Office add-in Excel.
Working with the Excel Office add-in (Page 94)

3.3.2 Useful information about the Information Server
The SIMATIC information server is a reporting-system which uses the Microsoft Reporting 
Services and accesses historical data of a process control system.
With the SIMATIC Information Server you can group, evaluate and show the messages, tags and 
recipe data of a process control system in a table or graphic.

Components of the Information Server
You can work with the following applications:
• Information Server Web application

Working with the Web application (Page 83)
• Information Server Office Add-In

AUTOHOTSPOT
The installation of IS Ready is necessary for PCS 7, OS, WinCC and PH installations to connect the 
data sources.
In the case of a PCS neo or PCS neo Batch installation, IS Ready is only installed on the PH.
The Web application and Office add-in user interface have various areas. Each area has a 
different functionality.
• Operating the user interface of the Information Server Web application (Page 97)
• Operating the user interface of the Office add-in of the Information Server (Page 98)

Data sources
A data source provides historical data that you can process using the Web application or Office 
add-in. 
You can access the data of the data sources that you have connected and for which you have 
permission. To access the data you need an existing connection to a Process Historian server.
You can work with the following data sources:
Data sources (Page 52)

Browser
You access the Web application of the Information Server with a browser with HTML 5 capability.
Browser (Page 52)
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3.3.3 Web application

3.3.3.1 Working with the Web application
You need the following information to work with the Web application:
Useful information about the Web application (Page 83)

In the "Dashboard" app, you visualize data from connected projects using configurable controls. 
This data is displayed differently in the individual dashboards depending on the selected control, 
for example, graphically or as a table.
AUTOHOTSPOT

In the "Reporting" app, you create reports or subscriptions using the report templates provided. 
You define the content of a report by assigning parameters. The report is visualized according to 
the selected report template, for example, as chart or table.
AUTOHOTSPOT

Using the "Download" app, you can download and install the Excel Office add-in.
AUTOHOTSPOT

In the "Administration" area, you configure users by assigning rights or creating groups. You 
attach projects that serve as data sources for your reports and define the email settings to send 
reports. In the license area, you check the existing licenses to ensure they are current.
AUTOHOTSPOT

3.3.3.2 Useful information about the Web application

User interface
The Web application user interface has various areas. Each area has a different functionality.
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Web application (Page 99)

User profile
The user profile contains an overview of the current user and the associated groups / 
permissions. Some settings for this can be edited directly in the profile.
User profile (Page 106)

Notifications
Depending on the notification type, creating a report triggers a notification by creating a report, 
or by creating a report using a subscription.
Notifications (Page 107)

Help
The "Help" button opens the PUD Manager. This contains all the documentation of the 
Information Server. 
Various filter functions are available in the help.
Help (Page 108)

3.3.3.3 Dashboard

Working with dashboards
You need the following information to work with Dashboards:
AUTOHOTSPOT

To fill a dashboard with controls, you create individual dashboards in the workspace of the app. 
You can view, edit, duplicate, delete, or export these dashboards.
• Creating a dashboard (Page 119)
• Viewing a dashboard (Page 120)
• Editing a dashboard (Page 121)
• Duplicating a dashboard (Page 121)
• Deleting a dashboard (Page 122)
• Exporting a dashboard (Page 122)
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To configure the layout of the dashboards created, create master pages and assign them to the 
corresponding dashboards. You can create as many master pages as you like. In the properties 
of a dashboard, you select the master page for the dashboard, among other things.
• Create master page (Page 189)
• Editing dashboard properties (Page 140)

The following controls are available for parameter assignment within a dashboard:
• Configuring "Chart" control (Page 140)
• Configuring "Single" control (Page 142)
• Configuring "Tag" control (Page 143)
• Configuring "Gauge" control (Page 144)
• Configuring "Message" control (Page 145)
• Configuring "Text" control (Page 146)
• Configuring "Report" control (Page 147)

In the "Message" control, you have various options for using filter groups. You can show and hide 
columns within the control and switch between the Message, Archive and Hitlist views.
• Creating a filter group (Page 148)
• Activate/deactivate filter group (Page 148)
• Editing a filter group (Page 149)
• Deleting a filter group (Page 149)
• Deleting all filter groups (Page 150)
• Show/hide columns (Page 150)
• Sorting the columns in ascending or descending order (Page 151)
• Changing views (Page 151)

You can edit, duplicate, delete or enlarge the controls created.
• Editing controls (Page 152)
• Duplicating a control (Page 152)
• Deleting controls (Page 153)
• Enlarging controls (Page 153)

To filter by time within a dashboard, you can create time filters in the dashboard properties and 
use them to filter the dashboard. 
• Creating a time filter for a dashboard (Page 139)
• Filtering in dashboards by time (Page 139)
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Adapt the directory structure of the dashboards in the app by creating, renaming, deleting 
folders or importing/exporting folder hierarchies. Sort the overview by name or last modified or 
browse the dashboard overview by name. 
• Create folder (Page 116)
• Edit folder (Page 117)
• Delete folder (Page 117)
• Import folder hierarchy (Page 118)
• Export folder hierarchy (Page 118)
• Sorting an overview of the dashboards (Page 123)
• Browsing the overview of the dashboards (Page 123)

Useful information about dashboards
In this area, you can use dashboards and controls to process and visualize data in a variety of 
ways.

User interface
The "Dashboard" app user interface has various areas. Each area has a different functionality.
Dashboard (Page 114)
The master page is selected in the Dashboard properties.
Master pages (Page 188)
Any number of controls can be created and configured within the respective dashboard using 
drag-and-drop.
Controls (Page 124)

Overview of controls
The following controls are available for processing and visualizing data in the dashboards.
• "Chart" control (Page 126)
• "Single" control (Page 129)
• "Tag" control (Page 130)
• "Gauge" control (Page 131)
• "Message" control (Page 132)
• "Text" control (Page 136)
• "Report" control (Page 137)
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Data modes for the "Chart" control
The parameter assignment of the "Chart" control requires you to select a data mode. The choices 
are start and end date, a time range, or live data. The selection of start and end date or time 
interval in combination with the "List" setting requires a time filter to be created beforehand.
Data modes (Page 128)

Filter criteria for "Message" control
The parameter assignment of the "Message" control requires the selection of one or more 
filters. The selection of filters varies depending on the connected data source.
Filter criteria (Page 134)

3.3.3.4 Reporting

Working with reporting 
You need the following information to work with reporting:
AUTOHOTSPOT

You can create and edit reports for the connected data sources using the pre-defined report 
templates for messages, tags, advanced reports, alarm statistics, batch logs and batch.
• Creating a report (Page 168)
• Viewing a report (Page 169)
• Export report (Page 170)
• Edit report (Page 171)
• Remove report (Page 171)
• Rerun report (Page 172)

To conveniently browse the tag hierarchies and directories when creating reports or 
subscriptions with tags, you can filter or sort the display or search for a specific tag name.
Browsing tags (Page 161)

To generate reports for specified events, create a subscription. You can edit or delete the created 
subscriptions.
• Creating a subscription (Page 175)
• Edit subscription (Page 177)
• Deleting a subscription (Page 177)
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Configure a trigger for the report cleanup, which configures the storage space if your available 
space reaches defined limits.
Configuring storage space (Page 199)

You can create, reuse or edit parameter presets in the toolbar.
• Creating parameter preset (Page 162)
• Reusing parameter preset (Page 162)
• Editing parameter preset (Page 163)

There are several ways to customize the tables for created reports and subscriptions.
• Show/hide columns (Page 172)
• Sorting the columns in ascending or descending order (Page 173)
• Set filter (Page 173)
• Reset filter (Page 174)

Useful information about Reporting
In this area, you can use reports and subscriptions to process and visualize data in a variety of 
ways.

User interface
The Reporting user interface has various areas. Each area has a different functionality.
Reporting (Page 154)

Reporting
Reporting contains report templates that you configure to generate reports or subscriptions. The 
report templates provide an overview of the functions for generating reports.
Report generation (Page 164)

There are different templates for messages, tags, advanced reports and alarm statistics. The 
display of the report templates varies depending on the connected data source.
Report templates (Page 165)

During report generation, the process is aborted after a time interval defined by default. This 
time range can be extended.
Time limit for creating reports (Page 167)
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Subscriptions
A subscription generates reports at regular intervals for defined events.
Subscriptions (Page 174)

The subscriptions are initiated by defined events, which are referred to as triggers. Depending on 
the connected data source, you can define message, tag and time triggers.
Trigger for subscriptions (Page 180)

When creating the subscription, you define additional properties relating to privacy, storage and 
transmission.
Settings for subscriptions (Page 184)

 Public and private subscriptions have different rights for reading, writing and deleting 
subscriptions.
Authorization matrices for subscriptions (Page 182)

There are several delivery methods for providing reports from subscriptions. You choose 
between storage in the database, local storage or transmission by email.
Delivery method (Page 183)

To make the optimal use of database or disk space, configure Report Clean Up. This allows you 
to automatically define the further procedure if an action is required to free up storage space.
Report Clean Up (Page 195)

Parameter presets
By using a parameter preset, the parameters are copied to the report template when the new 
report or subscription is created. 
Parameter presets (Page 161)

Time information
You configure absolute or relative time specifications for all reports. Pay attention to the time 
specifications in different time zones as well as the special features and the use of relative time 
specifications.
Time information (Page 157)

Browsing tags
When creating reports or subscriptions with tags, the tags are displayed in the hierarchy with all 
directories and subdirectories in a dialog. The display can be modified.
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Browsing tags (Page 159)

3.3.3.5 Download

Working with Download
You need the following information to work with Download:
AUTOHOTSPOT

To use the Office add-in for the Information Server, you can install the add-in via the "Download" 
app.
Installing Office add-in with the web application (Page 185)

Useful information about Download
The Information Server Office add-in can be installed by download in the Web application or via 
setup.

Using the Excel Office add-in
Installing the Excel Office add-in provides a variety of Information Server functions in Excel.
Download (Page 184)

For more information about the functions, see the Office add-in overview.
AUTOHOTSPOT

3.3.3.6 Administration

Working with Administration
You need the following information to work with Administration:
Useful information about Administration (Page 93)
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To configure the layout of the dashboards created, create master pages and assign them to the 
corresponding dashboards using the dashboard properties. You can create as many master 
pages as you like.
• Create master page (Page 189)
• Deleting a master page (Page 190)
• Saving a master page (Page 190)
• Duplicate a master page (Page 190)
• Exporting a master page (Page 191)
• Importing a master page (Page 191)

Customize the directory structure of report templates in reporting by creating, renaming, 
deleting or showing/hiding folders.
• Create folder (Page 195)
• Renaming folders (Page 195)
• Delete folder (Page 196)
• Show/hide folder (Page 196)

Configure the selection and display of report templates by importing, exporting, deleting or 
showing / hiding report templates.
• Import report template (Page 197)
• Export report template (Page 197)
• Move report template (Page 198)
• Delete report template (Page 198)
• Show/hide a report template (Page 199)

To free up disk space for the generated reports, define limits. Based on these limits, subsequent 
actions are configured for the files that occupy the storage space.
Configuring storage space (Page 199)

To send reports and subscriptions by email, enable the email settings. You can choose from 
different email providers, such as Gmail or Office 365. You can test the settings made and restore 
their factory settings.
• Configuring e-mail settings (Page 201)
• Testing e-mail settings (Page 209)
• Resetting e-mail settings to factory defaults (Page 209)
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The Application Installer shows an overview of the installed apps of the Web application. You 
check and update the individual apps if necessary. If an app is outdated, you are redirected to the 
Application Installer page directly at the beginning of the Web application.
Using the Application Installer (Page 210)

Check the existing licenses (and their validity) that are available to you for using the Information 
Server.
Check licenses (Page 212)

To start working with the Information Server, create new projects in the project configuration 
that will serve as data sources for the reports.
• Create new folder (Page 215)
• Add project (Page 215)
• Rename project (Page 216)
• Delete project (Page 217)

In addition, you can make other settings in the project configuration. Start a synchronization or 
a diagnostic run, assign permissions to individual users for a project, or make a host change 
when you move a project such as PH or WinCC to another computer.
• Start simulation (Page 214)
• Starting a diagnostic run (Page 217)
• Assigning authorizations (Page 218)
• Changing the host (Page 218)

Create a new domain user and add it to the required Windows groups to integrate the 
Information Server into a domain. The new profile is created in the database with the first login.
Subsequent integration of the Information Server into a domain (Page 187)

In the User configuration, you can create, edit and activate / deactivate users as well as create, 
edit and delete user groups. The email address, the language settings and the associated 
Windows user groups for each user are stored.
• Create user (Page 221)
• Edit user (Page 222)
• Activate / deactivate user (Page 223)
• Creating a user group (Page 224)
• Editing a user group (Page 224)
• Deleting user groups (Page 225)

SIMATIC Information Server
3.3 Concepts

SIMATIC Information Server
92 System Manual, 02/2022, A5E51661636-AA



Useful information about Administration
In this area, you can make settings that are exclusively reserved for the administrative user 
group.

User interface
The Administration user interface has various areas. Each area has a different functionality.
Administration (Page 186)

App configuration
The representation of a Dashboard is defined by selecting and configuring a master page. The 
master page is selected in the Dashboard properties.
Master pages (Page 188)

In the Administration area for reporting, you specify which report templates are displayed in 
which structure in the Reporting app. Independent of this, the display of report templates varies 
depending on the connected data source.
Reporting (Administration) (Page 193)

To make the optimal use of database or disk space, configure Report Clean Up. This allows you 
to automatically define the further procedure if an action is required to free up storage space.
Report Clean Up (Page 195)

Email settings
The settings define the transmission of reports and subscriptions via email. The email settings 
can be configured for the following providers:
• Generic
• Gmail
• Office 365
E-mail settings (Page 200)

Application Installer
In the Application Installer section, you can see an overview of the installed apps in the Web 
application and their installation status. 
Application Installer (Page 209)
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Licensing
The available licenses for the Information Server differ depending on the connected data source. 
The license count for client access depends on various factors. There is an additional 14-day trial 
license.
Licenses (Page 210)

Project configuration
The project configuration includes all administrative, project-related activities.
Project configuration (Page 212)

User configuration
The Information Server uses local Windows user groups to assign roles and rights. You assign the 
appropriate group to the created users.
User configuration (Page 219)

To use the Information Server in combination with PCS neo, the UMC user groups must be 
mapped once to the Windows user groups. 
Mapping of UMC and Windows groups in PCS neo (Page 220)

3.3.4 Office add-in

3.3.4.1 Working with the Excel Office add-in
The Information Server provides an add-in for the Microsoft Excel application. You can use this 
add-in to insert and create reports in Excel. 
You need the following information to work in Excel:
AUTOHOTSPOT

You configure the connection to the Information Server directly in the Office add-in.
Configuring server settings (Page 245)

To include reports in Excel, you can create the reports directly in Excel or open reports already 
created from a local storage location or from the Information Server Web application. 
• Creating a report in Excel (Page 229)
• Opening locally saved Excel reports (Page 230)
• Open Excel reports from the Information Server (Page 231)
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To generate reports for specified events, create a subscription.
Creating a subscription in Excel (Page 233)

Excel report templates can be saved locally or to the Information Server Web application.
• Saving Excel report templates locally (Page 232)
• Save Excel report templates to the Information Server (Page 232)

You can create, configure, or delete tags to display tags in the Excel worksheet.
• Create tag (Page 234)
• Configuring tag (Page 235)
• Deleting a tag (Page 239)

You can create, configure, or delete messages to display messages in the Excel worksheet.
• Create message (Page 239)
• Configuring a message (Page 240)
• Delete message (Page 243)

For the configured tags and/or messages, data from the connected data sources are retrieved 
and displayed.
Updating an Excel workbook (Page 244)

Selected process values can be displayed graphically in the Excel worksheet.
Display process values graphically (Page 244)

Filters for displaying messages can be configured based on links or groupings.
Configuring a message filter (Page 246)

For the configuration of tags and messages, there are various functions in the dialogs that 
facilitate the operation of the Excel Office add-in.
• Filter table (Page 248)
• Replace tag (Page 249)
• Apply parameters (Page 249)
• Copy message/tag or its configuration (Page 250)
• Insert copied message/tag (Page 251)
• Transfer configuration of the copied message/tag (Page 251)
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• Delete message/tag (Page 252)
• Select multiple messages/tags (Page 253)

By using a parameter preset, the parameters are copied to the report template when the new 
report or subscription is created.
• Creating parameter presets in Excel (Page 254)
• Reusing parameter presets in Excel (Page 254)

3.3.4.2 Useful information about the Office add-in

User interface
The Information Server add-in is integrated into the toolbar. The Office add-in user interface has 
various areas. Each area has a different functionality. 
Toolbar in Excel (Page 228)

Reports
Report templates can be used to create reports in the Office add-in.
Report types in the Office add-in (Page 226)

Time information
The Office Add-In allows you to enter absolute and relative times and to select pre-defined times 
from a list.
Time information (Page 157)

Subscriptions for report templates
A subscription is a regularly recurring report created according to defined parameters.
Subscriptions for report templates in Excel (Page 227)

You can use time, tag and message triggers to perform the subscriptions automatically. 
Trigger for subscriptions (Page 180)

Connection status
A connection to the Information Server must exist to retrieve information for a report. 
Connection status (Page 255)
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Message filter
The message filter has various options for filtering the display of messages. Filtering is done by 
groupings and/or links.
Message filters (Page 245)

Simplified operation
Simplified operation is used for faster processing of tags and messages. You can edit one or more 
columns at the same time using buttons.
Simplified operation (Page 247)

Parameter presets
A parameter preset contains pre-defined parameters for a report template. In Excel, you can 
adopt parameter presets that were created in the Web application.
Parameter defaults in Excel (Page 253)

3.4 Functions

3.4.1 Basics

3.4.1.1 Operating the user interface of the Information Server Web application
Below, reference is made to:
• Layout of the user interface
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Layout of the user interface
The user interface contains the following elements:

① Navigation 
area

Provides access to the individual apps of the Web application.

② Breadcrumb 
navigation

Shows the current position in the Web application menu.

③ Work area Displays an overview of the individual apps or the work area of an app, depending 
on its position in the menu.

④ Header A global basic element and can be seen in every area. 

3.4.1.2 Operating the user interface of the Office add-in of the Information Server
Below, reference is made to:
• Layout of the user interface
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Layout of the user interface
The user interface contains the following elements:

① Toolbar Provides access to the features in the Office add-ins.
② Footer Shows the connection status of the Office add-in.
③ Work area Displays the configured data.

3.4.2 Web application

3.4.2.1 Web application

Definition
You access the Web application of the Information Server with a browser with HTML 5 capability: 
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Structure
The Web application consists of the following areas: 

① Navigation bar (Page 101)
② Breadcrumb navigation (Page 102)
③ Work area in the Web application (Page 103)
④ Header (Page 105)

3.4.2.2 Step-by-step instructions

Opening a Web application

Requirement
You are a member of one of the following Windows user groups:
• SIMATIC Report Publishers
• SIMATIC Report Users
• SIMATIC Report Administrators
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Procedure
Enter the URL in the browser bar that you specified during installation in the SIMATIC Web 
Configurator.

Note
Browser selection and display
Google Chrome is recommended for using the Information Server Web application.
If the browser does not display the Web application of the Information Server, check that all 
software requirements in the installation instructions are met. 

Result
The Web application is open.

Note
License release by logging off the Web application
If you close the Web application without logging off, the license can remain inactive for 20 
minutes until it expires.

3.4.2.3 Navigation area

Definition
The navigation area provides access to the apps of the Web application. 
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Structure
The navigation area is divided into the following areas:

① Start page • Overview of the apps
• Quick access to certain functions of the apps

② Dash‐
board 
(Page 
114)

Configurable controls

③ Reporting 
(Page 
154)

• Reporting
• Subscriptions

④ Download 
(Page 
184)

Download of the Office add-ins

⑤ Adminis‐
tration

• App configuration
• E-mail settings
• Application Installer
• Licensing
• Project configuration
• User configuration

3.4.2.4 Breadcrumb bar

Definition
The breadcrumb bar gives you information about the current position in the menu of the web 
application with the respective higher hierarchy levels up to the start page. 
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Structure
The breadcrumb navigation is structured as follows:

① Hierarchy level 1: Starting point in the web application, here: Homepage
② Hierarchy level 2: App
③ Hierarchy level 3: Subarea of the app

3.4.2.5 Work area Web application

Work area in the Web application

Definition
The work area is the main area in the Web application. An overview of the individual apps is 
shown on the start page. You can select specific contents of the apps directly. The division of the 
work area can vary within the apps.
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Structure
The work area in the web application is divided into the following areas:

① Dashboard (Page 114)
② Download
③ Reporting (Page 154)
④ Administration

Step-by-step instructions

Opening the work area in the Web application

Requirement
You are a member of one of the following Windows user groups:
• SIMATIC Report Publishers
• SIMATIC Report Users
• SIMATIC Report Administrators
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Procedure
1. Open the Web application of the Information Server by entering the URL defined during 

installation into the address bar of the browser.
2. Select an app in the work area.

Result
The work area of the selected app is open.

3.4.2.6 Header

Header

Definition
The login name of the currently logged in user is visible in the header.
You can open the user profile, notifications and help in the header. 

Structure
The header has the following structure:

① User profile 
(Page 106)

Opens the user profile.

② Notifications 
(Page 107)

Displays the notifications to which you have subscribed.

③ Full-screen mode 
(Page 114)

Enables or disables full-screen mode.

④ Help (Page 109) Opens the Information Server help.
⑤ Logout (Page 113) Logs the user out.
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User profile

Definition
The user profile contains the following information and specifications:
• General: 

– Specification of the display names
– Selection of a profile picture
– E-mail address
– Selection of the display language
– Delete status data of the application

• Selection of the notification types that are received or sent
• Effective authorizations: Overview of the current authorizations of the assigned Windows 

user group
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Structure
The user profile is structured as follows:

① Profile picture (Page 109) Uploads a new profile picture.
② General (Page 110) Displays general information about the user profile, e.g. the language selection
③ Notifications (Page 111) Shows the list of notifications that can be activated.
④ Groups/Permissions (Page 112) Shows the overview of the groups assigned to your profile.
⑤ Effective permissions (Page 113) Shows the list of all permissions assigned to your profile and role.

Notifications

Definition
In the Notifications area you receive the news that you have selected in your profile under 
"Notifications". 
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Structure
The following functions are available:

① Subscribe (Page 111) Creates a new subscription.
② Mark all as read (Page 111) Marks all notifications as read.
③ Delete all read notifications 

(Page 112)
Deletes all read notifications.

Help
The help of the Information Server is displayed by the PUD Manager. 
The help consists of modern documentation that concentrates on the use of filters based on 
metadata (attributes, product properties) and the search function (e.g. consideration of 
synonyms).
Through nesting, the user can decide on the degree of detail required in the information. The 
user can specifically filter the contents using metadata such as user group, application phase, or 
software area

Step-by-step instructions

Clear all application state data

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• The user profile is open.

Procedure
1. Select the "General" tab.
2. Select the "Clear all application state data" button.
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Note
You delete the following data by confirming this option: 
• Configuration of tables in reporting (sorting, filters, displayed columns).
• Selection of tags/messages/batch: Position, size, last selected folder

Result
The application state data is deleted.

Upload profile picture

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• The Web application is open.

Procedure
1. Open the user profile.
2. Select the placeholder of the profile picture.
3. Select the required profile picture.
4. Confirm your selection.

Result
The profile picture is uploaded.

Opening online help

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• The Web application is open and the PUD is installed.
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Procedure
Select the "?" button.

Result
The PUD online help opens.

Opening a user profile

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• The Web application is open.

Procedure
Select "User profile".

Result
The "User profile" dialog opens.

Select language

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• The Web application is open.

Procedure
1. Open "User profile".
2. Select the "General" tab.
3. Select the language from the drop-down menu.
4. Select "Save". 
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Result
The display language is changed.

Subscribing to notifications

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• The Web application is open.

Procedure
1. Select "User profile".
2. Select the "Permissions" tab.
3. In the list, select the notification types that you want to receive and send.
4. Select "Save". 

Result
The notifications are activated.

Mark all notifications as read

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• The Web application is open.

Procedure
1. Open "Notifications".
2. Select "Mark all notifications as read".
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Result
All notifications are marked as read.

Delete all read notifications

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• The Web application is open.

Procedure
1. Open "Notifications".
2. Select "Delete read notifications".

Result
All read notifications are deleted.

Checking groups/permissions

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• The Web application is open.

Procedure
1. Open "User profile".
2. Select the "Groups/Permissions" tab.
3. Check the overview of the groups assigned to your profile.
4. Select "Save".
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Result
The user is logged off.

Checking effective permissions

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• The Web application is open.

Procedure
1. Open "User profile".
2. Select the "Effective permissions" tab.
3. Check the list of all rights assigned to your profile and role.
4. Select "Save".

Result
The user is logged off.

Log out user

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• The Web application is open.

Procedure
1. Select "Logout".
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Note
Logout is only available when the Information Server is not opened via the PCS neo Portal.

Result
The user is logged out. 

Enable full-screen mode

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• The Web application is open.

Procedure
1. Select "Full-screen mode". 

Result
Full-screen mode is enabled.

3.4.2.7 Dashboard

Dashboard

Definition
Various data visualization options are available within the dashboard using the configurable 
controls. 
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Layout
The "Dashboard" app is structured as follows:

① Toolbar (Page 115)
② Overview of the dashboards already created
③ Overview of the folder hierarchy 

Toolbar in the "Dashboard" app

Definition
The toolbar contains all functions within the "Dashboard" app.
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Structure
The toolbar for the folders contains the following functions:

① Create folder (Page 116) Creates a new folder.
② Edit folder (Page 117) Opens Edit mode of the selected folder.
③ Delete folder (Page 117) Deletes the selected folder.
④ Import folder hierarchy 

(Page 118)
Imports a hierarchy.

⑤ Export folder hierarchy 
(Page 118)

Exports the current folder hierarchy.

The dashboard toolbar contains the following functions:

① Create (Page 119) Creates new dashboards, dynamically fillable.
② Duplicate (Page 121) Duplicates the selected dashboard.
③ View (Page 120) Opens the selected dashboard for viewing.
④ Edit (Page 121) Opens Edit mode of the selected dashboard.
⑤ Delete (Page 122) Deletes the selected dashboard.
⑥ Export (Page 122) Exports the selected dashboard.
⑦ Sort (Page 123) Sorts by "Name" or "Last modified" via drop-down menu.
⑧ Find (Page 123) Search via direct entry of the dashboard name.

Step-by-step instructions

Create folder

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• The "Dashboard" app is open.
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Procedure
1. Select "Create" in the toolbar of the folder hierarchy.
2. Assign a name.
3. Select "Save".

Result
A folder for dashboards is created.

Edit folder

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• The "Dashboard" app is open.

Procedure
1. Select the folder you want to rename.
2. Select "Edit".
3. Change the name.
4. Select "Save".

Result
The name of the folder has changed.

Delete folder

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• The "Dashboard" app is open.
• A folder has been created.
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Procedure
1. Select the folder you want to delete.
2. Select "Delete".
3. Confirm your selection.

Result
The folder and all the dashboards it contains are deleted.

Import folder hierarchy

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• The "Dashboard" app is open.

Procedure
1. Select "Import".
2. Select the file you want to import.
3. Confirm the selection with "Import".

Result
The folder hierarchy is imported.

Export folder hierarchy

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• The "Dashboard" app is open.
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Procedure
1. Select the folder you want to export.
2. Select "Export".

Note
To export all dashboards, select the root folder and click the button to confirm the export. The 
dashboards are created in the specified location with the same folder structure as in the Web 
application.

Result
The folder has been saved locally in the specified target directory.

Creating a dashboard

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

Procedure
1. Select "Create".

Note
In contrast to version 2014 SP2, the dynamic dashboard template no longer statically links 
the controls to the divisions of the selected dashboard. Instead, they can be dragged and 
dropped to the desired location.

2. Drag-and-drop controls into the dashboard to suit your needs.
Controls (Page 124)

3. Select "Save".
Note
The "Properties" dialog opens automatically when saving for the first time.
You can open the dialog at any time using the "Properties" button.

4. Select the properties of the dashboard.
Editing the properties of a dashboard (Page 140)
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5. Select one of the master pages created for the dashboard layout.
Master pages (Page 188)
Note
Time filter
You have the option of creating one or more time filters that you can use to filter for controls 
within the dashboard. The created filters appear in the header of the dashboard. Filter in 
dashboards by time

6. Select "Save".

Result
The dashboard is created and appears in the overview of the "Dashboard" app.

See also
Filtering in dashboards by time (Page 139)

Viewing a dashboard

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers 
– SIMATIC Report Users 
– SIMATIC Report Administrators

• A dashboard is created.

Procedure
1. Select the dashboard you want to view.
2. Select the "View".

Note
Print function
When you open a selected dashboard with the "View" function, you have the option to print the 
view. The computer's own dialog opens for this. For a proportional view of the dashboard 
displayed on the printout, make sure you layout or scale the view and preview it.

Result
The selected dashboard is open in View mode.
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Editing a dashboard

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers 
– SIMATIC Report Users 
– SIMATIC Report Administrators

• A dashboard is created.

Procedure
1. Select the dashboard you want to edit.
2. Select "Edit".

Result
The selected dashboard is open in Edit mode.

Duplicating a dashboard

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers 
– SIMATIC Report Users 
– SIMATIC Report Administrators

• A dashboard is created.

Procedure
1. Select a dashboard that you want to duplicate.
2. Select "Duplicate".

Result
The selected dashboard is duplicated.
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Deleting a dashboard

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers 
– SIMATIC Report Users 
– SIMATIC Report Administrators

• A dashboard is created.

Procedure
1. Select the dashboard you want to delete.
2. Select "Delete".

Result
The selected dashboard is deleted.

Exporting a dashboard

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers 
– SIMATIC Report Users 
– SIMATIC Report Administrators

• A dashboard is created.

Procedure
1. Select the dashboard you want to export.
2. Select "Export".

Result
The dashboard has been saved locally in the default destination directory.
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Sorting an overview of the dashboards

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• The "Dashboard" app is open.

Procedure
1. Select a sorting order for the created dashboards: 

– Name
– Last modified

Result
The dashboards are displayed sorted according to your selection.

Browsing the overview of the dashboards

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• The "Dashboard" app is open.

Procedure
Enter the name of the dashboard you are looking for.

Result
The dashboard you are looking for is displayed in the overview.
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Controls

Controls

Definition
A control is an object for visualizing specific values. Each control displays these values from the 
projects differently.
The following options are available:
• Historical values or continuous adding of the latest values via the "Live data" mode
• Single or multiple tags, their values and quality codes
• Tags as gauge, renewed by live data
• Historical messages, currently pending messages and message statistics
• Integration of text and placeholders
• Integration of reports
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Layout 
The following controls are available:

① "Chart" control 
(Page 126)

Open the dialog for the "Chart" control in the work area using drag-and-
drop.

② "Single" control 
(Page 129)

Open the dialog for the "Single" control in the work area using drag-and-
drop.

③ "Tag" control 
(Page 130)

Open the dialog for the "Tag" control in the work area using drag-and-drop.

④ "Gauge" control 
(Page 131)

Open the dialog for the "Gauge" control in the work area using drag-and-
drop.

⑤ "Message" control 
(Page 132)

Open the dialog for the "Message" control in the work area using drag-and-
drop.

⑥ "Text" control 
(Page 136)

Open the dialog for the "Text" control in the work area using drag-and-drop.

⑦ "Report" control 
(Page 137)

Open the dialog for the "Report" control in the work area using drag-and-
drop.
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"Chart" control

Definition
With the "Chart" control, you can display tag values as a chart. The control supports both 
historical queries and a "Live data" mode that continuously adds the latest values to the view. 
Tags can be displayed with different time axes and value axes.

Layout
The "Chart" control is divided into the following areas:

① Header In the header, you can edit, duplicate, delete, or enlarge the control to full screen.
② Display area The chart is shown in the display area.
③ Footer Jump forward or backward in the display.

Enable live data or jump in the display to a specific point in time.

Settings for the control
"General" tab Description
Project Selection of the data source
Tag browsing Select New tag, Edit tag, Delete tag
Title Header of the control, optional
Step forward/backward Determines the number of seconds, minutes, hours or days to jump to the future or 

past when using the Forward/Back button.
Maximum number of values Determines the maximum number of tag values that may be read from the server 

per query. For security reasons, the value must be limited to protect server resour‐
ces.

Legend position Determines the position of the legend in the chart.
Legend in the layout Determines whether the legend of tag names should be structured horizontally or 

vertically.
Crosshairs Turns on a mode in which an additional vertical line is displayed when the cursor 

contacts the graph.
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"Edit element" dialog Description
Tag Tag name
Enable aggregation Toggles between aggregated values and raw values.
Aggregate function If aggregation is enabled, the desired aggregate function can be selected here (e.g. 

interval-based summary or determination of maximum values).
Aggregation interval Determines the interval size to be used for the aggregate function.
Type Allows the tag values to be displayed in different forms (e.g. as a line chart or as a bar 

chart).
Enable data labels Determines whether a window with the time and value of the current data point of 

the tag should be displayed when the mouse hovers over the chart.
Line style Graphical representation of the line within the chart.
Line width (pixels) Line width within the chart, in pixels.
Color Line color
Time axis The control supports the simultaneous display of several time axes, so that values 

from different days can be compared graphically, for example. The time axis for the 
current tag can be determined here.

Value axis The control supports the simultaneous display of several value axes, so that values 
of different days can be compared graphically, for example. The value axis for the 
current tag can be determined here.

"Time axes" tab Description
Time axes Allows adding additional time axes that can be assigned to individual tags and are 

displayed below or above the chart.
Object name Name of the time axis within the settings. The name is not displayed in the chart and 

is only used for identification.
Axis title (optional) Labeling of the time axis, optional
Data mode Toggles between different query modes.
Enable grid lines Displays additional vertical lines for subdivision of the chart by time.
Position Determines whether the time axis should be displayed above or below the chart.

"Value axes" tab Description
Value axis Allows you to add additional value axes that can be assigned to individual tags and 

displayed either to the left or to the right of the chart.
Object name Name of the value axis within the settings. This name is not displayed in the chart 

and is only used for identification.
Axis title (optional) Labeling of the value axis, optional
Enable grid lines Displays additional horizontal lines for subdivision of the chart by values.
Activate limits Switches between automatic value range determination and static minimum and 

maximum values for the value axis.
Interval between ticks • Automatic: Distributes the horizontal bars of the value axis automatically.

• Manual: Manual definition of the distance between horizontal marks on the 
value axis.

Position Determines whether the time axis should be displayed on the left or right of the 
chart.
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Data modes

Definition
You can choose from different data modes when configuring the "Chart" control.

Layout
The following data modes are available:

Data mode Setting
Specify start and end date Shows tag values from the specified time range.

• Start and end time Selection between:
– Default: Date and time information
– Relative: Relative time information (Time infor‐

mation (Page 157))
– List: Selection of filters already created

Time interval Shows tag values within an interval starting at the 
specified time.
• Start time selection between:

– Default: Date and time information 
– Relative: Relative time information (Time infor‐

mation (Page 157))
– List: Selection of filters already created

• Time interval
Live data Shows tag values from the last 10 minutes and contin‐

uously adds new tag values to the view. The interval size 
can be changed.
• Time interval

List of time filters
By selecting the "List", you select one of the time filters already defined or create new filters for 
filtering the dashboard.
The selected time filter appears in the dashboard header and is applied to all "Chart" controls in 
the selected dashboard for which "Specify start and end date" or "Time interval" is selected as the 
"List" setting in the data mode. 
You can toggle in the header between the different time filters for the selected dashboard.
Creating a time filter for a dashboard (Page 139)
Filtering in dashboards by time (Page 139)
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"Single" control

Definition
The "Single" control allows you to view live data of a single tag, its current value and its quality 
code. In addition, warnings can be configured when limits are violated.

Layout
The "Single" control is divided into the following areas:

① Header In the header, you can edit, duplicate, delete, or enlarge the control to full screen.
② Display area You can find information on the limit value and its quality code below the graphical 

display.
You can use the Pause/Play button to pause or resume the control.

Note
When you pause the control, values are displayed at certain intervals, for which the 
corresponding data is displayed when you mouse-over. 
If the configured high or low limit is violated, the value display takes on the color that 
corresponds to the limit.

Settings for the control
"General" tab Description
Title Header of the control, optional
Project Selection of the data source
Tag Tag whose values are to be displayed.
Number of decimal places Number of decimal places to be displayed as a numerical value below the chart.
Displaying quality code Switches on the display of the quality code. 

The quality code is a numeric value that contains additional information about the 
last tag value. The codes are explained in the "Quality codes" tab.
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"Quality codes" tab Description
Table Overview of all quality codes, their meaning and the configured colors. 

The color can be configured for each quality code.

"Tag" control

Definition
With the "Tag" control, you can display the live data of several tags in tabular form, as well as their 
current values and quality codes. Optionally, aggregate values over the past hour or additional 
time intervals can also be displayed.

Layout
The "Tag" control is divided into the following areas:

① Header In the header, you can edit, duplicate, delete, or enlarge the control to full screen.
② Display area The display area shows the values and the chart.
③ Footer You can use the Pause/Play button to pause or resume the control.

Settings for the control
"General" tab Description
Title Header of the control, optional
Project Selection of the data source
Tags Tags whose values are displayed in tabular form.
Number of decimal places Number of decimal places to be displayed as a numerical value below the chart.
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"General" tab Description
Displaying quality code Switches on the display of the quality code. The quality code is a numeric value that 

contains additional information about the last tag value. The codes are explained in 
the "Quality codes" tab.

Functions Aggregate functions, which are shown as additional columns. In each case, a single 
aggregate value is calculated for the specified time interval.

Time interval By default, the aggregate value is calculated for the past hour. 
The interval is configurable.

"Quality codes" tab Description
Table Overview of all quality codes, their meaning and the configured colors. 

The color can be configured for each quality code.

"Gauge" control

Definition
You can use the "Gauge" control to visualize the current value of a tag in form of a gauge with 
configurable value range. The value is continuously refreshed by live data. The control supports 
the display of quality codes.

Layout
The "Gauge" control is divided into the following areas:

① Header In the header, you can edit, duplicate, delete, or enlarge the control to full screen.
② Display area

 
You can find information about the limit below the graphical display.

③ Footer Display of the quality code
You can use the Pause/Play button to pause or resume the control.
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Note
If the configured high or low limit is violated, the value display takes on the color that 
corresponds to the limit.

Settings for the control
"General" tab Description
Title Header of the control, optional
Project Selection of the data source
Tag Tag whose values are to be displayed.
Number of decimal places Number of decimal places to be displayed as a numerical value below the chart.
Displaying quality code Switches on the display of the quality code. The quality code is a numeric value that 

contains additional information about the last tag value. The codes are explained in 
the "Quality codes" tab.

Min. value Determines the minimum value on the left side of the measurement display.
Max. value Determines the maximum value on the right side of the measurement display.
Interval between ticks • Automatic: Distributes the horizontal bars of the value axis automatically.

• Manual: Manual definition of the distance between horizontal marks on the 
value axis.

"Quality codes" tab Description
Table Overview of all quality codes, their meaning and the configured colors. 

The color can be configured for each quality code.

"Message" control

Definition
The "Message" control allows you to display historical messages, currently pending messages 
and message statistics (hitlist) in tabular form. The control allows you to configure filters to limit 
the messages to be read out, e.g. based on a certain error type or a certain location.

Note
Only messages can be displayed with this control. It is not possible to acknowledge or comment 
messages.
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Layout
The "Message" control is divided into the following areas:

① Header In the header, you can edit, duplicate, delete, or enlarge the control to full screen.
② Display area The values are shown as configured in the display area.

The columns can be sorted in descending or ascending order using the arrows next 
to the column names. You can add additional attributes to the table.

③ Footer Scroll the table in the footer forwards or backwards. 
You can switch between three different views, depending on the data source: Mes‐
sage list (live mode), archive list (archive mode) and hit list (statistical analysis 
mode).

Views in the control
The control supports three different views, which you can switch between using the 
corresponding buttons in the footer of the control.
• Message bar: Display of currently pending messages
• Archive list: Display of historical messages from a specific time interval
• Hit list: Display of statistics related to the occurrence frequency of messages

Restrictions
The following table shows the restrictions of the view according to the connected data source.

Data source Message bar Archive list Hit list
PCS 7/WinCC OS Yes Yes Yes
PH PCS 7/WinCC Yes Yes No
PCS neo Yes Yes No
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Settings for the control
"Settings" dialog Description
Title Header of the control, optional
Project Data sources from which messages are to be displayed.
Messages per page Determines the maximum number of messages to be displayed in tabular form per 

page.
Filter Allows the creation and management of filter groups. 

Each of these groups consists of a number of linked filters (logical AND) that further 
limit the selection of messages to be read. Groups can be enabled or disabled indi‐
vidually and logically linked (logical OR). 
When creating a new group, a range of validity must be selected:
• Only for this dashboard: The filter group can be used only in the "Message" 

controls of the same dashboard. The filter group is not visible in other dash‐
boards.

• For all dashboards: The filter group can be used in all "Message" controls in all 
dashboards.

Add filter group Description
Name Name of the filter group within the settings

The name has no effect on the display of the data.
Private Determines whether the filter group is visible only to the current user or to all users.
Filter Defines a filter condition that further restricts the selection of messages to be read.

• Filter by: The message attribute by which to filter.
• Operator The operator to use to compare the message attribute to the value.
• Setting: The value to which the message attribute is compared.

Filter criteria

Definition
You can select different filter criteria when configuring a "Message" control.
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Layout
The following filter criteria are available:

Filter Setting
Date/time • Operators: = / > / ≥ / < / ≤

Select between:
– Default: Date and time information
– Relative: relative time information (see sec‐

tion Time information (Page 157))
– List: Selection from filters already created

• Input: Character string or numeric, depending 
on selection

State • Operators: = / > / ≥ / < / ≤
• Input: Numeric

Number • Operators: = / > / ≥ / < / ≤
• Input: Numeric

Class • Operators: include = /
• Input: Character string

Type • Operators: include = /
• Input: Character string

AG number • Operators: include = /
• Input: Character string

CPU number • Operators: include = /
• Input: Character string

Computer name • Operators: include = /
• Input: Character string

User name • Operators: include = /
• Input: Character string

Priority • Operators: = / > / ≥ / < / ≤
• Input: Numeric

Message text • Operators: include = /
• Input: Character string

Fault location • Operators: include = /
• Input: Character string

Block 3 to block 10 • Operators: include = /
• Input: Character string

Process value 1 to process value 10 • Operators: = / equal (text) / include (text) / > / ≥ / 
< / ≤

• Input: Character string or numeric
Name • Operators: include = /

• Input: Character string
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Filter Setting
Area • Operators: include = /

• Input: Character string
Origin • Operators: include = /

• Input: Character string
Event message • Operators: include = /

• Input: Character string
Process value (text) to process value 9 (text) • Operators: include = /

• Input: Character string

Note
The possible filter criteria vary depending on the connected data source. 

"Text" control

Definition
The "Text" control allows you to display and format text and images. You can use special 
placeholders within the text, which are later replaced dynamically.

Layout
The "Text" control is divided into the following areas:

① Header In the header, you can edit, duplicate, delete, or enlarge the control to full screen.
② Display area The display area shows the integrated information, graphics, etc.
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Settings for the control
"Settings" dialog Description
Title Header of the control, optional
Contents Text to be displayed within the control. 

By using the buttons above the text input box, the text can be displayed as bold, 
italic, underlined, left-justified, centered, right-justified, as a list or as an enumera‐
tion. Special placeholders can be inserted using the drop-down menu on the right 
side:
• {name} – Name of the dashboard
• {description} – Description of the dashboard
• {currentdate} – Today's date

Show header and border Determines whether to display the header and border around the control.

"Report" control

Definition
The "Report" control allows you to include reports from the "Reporting" app in the dashboard. 
The report is generated once when the dashboard is opened with the parameters previously set.

Note
Rendering a report within a "Report" control in a dashboard is faster than in reporting because 
only one page is rendered at a time. 
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Layout
The "Report" control is divided into the following areas:

① Header In the header, you can edit, duplicate, delete, or enlarge the control to full screen.
② Display area The process values are displayed as configured in the display area.
③ Footer Scroll the table forward or backward in the footer or adjust the display size of the 

report.

Settings for the control
"Settings" dialog Description
Title Header of the control, optional
Report template The report template to be used for embedding. 

The selection is the same as in the "Reporting" app.
Parameter The parameters to be used to generate the report. 

Select "Edit parameters" to open the dialog for configuring the parameters. The 
dialog is functionally identical to the app.
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Step-by-step instructions for a dashboard

Creating a time filter for a dashboard

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• A dashboard is open and a control is created.

Procedure
1. Open the "Properties" dialog.
2. Select "Add".
3. Assign a name for the time filter.
4. Enter a relative or absolute value by which to filter.
5. Select "Save". 

Result
 The time filter appears in the header of the dashboard.

Filtering in dashboards by time

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A time filter for the dashboard is created.

Procedure
1. Select the time filter you want to apply in the dashboard header.
2. Select "Apply".
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Result
The time filter is applied to the dashboard.

Editing dashboard properties

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A dashboard is open.

Procedure
1. Open the "Properties" dialog.
2. Assign a name.
3. Add an optional description.
4. Select a master page for the dashboard.
5. Optionally, select a time filter or create a new time filter.

Creating a time filter for a dashboard (Page 139)
6. Select "Save".

Result
The properties of the dashboard are edited.

Configuring step-by-step instructions for controls

Configuring "Chart" control

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A dashboard is open.
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Procedure
1. Use drag-and-drop to place the "Chart" control on the dashboard.
2. Select a project in the "General" tab.
3. Select "Add" and select the appropriate tags.

The tags appear in the table.
Note
You can select several tags at the same time. They are automatically assigned different colors 
in the overview.

4. Select a tag.
5. Select the "Edit" button.
6. If needed, enable an aggregate function and set an aggregation interval.
7. Select the diagram type for displaying the data from the drop-down menu.
8. Select "Enable data labels" if required.

Note
The data label appears in the chart and shows you the data values. The data label can be 
faded in/out or displayed transparently, i.e. the label is only visible when moving the mouse 
over the position in the diagram.

9. Configure the display of the diagram and the tag values in the diagram.
10.Select the time and value axes.
11.Repeat the configuration for each tag and confirm with "Save".
12.Configure the following display options: 

– Step forward/backward
– Maximum number of values
– Legend position
– Legend in the layout
– Enable crosshairs

13.Configure one or more time and value axes in the "Time axes" and "Value axes" tabs.
Note
Vertical axis
Specify a minimum and maximum limit for the representation of the data in the diagram. The 
marking interval can be set automatically or manually.
Data modes
The following data modes are available during the parameter assignment of the control:
Data modes (Page 128) 

14.Select "Save".
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Result
A "Chart" control is configured.

Configuring "Single" control

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A dashboard is open.

Procedure
1. Use drag-and-drop to place the "Single" control on the dashboard.
2. Optionally, enter a title for the control.
3. Select a project.
4. Select a tag from the connected archives.
5. Select "Edit".
6. Optionally, enable a custom unit.
7. Optionally, define one or more high and low limits and save the settings. 

Note
Display of the limits in the control
Depending on the configuration, the limits are displayed in color in the control. If the limit is 
exceeded or undershot, the value with the selected color for this limit is displayed.

8. Select the number of decimal places displayed.
9. If required, disable the check box for displaying the quality code. 

Note
The quality code is activated by default.

10.Configure the display and description of the quality codes in the "Quality Codes" tab.
11.Select "Save".

Result
A "Single" control is configured.
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Pausing and resuming "Single" control

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A dashboard with a configured "Single" control is open.

Procedure
Select "Play/Pause" to pause or resume the "Single" control.

Note
When the control is paused the individual values are displayed. The label is visible when moving 
the mouse to the position in the diagram.

Result
The "Single" control is paused / continued.

Configuring "Tag" control

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A dashboard is open.

Procedure
1. Use drag-and-drop to place the "Tag" control on the dashboard.
2. Optionally, enter a title for the control.
3. Select a project.
4. Select the tag from a linked archive or edit a tag. 
5. Optionally, enable a custom unit.
6. Select the number of decimal places.
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7. Optionally, disable the check box for displaying the quality code.
Note
The quality code is activated by default.

8. Optionally, enable one or more aggregate functions.
– Sum
– Maximum
– Minimum
– Average

9. Select a time interval.
10.Configure the display and description of the quality codes in the "Quality Codes" tab.
11.Select "Save".

Result
A "Tag" control is configured.

Configuring "Gauge" control

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A dashboard is open.

Procedure
1. Use drag-and-drop to place the "Gauge" control on the dashboard.
2. Optionally, enter a title for the control.
3. Select a project.
4. Select a tag from the connected archives.
5. Select "Edit".
6. Optionally, enable a custom unit.
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7. Optionally, define one or more high and low limits and save the settings. 
Note
Display of the limits in the control
Depending on the configuration, the limits are displayed in color in the control. If the limit is 
exceeded or undershot, the value with the selected color for this limit is displayed.

8. Select the number of decimal places.
9. If required, disable the check box for displaying the quality code.

Note
The quality code is activated by default.

10.Define the displayed range of values for the control by entering a minimum and maximum.
11.Select the marking interval.
12.Configure the display and description of the quality codes in the "Quality Codes" tab.
13.Select "Save".

Result
A "Gauge" control is configured.

Configuring "Message" control

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A dashboard is open.

Procedure
1. Use drag-and-drop to place the "Message" control on the dashboard.
2. Optionally, enter a title for the control.
3. Select one or more projects.
4. Select the number of messages per page.

Note
If you have already configured filters for this control, you can activate/deactivate the created 
filters here.
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5. Select "Add" and between "Only for this dashboard" and "For all dashboards".
– You create a local filter group with the selection "Only for this dashboard".
– Select "For all dashboards" to create a global filter group.

6. Configure one or more filters.
Creating a filter group (Page 148)
Editing a filter group (Page 149)

7. Activate the filters you want to apply in this control.
Activating / deactivating a filter group. (Page 148)

8. Select "Save".

Result
A "Message" control is configured. You can switch between three different views, depending on 
the data source: Message list (live mode), archive list (archive mode) and hit list (statistical 
analysis mode).
Show/hide columns (Page 150)
Sorting the columns in ascending or descending order (Page 151)
Changing views (Page 151)

Configuring "Text" control

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A dashboard is open.

Procedure
1. Use drag-and-drop to place the "Text" control on the dashboard.
2. Select a title.
3. Enter a text and format the content with the tools in the input window.

Note
You can also insert hyperlinks, graphics and tables here.

4. Using the drop-down menu, you can insert the dashboard name, the description of the 
dashboard and the current date and time.
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5. Disable the "Show header and frame" option if you only want to display the contents of the 
control.

6. Select "Save".

Result
A "Text" control is configured.

Configuring "Report" control

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A dashboard is open.

Procedure
1. Use drag-and-drop to place the "Report" control on the dashboard.
2. Select a title.
3. Select a report template and configure the parameters.

Note
For details on configuration of the individual report templates, see the section "Reporting".
Report generation (Page 164)

4. Select "Save".

Note
Rendering a report as a "Report" control in a dashboard is faster than in reporting because only 
one page is rendered at a time. 

Result
A "Report" control is configured.
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Step-by-step instructions for a "Message" control

Creating a filter group

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A dashboard is open.

Procedure
1. Enter a name for the filter group.
2. Activate the "Private" option if the filter group should not be visible to all users. 
3. Create filters based on the specified criteria.

Filter criteria (Page 134)
4. Select "Add" when you have configured the filter group.

Result
The created filter group appears in the list.

Activate/deactivate filter group

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A dashboard is open.
• A "Message" control is open in edit mode and at least one filter has been created.

Procedure
1. In the overview of the filter groups, activate / deactivate the option for the filter group you 

want to activate / deactivate in the "Activated" column.
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Result
The filter group is activated / deactivated.

Editing a filter group

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A dashboard is open.
• A "Message" control is open in edit mode and a filter group has been created.

Procedure
1. Select the filter group from the list.
2. Select "Edit".
3. Edit the filter group.
4. Save your changes.

Result
The filter group is processed.

Deleting a filter group

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A dashboard is open.
• A "Message" control is open in edit mode and a filter group has been created.

Procedure
1. Select the filter group from the list.
2. Select "Delete".
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Result
The filter group is deleted.

Deleting all filter groups

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A dashboard is open.
• A "Message" control is open in edit mode and a filter group has been created.

Procedure
1. Select "Delete all".

Result
All filter groups are deleted.

Show/hide columns

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A dashboard is open and a "Message" control has been configured.

Procedure
1. Open the column settings of the table.
2. Select "Columns".
3. Activate / deactivate the columns you want to show or hide.

Result
The columns are activated / deactivated.
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Sorting the columns in ascending or descending order

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A dashboard is open and a "Message" control has been configured.

Procedure
1. Go to the column you want to sort.
2. Select "Column settings".
3. Select "Sort in ascending order" or "Sort in descending order".

Result
The columns are sorted in ascending / descending order.

Changing views

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A dashboard is open and a "Message" control has been configured.

Procedure
Select the view for the control in the footer:
• Message bar: Live mode
• Archive list: Archive mode
• Hit list: Statistical analysis mode

Result
The contents of the control are displayed in the selected view.
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Step-by-step instructions for controls in general

Editing controls

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• A dashboard is open and a control is created.

Procedure
Select "Edit control" in the control.

Result
Edit mode for the selected control opens.

Duplicating a control

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• A dashboard is open and a control is created.

Procedure
Select the "Duplicate control" option in the control.

Result
The selected control is duplicated.
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Deleting controls

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• A dashboard is open and a control is created.

Procedure
Select "Delete control" in the control.

Result
The selected control is deleted.

Enlarging controls

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers  
– SIMATIC Report Users  
– SIMATIC Report Administrators 

• A dashboard is open and a control is created.

Procedure
Select the "Enable full-screen mode" option in the control.

Note
By zooming into the control, more information is displayed in the Single and Gauge controls.

Result
The selected control is enlarged.
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3.4.2.8 Reporting

Reporting

Definition
The "Reporting" app enables the creation of reports and subscriptions. 
Report generation (Page 164)
You define the content of the report or subscription with the parameter assignment.
Reporting contains the following functions for reports: 
• Create
• Edit
• View
• Export
• Remove
• Rerun
Reporting contains the following functions for subscriptions: 
• Create
• Edit
• Remove
The report is visualized according to the selected report template, as chart, table or batch report. 
The overview and details of report templates can be found here: Report templates (Page 165)
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Structure 
Reporting is subdivided into the following areas:

① Reporting Shows the overview and configuration options for reports.
② Parameter presets Creates a parameter preset or shows the parameter presets already created.
③ Subscriptions Shows the overview and configuration options for subscriptions.

Overview table
The columns in the table are can be shown or hidden. Not all columns are shown by default.
Show/hide columns (Page 172)
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The tables in reporting provide you with an overview of the following information:

Table Column Description
Reports Preview Preview of the created report

Name Name of the report
Processing Current editing status
Created by User
Comment Comment on this report, optional entry
Created Date created
Modified Date of the last change
Parameters Project parameters: Project name, start data, end date, selec‐

ted message classes
Private Indicates whether the report is visible to all Information Server 

users or only to the user who created the report.
Cleanup Indicates whether the report is selected for automatic release 

of storage space.
Subscriptions Name Name of the subscription

Last executed Date of the last execution
Triggers A report is generated and sent based on the specified triggering 

criteria.
Parameters Project name, start data, end date
Comment Comment on this report, optional entry
Created by User
Created Date created
Modified Date of the last change
Private Indicates whether the subscription is visible to all Information 

Server users or only to the user who created the subscription.
Cleanup Indicates whether the subscription is selected for automatic 

release of storage space.
Enabled Indicates whether the subscription is activated and creates/

sends the reports for the specified triggers.
Project Selected project
Start Start time
End End time

Filter 
Depending on the column type in the column header, different filters with up to two conditions 
per column can be used via the shortcut menu.
Set filter (Page 173)
Reset filter (Page 174)

Sorting
The columns can be sorted in ascending or descending order using the shortcut menu.
Sorting the columns in ascending or descending order (Page 173)

SIMATIC Information Server
3.4 Functions

SIMATIC Information Server
156 System Manual, 02/2022, A5E51661636-AA



See also
Browsing tags (Page 159)
Parameter presets (Page 161)
Subscriptions (Page 174)

Time information

Definition
The time specifications define for reports:
• The start and end date
• A time period in which the data is accessed to evaluate the report

In the Information Server, enter absolute or relative times or select predefined times from a list.

Note
Time data in different time zones
If the Information Server and Information Server Client are in different time zones, the reports 
display the local time of the Information Server.
The inputs in the Information Server Client are in the local time of the client. 
The local time of the client is always displayed in the Excel AddIn. 
Example: The IS client is running in Germany (UTC+1), the IS server is running in China (UTC+8 ). 
The output of the query in the Excel Add-In is in UTC+1.
Exception
When using the "Create" or "Insert" options, the server time is displayed in the report. 

Absolute time information
Absolute time information describe a specific point in time.
The following table shows possible absolute times:

Absolute time information Time unit Web application
dd.mm.yyyy hh:mm:ss Date with time ✓

The following table shows examples of absolute times:

Example Description
12/08/2012 Specified date
12.08.2012 14:30:00 14:30 on the specified date

SIMATIC Information Server
3.4 Functions

SIMATIC Information Server
System Manual, 02/2022, A5E51661636-AA 157



Relative time information
Relative time information is a placeholder for a time interval. The time interval does not have an 
absolute start and end time. The relative time requires a reference time.
The reference time can be absolute or relative. If a plus sign precedes the relative time, the 
specified time interval is after the reference time. If a minus sign precedes the relative time, the 
specified time interval precedes the reference time.
The following table shows regular relative times:

Relative time information Time unit Web application
ms Millisecond ✓
s Second ✓
m Minute ✓
h Hour ✓
d Day ✓
w Week ✓
mo Month ✓
y Year ✓

The following table shows separate relative times:

Relative time information Time unit Web application
t Current day ✓
y Yesterday ✓
* Current time ✓
1-31 1st-31st of the current month ✓

Special feature of the relative time "y":
The relative time "y" denotes both a "year" and a "yesterday". The context in which "y" is used 
decides the relative time specification:
• "y" at the beginning of a time span: "y" represents the relative time specification "yesterday".
• "y" in connection with a number: "y" stands for the relative time specification "year".

Special feature of the relative time "1-31":
The relative time "1-31" contains all numbers between 1 and 31.
If one of these numbers is not used in direct connection with another relative time, the number 
stands for this day of the month.
The following table shows examples of relative times:

Example Description
12.08.12 10:00:00+1d-2h+30m 12.08.12 10:00 plus 1 day minus 2 hours plus 30 minutes
*-24h+25m Current time minus 24 hours plus 25 minutes
d-3h 00:00 of the current day minus 3 hours
*-2y-3mo Current date minus 2 years minus 3 months
y-15h Yesterday minus 15 hours
12 The 12th of the month
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Note
Using relative time information
The use of relative times is especially useful in reporting for subscription reporting. Cyclic reports 
can be generated using relative time information. 
Example: The production committee of the early shift is to be represented. Have the report 
generated for your subscription every day at 15:00 and enter *-9h and end time * as the start 
time.

See also
Creating a time filter for a dashboard (Page 139)

Browsing tags

Browsing tags

Definition
The dialog for browsing tags can be called from the following situations: 
• When creating reports with tags
• When creating subscriptions with tags
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Structure
The dialog for browsing tags is structured as follows:

① Tag hierarchy with directories and subdirectories
② Search for tags
③ Sorting and table modification

Filtering and display
Sorting and table modification
Open the shortcut menu of the table from the options in the table header. The tables can be 
sorted in ascending or descending order and columns can be shown or hidden.

Search for tags
When a search term is entered, the directory selected in the tag hierarchy is searched. If you have 
not selected a directory or subdirectory, the tag search is performed in all directories. If a 
directory is selected but the search should be performed in all directories, clicking in the empty 
area in the tag view restores the status. The search term must be contained as part of the tag 
name. Search entries consisting of multiple words are not permitted.
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Step-by-step instructions

Browsing tags

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• "Reporting" > "Report templates" > "Templates" is open.
• The "Create report" or "Create subscription" dialog opens for a report template for tags and 

a project is selected.

Procedure
1. Open the dialog for tag selection.
2. Open the tag hierarchy to expand the directories and subdirectories.
3. Select the directory from which you want to add one or more tags.
4. Select the tags you want to add from the directory overview.

Note
Filtering the tags
For more information on filtering the tags within this dialog, refer to "Browsing tags 
(Page 159)"

5. Save your selection.

Result
The selected tags are added.

Parameter defaults

Parameter presets

Definition
Parameter presets are saved presets for a report that are applied when a new report is generated 
for the selected report template. 
You can edit or delete the presets. The parameter presets are valid for the report templates for 
which they were created.
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Step-by-step instructions

Creating parameter preset

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• "Reporting" > "Report templates" > "Templates" is open.

Procedure
1. Select the desired report template from the templates.
2. Select "Create report".
3. Parameterize the report.
4.  Select "Create parameter presets".
5. Select a name.
6. If you want the presets to only be visible to yourself, select the "Private" option.

Note
Users of the "SIMATIC Report Administrators" group can view all templates, including private 
ones.

7. Select "Save".

Result
The parameter preset has been created.

Reusing parameter preset

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• "Reporting" > "Report templates" > "Templates" is open.
• A parameter preset has been created.
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Procedure
1. From the folders, choose a report template for which you are creating a new report and for 

which you have already created a parameter preset.
2. Open the drop-down list.
3. Select one of the previously created parameter presets.

Result
The parameter presets are reused and the "Create report" dialog opens with the stored presets.

Editing parameter preset

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• "Reporting" > "Report templates" > "Templates" is open.
• A parameter preset has been created.

Procedure
1. From the folders, choose a report template for which you have already created parameter 

presets. 
2. Open the drop-down menu to "Create report".
3. Select "Manage presets" 
4. Select the parameter preset that you want to edit. 
5. You can edit, delete, or move the saved presets up and down. 
6. Select "Save". 

Result
The saved parameter presets have been edited.
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Report generation

Report generation

Definition
Report generation templates are divided into: 
• Messages
• Tags
• Extended reports
• Alarm statistics
• Batch logs
Depending on the template, the representation varies between different chart forms or tables. 
The supplied templates are intended as templates for your templates and do not represent 
finished report templates. They provide an overview of the report creation functions.
Report templates (Page 165)
Use the toolbar to configure the report templates.
Report generation toolbar (Page 168)

Note
Generating an online preview for reports with many pages
When generating an online preview for reports with many pages, the displayed number of 
maximum pages per page function may temporarily not match the number of pages displayed 
in the report. 
The behavior is caused by the generation method of the preview graphics; due to the scaling, 
only up to 1000 pages are generated in each step. To make the first pages available faster, the 
first step only contains 25 pages.

Possible data sources
For PCS 7 OS and WinCC, access is possible directly to data of the OS server as well as the Process 
Historian.
For PCS neo, access is possible to the PCS neo Batch and Process Historian data.

Note
Display of report templates specific to the data source
Only the report templates that are compatible with the connected data sources are displayed in 
the reporting.
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Adapting fields in data records
After modifying an SQL query that uses the "InfoServer" data source, Microsoft Report Builder 
will display an error message regarding refreshing the fields because the Custom Data Source 
("ISRSE") used by the Information Server is incompletely supported.
If the columns output by the query do not change, you can ignore this error and confirm with 
"OK". If they change, they must first manually adjust the fields displayed in the dialog so that they 
match the columns.

Report templates

Possible data sources
For PCS 7 OS and WinCC, access is possible directly to data of the OS server as well as the Process 
Historian.
For PCS neo, access is possible to the Process Historian data.

Note
Display of report templates specific to the data source
Only the report templates that are compatible with the connected data sources are displayed in 
the reporting.
Limitation in report creation for messages and tags with a PCS neo data source
To comply with the limitation in report creation, you can either decrease the time range of the 
report or increase the aggregation interval for aggregated tags.
Limitation for tabular messages: 2500 messages
Limitation for non-aggregated tabular tags: 10000 values
Limitation for aggregated tags: 10000 intervals

Templates for messages
Template Representation Possible data sources
Duration until acknowledgment Bar chart PCS 7 OS, WinCC, PCS neo
Messages per day Bar chart PCS 7 OS, WinCC
Messages by origin Bar chart PCS 7 OS, WinCC, PCS neo
Messages by priority Bar chart PCS 7 OS, WinCC
Messages per 10 minute period Bar chart PCS 7 OS, WinCC, PCS neo
Messages by priority Pie chart PCS 7 OS, WinCC, PCS neo
Average duration until acknowledgment Bar chart PCS 7 OS, WinCC
Messages filtered by message class Table PCS 7 OS, WinCC
Messages sorted by priority Table PCS 7 OS, WinCC
Messages sorted by timestamp Table PCS 7 OS, WinCC
Commented messages Table PCS 7 OS, WinCC
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Number of messages by message class Bar chart PCS 7 OS, WinCC, PCS neo
Total duration until acknowledgment Bar chart PCS 7 OS, WinCC
Total duration until gone Bar chart PCS 7 OS, WinCC

Templates for tags
Template Representation Possible data sources
Trend Line chart PCS 7 OS, WinCC, PCS neo
Aggregation matrix Table PCS 7 OS, WinCC, PCS neo
Matrix Table PCS 7 OS, WinCC, PCS neo
Aggregation table Table PCS 7 OS, WinCC, PCS neo
Table Table PCS 7 OS, WinCC, PCS neo

Note
Using aggregates
Aggregates are easier to process than raw values because they can be displayed faster and 
produce less load. Especially when creating reports over a longer period of time, a trend is better 
recognized via aggregates than via raw values. 

Note
FAQ: Creation of report templates for the Information Server on data basis of the Process 
Historian 
This application example describes the basics and principle of operation of the Process Historian 
(PH) and the Information Server (IS). The example describes how to create individual reports in 
order to be able to promptly read out data from the PH database. In addition, you learn how to 
work with the Process Historian database.
Link to FAQ (https://support.industry.siemens.com/cs/document/64906050/creation-of-report-
templates-for-the-information-server-based-on-process-historian-data-in-the-wincc-and-pcs-7-
environment?dti=0&dl=en&lc=de-DE)

Templates for advanced reports
Template Representation Possible data sources
Message sequence Table PCS 7 OS, WinCC, PCS neo
Analog table Table PCS 7 OS, WinCC, PCS neo
Analog interval Table PCS 7 OS, WinCC, PCS neo
Analog intervals, detailed Table PCS 7 OS, WinCC, PCS neo
Analog sequence Table PCS 7 OS, WinCC, PCS neo
Operation sequence Table PCS 7 OS, WinCC, PCS neo
Operating hours Table PCS 7 OS, WinCC, PCS neo
Switching cycle Table PCS 7 OS, WinCC, PCS neo
Trend Line chart PCS 7 OS, WinCC, PCS neo
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Note
Templates for "Operating hours" and "Switching cycle"
The "Operating hours" and "Switching cycle" report templates only work with the "cntohsc" 
counter blocks from the PCS neo standard component library. 

Templates for alarm statistics
Template Representation Possible data sources
Messages per time interval Bar chart PCS 7 OS, WinCC
Messages by area Pie chart PCS 7 OS, WinCC
Messages by message class Pie chart PCS 7 OS, WinCC
Messages by quantity Table PCS 7 OS, WinCC
Messages by state Pie chart PCS 7 OS, WinCC
Chattering messages Table PCS 7 OS, WinCC
Messages per day Table/bar chart PCS 7 OS, WinCC
Messages by priority Pie chart PCS 7 OS, WinCC

PCS neo Batch templates
Template Representation Possible data sources
PCS neo Batch batch log Batch log PCS neo Batch

Time limit for creating reports

Definition
By default, a time limit is defined for creating reports, which after the defined time interval 
interrupts the creation of reports.
You can extend the time limit to prevent an interruption caused by the time limit when creating 
particularly large reports. 
To do this, follow the instructions on the following Internet site:https://technet.microsoft.com/
en-us/library/jj969577.aspx (https://technet.microsoft.com/de-de/library/jj969577.aspx)

Note
Pay special attention to the sections "Specify the report execution time-out period" and "Specify 
the user session time-out period". You can adjust the time limit for one report or for all reports.
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Report generation toolbar

Definition
The reporting toolbar contains all functions with which you can edit reports.

Structure 
The following functions are available:

① Create report 
(Page 168)

Creates a new report.

② View report (Page 169) Opens the selected report in the view mode.
③ Export report 

(Page 170)
Exports the selected report.

④ Edit report (Page 171) Opens edit mode of the selected report.
⑤ Remove report 

(Page 171)
Removes the selected report.

⑥ Rerun (Page 172) Updates the overview of the created reports.
⑦ Reset filter (Page 174) Resets the selected filter.

Step-by-step instructions

Creating a report

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• "Reporting" > "Report templates" > "Templates" is open.

Procedure
1. Select a report template.
2. Select "Create report". 
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3. Parameterize the report template
Note
Time information
For report creation, you can enter absolute and relative time information by enabling the 
"Standard" or "Relative" option under "Time range". The selectable time specifications and 
examples can be found in "Time specifications" (Page 157).

4. Select "Create report".
5. Assign a name and an optional comment.
6. Enable/disable the following options:

– Private: When you disable the option, all users of the Information Server can access the 
subscription.

– Online report: When you disable the option, no online report can be generated that can 
be displayed in the Web browser.
This reduces the load on the report server and therefore less storage space is used in the 
database.
To display the report, you must download the report.

– Cleanup: Releases the report for cleanup if too little storage space is available in the 
database. 

– Export type: Select an export format for this report.
7. Save the report.

Result
A report has been created.

Viewing a report

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• "Reporting" > "Report templates" > "Templates" is open.
• A report has been created.

Procedure
1. Select the report in the table.
2. Select the "View".
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Result
The report is shown in the display mode.

Export report

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• "Reporting" > "Report templates" > "Templates" is open.
• A report has been created.

Procedure
1. Select the report in the table.
2. Select "Export".

Note
Multiselection
Using the "Ctrl+Shift" key combination, you can select several reports in the overview at the 
same time and export them as a .zip file using the "Export" button.

Result
The report is exported.

Note
The file name contains the date and time of the report generation.
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Edit report

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• "Reporting" > "Report templates" > "Templates" is open.
• A report has been created.

Procedure
1. Select the report in the table.
2. Select "Edit".
3. Make your changes.
4. Select "Save".

Result
The report has been edited and saved.

Remove report

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• "Reporting" > "Report templates" > "Templates" is open.
• A report has been created.

Procedure
1. Select the report in the table.
2. Select "Remove".
3. Select "Yes".
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Note
Multiselection
Using the "Ctrl+Shift" key combination, you can select several reports in the overview at the 
same time and remove them simultaneously using the "Remove" button.

Result
The report is removed.

Rerun report

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• "Reporting" > "Report templates" > "Templates" is open.
• A report has been created.

Procedure
1. Select the report in the table.
2. Select "Repeat".

Result
The report is run again and appears in the overview.

Show/hide columns

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• Reporting is open.
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Procedure
1. Open the column settings of the table.
2. Select "Columns".
3. Activate / deactivate the columns you want to show or hide.

Result
The columns are activated / deactivated.

Sorting the columns in ascending or descending order

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• Reporting is open.

Procedure
1. Go to the column you want to sort.
2. Select "Column settings".
3. Select "Sort in ascending order" or "Sort in descending order".

Result
The columns are sorted in ascending / descending order.

Set filter

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• Reporting is open.
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Procedure
1. Go to the column you want to filter. 
2. Select "Column settings".
3. Configure the filter for the selected column with up to two conditions.

Result
The filter is enabled.

Reset filter

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• "Reporting" > "Report templates" > "Templates" is open.
• One or more filters have been parameterized for the table.

Procedure
1. Select "Reset filter".

Result
The filtering in the table is reset.

Subscriptions

Subscriptions

Definition
A subscription is a regularly recurring report that according to set parameters:
• retrieves data
• evaluates data
• triggers reports when a specified event occurs 
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For the subscription, relative times are used, with which you can compare certain data, for 
example, weekly or monthly. 
Time information (Page 157)

Subscriptions toolbar

Definition
The toolbar contains all functions for configuration of subscriptions.

Structure
The following functions are available:

① Create subscription 
(Page 175)

Creates a subscription.

② Edit subscription 
(Page 177)

Opens edit mode of the selected subscription.

③ Remove subscrip‐
tion (Page 177)

Removes the selected subscription.

④ Reset filter 
(Page 179)

Resets the selected filter.

Step-by-step instructions

Creating a subscription

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• "Reporting" > "Report templates" > "Templates" is open.

Procedure
1. Select the report template for which you are creating the subscription.
2. Select "Create subscription". 
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3. Enter a name for the subscription. 
Note
Text fields whose names are shown in italics are optional.

4. Disable the following settings as required:
Settings for subscriptions (Page 184)

5. Select the parameters for the subscription.
Note
Corresponding tag trigger
When creating a subscription for a tag, you can add a corresponding tag trigger to your 
defined parameters in the "Create subscription" dialog. This appears in the "Trigger" tab. This 
replaces steps 6 to 8.

6. Select the "trigger" tab.
7. Open the list of triggers with "Add". 
8. Use the triggers to specify when the reports are created.

Trigger for subscriptions (Page 180)
9. Select the export format. The following formats are available: 

– PDF
– Microsoft Excel
– Microsoft Word
– XML
– Microsoft HTML

10.Define the report parameters in the "Parameter" tab.
11.Select a delivery method in the "Delivery method" tab. 

Delivery method (Page 183)
12.Select "Save".

Result
The subscription is created and appears in the list.
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Edit subscription

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• "Reporting" > "Report templates" > "Templates" is open.
• A subscription has been created.

Procedure
1. Select the subscription you want to edit in the list of subscriptions.
2. Edit the subscription.
3. Select "Save".

Result
The subscription has been edited.

Deleting a subscription

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers 
– SIMATIC Report Users 
– SIMATIC Report Administrators

• "Reporting" > "Report templates" > "Templates" is open.
• A subscription has been created.

Procedure
1. Select the subscription you want to delete in the list of created subscriptions.
2. Select "Delete subscription"
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Note
Multiselection
You can use the Ctrl+Shift key combination to select multiple subscriptions and the "Delete" 
button to delete them simultaneously.

Result
The subscription is deleted.

Show/hide columns

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• Reporting is open.

Procedure
1. Open the column settings of the table.
2. Select "Columns".
3. Activate / deactivate the columns you want to show or hide.

Result
The columns are activated / deactivated.

Sorting the columns in ascending or descending order

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• Reporting is open.
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Procedure
1. Go to the column you want to sort.
2. Select "Column settings".
3. Select "Sort in ascending order" or "Sort in descending order".

Result
The columns are sorted in ascending / descending order.

Set filter

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• Reporting is open.

Procedure
1. Go to the column you want to filter. 
2. Select "Column settings".
3. Configure the filter for the selected column with up to two conditions.

Result
The filter is enabled.

Reset filter

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• "Reporting" > "Report templates" > "Templates" is open.
• The table with subscriptions is filtered.
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Procedure
In the "Subscriptions" area, select "Reset filter".

Result
The filters in the table are reset and all subscriptions created are displayed unfiltered.

Trigger for subscriptions

Definition
Triggers are pre-defined events which have to occur to ensure that a pre-defined action is 
initiated. 
Subscriptions can be triggered by:
• Time trigger
• Tag trigger
• Message trigger

Note
Message triggers are only available for the PCS 7 and WinCC data sources.

Time trigger
One or more fixed times trigger the subscription. 

One-off time trigger
This time trigger is only initiated once at a specified point in time.

Recurring time trigger
Recurring time triggers are initiated cyclically by defined time parameters.
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The following recurring triggers can be configured:
• "Daily" frequency:

Selection Description
Daily Enter number
Frequency per day "Once" or "Recurring"
Frequency per day > Once Select time of day
Frequency per day > Recurring • Specify delay per minute or hour

• Define start, optionally also end

• "Weekly" frequency:

Selection Description
Weekly Enter number
Weekday Select day of week, multiselection possible
Frequency per day "Once" or "Recurring"
Frequency per day > Once Select time of day
Frequency per day > Recurring •  Specify delay per minute or hour

• Define start, optionally also end

• "Monthly" frequency for an "Absolute" offset:

Selection Description
Offset "Absolute"
Day of the month Between 1 and 31
Monthly Enter number
Frequency per day "Once" or "Recurring"
Frequency per day > Once Select time of day
Frequency per day > Recurring • Specify delay per minute or hour

• Define start, optionally also end

• "Monthly" frequency for a "Relative" offset:

Selection Description
Offset "Relative"
Week of the month Select week: First, Second, Third, Fourth or Last
Weekday Select week of the month 
Frequency per day "Once" or "Recurring"
Frequency per day > Once Select time of day
Frequency per day > Recurring • Specify delay per minute or hour

• Define start, optionally also end
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Note
Full-day recurring subscriptions
If you want to create a subscription that generates recurring reports around the clock, define 
00:00 as the start time. 

Tag trigger
The selected tag triggers the subscription. 

Select one of the following event types for the tag:
• On change
• High limit
• Low limit
• High and low limit

Note
Corresponding tag trigger
When creating a subscription for a tag, you can add a corresponding tag trigger to your defined 
parameters in the "Create subscription" dialog. This appears in the "Trigger" tab.

Message trigger
The selected message triggers the subscription. 

Authorization matrices for subscriptions

Authorization matrices for subscriptions
Authorization matrix for public subscriptions:

User Read Write Delete
Owner Yes Yes Yes
Administrator Yes Yes Yes
Publisher Yes Yes Yes
User No No No
Viewer No No No
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Authorization matrix for private subscriptions:

User Read Write Delete
Owner Yes Yes Yes
Administrator Yes Yes Yes
Publisher No No No
User No No No
Viewer No No No

Delivery method

Definition
Select one of the various delivery methods for the created subscription in the "Delivery method" 
tab. 

Layout
The following options are available:
• Only in the database: The report is only saved in the database.
• Folder: The report is saved locally or via a network share in the folder.

Note
Parameter %-ts%
The file name in the target folder consists of the specified file name and the timestamp. If no 
file name is specified, the name of the subscription and the timestamp is used. The reports 
are saved to the target folder after triggering the specified trigger.
If the file should always be overwritten with the current report, the following key must be 
added to the file name: <file name>%-ts%
The key only replaces the file in the target folder.

• E-mail: This e-mail contains the report as an attachment. The priority of the e-mail is set to 
"Normal" by default.

• E-mail (link): This e-mail contains a link to the report in the specified target directory.

Note
Delete after delivery
If you select the option "Delete after delivery", the report is deleted from the database after 
successful delivery. The "Online report" option can be disabled automatically.

SIMATIC Information Server
3.4 Functions

SIMATIC Information Server
System Manual, 02/2022, A5E51661636-AA 183



Settings for subscriptions

Definition
When creating a subscription, you can make settings relating to privacy, delivery or use of 
storage space.

Settings
Setting Description
Private If you disable the option, all users of the Information Server can access the sub‐

scription.
Enabled If you disable the option, the subscription can no longer provide reports.
Online report If you disable the option, no online report can be generated that can be displayed 

in the Web browser. This reduces the load on the report server and therefore less 
storage space is used in the database. To display the report you have to download 
the report.
If PDF is selected as the export format, the online report is available at:
• Creation with "Create report"
• Creation by means of a subscription with the transmission method "Only in 

the database" or "Email (link)".
Clean up reports Provides the reports for cleanup if too little storage space is available in the 

database. 

3.4.2.9 Download

Download
The "Download" app allows you to install the Information Server Office add-in on your computer. 
The following options are available for installation:
• You have already installed the Microsoft Office add-in when you installed the SIMATIC 

Information Server.
• You install the add-in directly from the Web application via the "Download" app.

Installing the Office add-in (Page 185)

Note
Note the requirements for the installation.
Requirements for installing the Office add-in (Page 57)
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Step-by-step instructions

Installing Office add-in with the web application

Requirement
You are a member of the Windows user group SIMATIC Report Administrators.

Procedure
1. Check if all requirements for installing the add-in are met.

Requirements for installing the Office add-in (Page 57)
Note
Close all Windows programs before running setup for the Office add-in.

2. Download the Office add-in from the Web application.
Downloading the Office add-in from the Web application (Page 72)

3. Perform the setup for the installation of the add-in.
4. Connect the Office add-in to the Information Server.

Connecting Office add-in with a stored certificate to the Information Server (Page 73)

Result
The Office add-in has been installed.
Opening an Office add-in (Page 227)

Note
HTTP Proxy
This configuration must be performed additionally for all computers that require an HTTP proxy 
and use the Information Server web application or the Information Server Excel add-in.
1. Open the "Internet options" dialog from the Start menu.
2. In the "Internet Properties" dialog, select the "Connections" tab. 
3. Select "LAN Settings".
4. Activate the option "Proxy server". 
5. Select "Advanced".
6. For "Exceptions", enter the complete FQDN name of the Information Server computer.

This name must match the CN of the HTTPS certificate (see above).
7. Confirm your entry.
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3.4.2.10 Administration

Administration

Definition
In the Administration app you make central settings for the Information Server. 
The administration consists of the following areas:
• Project configuration
• User configuration
• App configuration
• Email settings
• Licensing
• App installation
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Structure
The administration has the following structure:

① Email settings 
(Page 200)

Opens the email settings.

② Licensing (Page 210) Opens the overview of licenses.
③ User configuration 

(Page 219)
Opens the user configuration.

④ Project configuration 
(Page 212)

Opens the project configuration.

⑤ App installation 
(Page 209)

Opens the app installation.

⑥ App configuration In the configuration for reporting, edit:
• Report templates
• Report Clean Up (Page 195)
Edit the master pages in the configuration for the dashboard.
• Master pages (Page 188)

Subsequent integration of the Information Server into a domain

Requirement
• You have administrative rights in the domain.
• You are entered as an administrator in the local Windows user group.
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Procedure
1. Add the computer on which the Information Server is installed to the domain. 
2. Create a new domain user. 

Note
This step is not necessary if there is already a designated service user to run the Information 
Server with access to the data sources.

3. Add the new domain user to the "SIMATIC Report Administrators" and "SIMATIC Report 
Services" groups. 

4. Start the SIMATIC Web Configurator:
C:\Program Files\Siemens\InformationServer\ConfigurationManager
\ConfigurationManager.exe

5. In the service configuration dialog, specify the domain user credentials from step 2.
6. Restart the system. 
7. Log in with the domain user credentials and configure the web browser settings. 

Configuring browser settings for the Information Server (Page 63)

Result
The first logon operation, in combination with the Windows user group, creates the new profile 
in the database.

Dashboard app configuration

Master pages

Definition
With the master page selected, you define the layout of the dashboard. 
It is possible to create, configure and assign any number of master pages for the dashboard 
layout.

Toolbar for master pages

Definition
The toolbar contains all functions for configuring the master pages for the dashboards.

SIMATIC Information Server
3.4 Functions

SIMATIC Information Server
188 System Manual, 02/2022, A5E51661636-AA



Structure 
Administration > "Configuration" > "Dashboard" contains the following functions:

① Create a master page 
(Page 189)

Creates a master page.

② Deleting a master 
page (Page 190)

Deletes the selected master page.

③ Saving a master page 
(Page 190)

Saves the master page.

④ Duplicate a master 
page (Page 190)

Duplicates the selected master page.

⑤ Exporting a master 
page (Page 191)

Exports the selected master page.

⑥ Importing a master 
page (Page 191)

Opens the dialog to import an existing master page.

Step-by-step instructions

Create master page

Requirement
• You are a member of the SIMATIC Report Administrators Windows user group. 
• "Administration" > "Configuration" > "Dashboard" is open.

Procedure
1. Select "Create".
2. Assign a title.
3. Optionally choose a background color.
4. Optionally choose a font color.
5. Optionally, configure a header.

Configure header for a master page (Page 192)
6. Optionally, configure a footer.

Configure footer for a master page (Page 192)

Result
The master page is created.
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Deleting a master page

Requirement
• You are a member of the SIMATIC Report Administrators Windows user group. 
• "Administration" > "Configuration" > "Dashboard" is open.
• A master page is created.

Procedure
Select the master page that you want to delete.

Result
The selected master page is deleted.

Saving a master page

Requirement
• You are a member of the Windows user group SIMATIC Report Administrators. 
• "Administration" > "Configuration" > "Dashboard" is open.
• A master page has been edited.

Procedure
Select "Save" to save the changes to the master page.

Result
The changes to the master page are saved.

Duplicate a master page

Requirement
• You are a member of the SIMATIC Report Administrators Windows user group. 
• "Administration" > "Configuration" > "Dashboard" is open.
• A master page is created.
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Procedure
1. Select the master page that you want to duplicate.
2. Select "Duplicate".

Result
The selected master page is duplicated.

Exporting a master page

Requirement
• You are a member of the SIMATIC Report Administrators Windows user group. 
• "Administration" > "Configuration" > "Dashboard" is open.
• A master page is created.

Procedure
1. Select the master page you want to export.
2. Select "Export".

Result
The master page is exported to the local repository.

Importing a master page

Requirement
• You are a member of the SIMATIC Report Administrators Windows user group. 
• "Administration" > "Configuration" > "Dashboard" is open.
• A master page is stored locally.

Procedure
1. Select "Import".
2. Select the file to be imported with "Select file".
3. Confirm your selection with "Import".

Result
The master page is imported and is displayed in the overview.
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Configure header for a master page

Requirement
• You are a member of the Windows user group SIMATIC Report Administrators. 
• "Administration" > "Configuration" > "Dashboard" > "Creation" is open.

Procedure
1. Enable "Use image" if you want to add a graphic to the default header for the master page. 

Note
If you do not need a header line, enable "No header". 
By default, the header contains a placeholder for a title and a description.

2. Upload the image to the header by selecting the field provided for the image and opening the 
corresponding image for upload in the dialog.

3. If you want to create a custom layout for the header, enable the "Use user-defined header" 
button.

4. Enter text for the header and format the text using the tools in the input window.
– Bold, italic or underlined
– Align right, centered, align left
– List or enumeration
– Indentation
– Insert hyperlinks, images or tables
– Placeholder for dashboard title, description, and current date

Result
The header for a master page is configured.

Configure footer for a master page

Requirement
• You are a member of the Windows user group SIMATIC Report Administrators. 
• "Administration" > "Configuration" > "Dashboard" > "Creation" is open.
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Procedure
1. Select the "Use user-defined footer" button if you want to use a user-defined layout for the 

master page footer. 
Note
If you do not need a footer, enable "No footer". 
The footer is hidden by default.

2. Upload the image to the footer by selecting the field provided for the image and opening the 
corresponding image for upload in the dialog.

3. Enable the "Use user-defined footer" button if you want to use a user-defined layout for the 
footer.

4. Enter text for the footer and format the text using the tools in the input window.
– Bold, italic or underlined
– Align right, centered, align left
– List or enumeration
– Indentation
– Insert hyperlinks, images or tables
– Placeholder for dashboard title, description, and current date

Result
The footer for a master page is configured.

Reporting app configuration

Reporting (Administration)

Definition
The report generation of the web application allows the use of different report templates for 
messages, tags, extended reports, alarm statistics and batch logs. 
The following functions are available in the "Administration > Reporting" area for the existing 
report templates:
• Sort
• Export/Import
• Show/hide
• Create/delete folders for report templates
• Show/hide folders for report templates
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The Report Clean Up allows you to make settings for optimal storage use.
Report Clean Up (Page 195)

Toolbar in Reporting (Administration)

Definition
The toolbar contains all functions for configuration of report templates.

Structure
The following functions are available for the folders:

① Create folder (Page 195) Creates a new folder.
② Rename folder (Page 195) Opens the edit mode for the name of the selected folder.
③ Delete folder (Page 196) Deletes the selected folder.
④ Show/hide folder (Page 196) Shows/hides the selected folder.

The following functions are available for the report templates:

① Import report template (Page 197) Imports a report template.
② Export report template (Page 197) Exports the selected report template.
③ Move report template (Page 198) Moves the selected report template.
④ Delete report templates (Page 198) Deletes the selected report template.
⑤ Show/hide a report template 

(Page 199)
Shows/hides the selected report template.

See also
Configuring storage space (Page 199)
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Report Clean Up

Definition
Report Cleanup allows you to configure a limit for storing reports. When this limit is reached, 
database or disk space is automatically freed by stopping reporting, or exporting or deleting 
reports.

Application recommendations
Configuring storage space (Page 199)

Step-by-step instructions

Create folder

Requirement
• You are a member of the Windows user group SIMATIC Report Administrators.
• "Administration > Configuration > Reporting > Templates" is open.

Procedure
1. Select "Create".
2. Enter a name for the new folder.
3. Select "Save".

Result
A folder has been created.

Renaming folders

Requirement
• You are a member of the Windows user group SIMATIC Report Administrators.
• "Administration > Configuration > Reporting > Templates" is open.

Procedure
1. Select the folder you want to rename.
2. Select "Rename".
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3. Enter the new name.
4. Select "Save".

Result
The folder is renamed.

Delete folder

Requirement
• You are a member of the Windows user group SIMATIC Report Administrators.
• "Administration > Configuration > Reporting > Templates" is open.

Procedure
1. Select the folder you want to delete.
2. Select "Delete".
3. Confirm the security prompt with "Yes".

Result
The folder is deleted.

Show/hide folder

Requirement
• You are a member of the Windows user group SIMATIC Report Administrators.
• "Administration > Configuration > Reporting > Templates" is open.

Procedure
1. Select the folder you want to show/hide.
2. Select "Show/hide".

Result
The folder is shown / hidden.
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Import report template

Requirement
• You are a member of the Windows user group SIMATIC Report Administrators.
• "Administration > Configuration > Reporting > Templates" is open.

Note
Importing report templates
With report templates you have created yourself or acquired externally ensure that they do no 
contain any free-text parameters as this can lead to security risks with regard to SQL injections.

Procedure
1. Select "Import".
2. Select a file from the local repository in the "Select file" folder.

Note
File formats 
The report templates can be files in the following formats: 
• .rdl for reports for SQL Server Reporting Services (.rdl = Report Definition)
• .ert for Excel reports (.ert = Excel report template)
Importing report templates with the same name
When you import a report template that already exists with the same name in the Web 
application, the report template in the Web application is overwritten by the imported report 
template without prompting.

3. Confirm the selection with "Open".

Result
The report template is imported.

Export report template

Requirement
• You are a member of the Windows user group SIMATIC Report Administrators.
• "Administration > Configuration > Reporting > Templates" is open.

SIMATIC Information Server
3.4 Functions

SIMATIC Information Server
System Manual, 02/2022, A5E51661636-AA 197



Procedure
1. Select a template that you want to export.
2. Select "Export".

Result
The report template is exported to the local repository folder.

Move report template

Requirement
• You are a member of the SIMATIC Report Administrators Windows user group.
• "Administration > Configuration > Reporting > Templates" is open.

Procedure
1. Select the template you want to move.
2. Select "Move".
3. Select the new location in the "Move template" dialog.
4. Confirm with "OK".

Result
The report template is moved to the new location.

Delete report template

Requirement
• You are a member of the SIMATIC Report Administrators Windows user group.
• "Administration > Configuration > Reporting > Templates" is open.

Procedure
1. Select the template you want to delete.
2. Select "Delete".
3. Confirm the security prompt with "Yes".

Result
The report template is deleted.
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Show/hide a report template

Requirement
• You are a member of the Windows user group SIMATIC Report Administrators.
• "Administration > Configuration > Reporting > Templates" is open.

Procedure
1. Select the template you want to show/hide.
2. Select "Show/hide".

Result
The report template is shown/hidden.

Configuring storage space

Requirement
• You are a member of the Windows user group "SIMATIC Report Administrators".
• "Administration > Configuration > Reporting > Report Cleanup" is open.

Procedure
1. Activate the "Report Clean Up".
2. Specify whether the Report Cleanup is triggered by a time trigger, reaching a size limit, or 

both. 

Trigger Setting
Time • Once: One-time triggering of the Report Cleanups

• Recurring: Configure the following for the Report Clean Up:
– the start
– optionally the end 
– the frequency 

Size limit of the database • Enter the maximum size in MB
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3. Select the action that is performed when initiating the trigger.

Action Setting
Stop report generation -
Delete reports/
Export reports

• Selected for cleanup:
You can select reports and subscriptions as prioritized in Report 
Cleanup when they are created. This enables you to clean up re‐
ports by weighting. 

• All:
All reports are treated the same in a Report Clean Up.

4. Specify a path to a folder to which the reports can be exported for the "Export reports" action. 
Note
The folder may not be on the drive where the database is located.

5. Specify the number of days after which the reports are deleted or exported for the "Delete 
reports" and "Export reports" actions.
Note
Enter "0" to continually run the Report Cleanup.

6. Select "Save". 

Result
The storage space settings have been configured.

E-mail settings

E-mail settings

Definition
Configure the SMTP server settings for sending Information Server reports by e-mail.

Application recommendations
Configuring e-mail settings (Page 201)
Testing e-mail settings (Page 209)
Resetting e-mail settings to factory defaults  (Page 209)

SIMATIC Information Server
3.4 Functions

SIMATIC Information Server
200 System Manual, 02/2022, A5E51661636-AA



Step-by-step instructions

Configuring e-mail settings

Requirement
• You are a member of the Windows user group "SIMATIC Report Administrators".
• "Administration > E-mail settings" is open.

Procedure
1. Activate e-mail transmission.
2. Select an e-mail provider from the list.
3. Enter the information required for your selection:

– Configure generic email settings (Page 201)
– Configure email settings for a Gmail account (Page 203)
– Configure email settings for an Office 365 account (Page 202)

4. Select "Save".

Result
The e-mail settings are created.

Note
You can test your entries by pressing the "Test settings" button. A test e-mail is sent to the stored 
e-mail address. Use "Reset" to restore the original state and enter the settings again.
Testing e-mail settings (Page 209)
Resetting e-mail settings to factory defaults (Page 209)

Configuring generic e-mail settings

Requirement
• You are a member of the Windows user group "SIMATIC Report Administrators".
• "Administration > E-mail settings" is open.
• E-mail delivery is enabled and "Generic" is selected as the e-mail provider.
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Procedure
1. Enter the server IP address or host name of the server from which e-mails are sent.
2. Select a port.
3. Enter your user name and password
4. Select an e-mail address that is displayed as the sender's e-mail address to the recipients of 

the e-mails.
5. Select "Save".

Result
The e-mail settings for a generic mail account are created.
Test your settings by sending a test e-mail.

Configuring email settings for an Office 365 account

Requirement
• You are a member of the Windows user group "SIMATIC Report Administrators".
• "Administration > E-mail settings" is open.
• E-mail delivery is enabled and "Office 365" is selected as the e-mail provider.
• You are registered for the "Microsoft 365 Developer Program".

Developer Program (https://developer.microsoft.com/en-us/microsoft-365/dev-program)

Procedure
1. Create the application.

Creating an application (Page 203)
2. Generate a client secret.

Generating a client secret (Page 204)
3. Add an API permission.

Adding API permissions (Page 205)
4. Configure the e-mail settings in the Information Server.

Configuring e-mail settings in the IS (Office 365) (Page 205)

Result
The e-mail settings for an Office 365 account are created.
You can test the settings by sending a test e-mail.
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Configuring email settings for a Gmail account

Requirement
• You are a member of the Windows user group "SIMATIC Report Administrators".
• "Administration > E-mail settings" is open.
• E-mail delivery is enabled and "Gmail" is selected as the e-mail provider.
• The Google APIs & Services  (https://console.developers.google.com/  

// XmlEditor.InternalXmlClipboard:4384213f-03bd-06e4-c704-bf7e9539203d)page is open 
and you are logged in with an existing Gmail account.

Procedure
1. Enable the Gmail API terms.

Enabling the Gmail API (Page 206)
2. Configure the "OAuth consent screen".

Configuring the "OAuth consent screen" (Page 207)
3. Create credentials.

Creating "Credentials" (Page 207)
4. Configure the e-mail settings in the Information Server.

Configuring e-mail settings in the IS (Gmail) (Page 208)

Result
The e-mail settings for a Gmail account are created.
You can test the settings by sending a test e-mail.

Note
You can test your entries by pressing the "Test settings" button. A test e-mail is sent to the stored 
e-mail address. Use "Reset" to restore the original state and enter the settings again.

Creating an application

Requirement
• You are a member of the Windows user group "SIMATIC Report Administrators".
• "Administration > E-mail settings" is open.
• E-mail delivery is enabled and "Office 365" is selected as the e-mail provider.
• You are registered for the "Microsoft 365 Developer Program".

Developer Program (https://developer.microsoft.com/en-us/microsoft-365/dev-program)
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Create application
1. Open the following link to the start page of Azure.

Azure home page (https://portal.azure.com)
2. Select "Azure Active Directory" in the menu.
3. In the "App registrations" menu, select the "Register an application" option.
4. Complete the fields for registration. 

– Assign a name for the application.
– Select "Accounts in any organizational directory (any Azure AD directory-multitenant) 

and personal Microsoft accounts (e.g. Skype, ...)".
– Under "Redirect URI" in the drop-down menu, select the option "Web" as the application 

type.
– Copy the required address from the last line of the "Email Settings" dialog in the App 

administration in the Web application of the Information Server.
5. Confirm with "Register" for data generation.

Note
In the overview, you can find the Client ID and Tenant ID that you will need in the following 
steps to complete the e-mail settings in the Information Server Web application.

Result
The application is created.

Generating a client secret

Requirement
• You are a member of the Windows user group "SIMATIC Report Administrators".
• "Administration > E-mail settings" is open.
• E-mail delivery is enabled and "Office 365" is selected as the e-mail provider.
• You are registered for the "Microsoft 365 Developer Program".

Developer Program (https://developer.microsoft.com/en-us/microsoft-365/dev-program)

Generate a client secret
1. Open the application you created via "Azure Active Directory" > "Manage" > "App registration" 

> "Owned applications".
You are in the overview of the application.

2. In the "Certificates & secrets" menu item, select "New client secret".
The "Add a client secret" page opens.

3. Enter a description and select an "Expires" option.
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4. Confirm with "Add".
The created generated document appears in the overview.

5. Copy the value of the generated document to the e-mail settings of the Information Server.

Result
A client secret is generated.

Adding API permissions

Requirement
• You are a member of the Windows user group "SIMATIC Report Administrators".
• "Administration > E-mail settings" is open.
• E-mail delivery is enabled and "Office 365" is selected as the e-mail provider.
• You are registered for the "Microsoft 365 Developer Program".

Developer Program (https://developer.microsoft.com/en-us/microsoft-365/dev-program)

Add API permissions
1. Open "Azure Active Directory" > "Manage" > "API permissions" .
2. Select "Add a permission".
3. Select "Microsoft Graph".
4. Select "Delegate permissions".
5. Add the following permissions:

– Mail.Send: Send mail as a user
– openid: Sign users in
– User.Read: Sign in and read user profile

Result
The API permissions are added.

Configuring e-mail settings in the IS (Office 365)

Requirement
• You are a member of the Windows user group "SIMATIC Report Administrators".
• "Administration > E-mail settings" is open.
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• E-mail delivery is enabled and "Office 365" is selected as the e-mail provider.
• You are registered for the "Microsoft 365 Developer Program".

Developer Program (https://developer.microsoft.com/en-us/microsoft-365/dev-program)

Configure e-mail settings in the IS
1. Open "Administration" > "E-mail settings".
2. Enable the settings.
3. Insert the required information that you created in the previous steps with Azure.
4. Select "Get authorization token" .
5. Enter the required Microsoft credentials.
6. Accept the required authorizations.
7. Select "Save".

Result
The e-mail settings in IS are configured.

Enabling the Gmail API

Requirement
• You are a member of the Windows user group "SIMATIC Report Administrators".
• "Administration > E-mail settings" is open.
• E-mail delivery is enabled and "Gmail" is selected as the e-mail provider.
• The Google APIs & Services  (https://console.developers.google.com/  

// XmlEditor.InternalXmlClipboard:4384213f-03bd-06e4-c704-bf7e9539203d)page is open 
and you are logged in with an existing Gmail account.

Enable the Gmail API
1. Select "Dashboard" in the sidebar. 
2. Select "Create project".

If a project has already been created, select the existing project. Proceed to step 4.
3. Enter the required data and select "Create".
4. Select the created project from the menu bar.
5. Select "Enable APIs and services".
6. Select "Gmail API" from the list.
7. Confirm the selection of the Gmail API with "Enable".
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Result
The Gmail API is enabled.

Configuring the "OAuth consent screen"

Requirement
• You are a member of the Windows user group "SIMATIC Report Administrators".
• "Administration > E-mail settings" is open.
• E-mail delivery is enabled and "Gmail" is selected as the e-mail provider.
• The Google APIs & Services  (https://console.developers.google.com/  

// XmlEditor.InternalXmlClipboard:4384213f-03bd-06e4-c704-bf7e9539203d)page is open 
and you are logged in with an existing Gmail account.

Configure the "OAuth consent screen"
1. Select "OAuth consent screen" in the sidebar.
2. Select as "User Type" > "External" and confirm with "Create".
3. In the following, enter the "App name" and the "User support e-mail".
4. Enter the e-mail address under "Developer contact information".
5. Confirm with "Save and continue".

Result
The created application can be seen in the overview of the "OAuth consent screen" page. 

Creating "Credentials"

Requirement
• You are a member of the Windows user group "SIMATIC Report Administrators".
• "Administration > E-mail settings" is open.
• E-mail delivery is enabled and "Gmail" is selected as the e-mail provider.
• The Google APIs & Services  (https://console.developers.google.com/  

// XmlEditor.InternalXmlClipboard:4384213f-03bd-06e4-c704-bf7e9539203d)page is open 
and you are logged in with an existing Gmail account.

Create "Credentials"
1. Select "Credentials" in the sidebar. 
2. Select "Create credentials" from the menu bar and select "OAuth client ID".
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3. Fill in the following fields: 
– Application type: Web application
– Name 
– Authorized redirect URI: Copy from the "E-mail settings" dialog > "Redirect URI".

4. Confirm with "Create".

Result
The "ClientID" and "ClientSecret" client data have been created under "Credentials". 

Configuring e-mail settings in the IS (Gmail)

Requirement
• You are a member of the Windows user group "SIMATIC Report Administrators".
• "Administration > E-mail settings" is open.
• E-mail delivery is enabled and "Gmail" is selected as the e-mail provider.
• The Google APIs & Services  (https://console.developers.google.com/  

// XmlEditor.InternalXmlClipboard:4384213f-03bd-06e4-c704-bf7e9539203d)page is open 
and you are logged in with an existing Gmail account.

Configure e-mail settings in the IS
1. Open "Administration" > "E-mail settings".
2. Enable the settings.
3. Insert the required information that you created in the previous steps with Azure.
4. Select "Get authorization token" .
5. Enter the required Microsoft credentials.
6. Accept the required authorizations via "Advanced" > "Go to siemens.net (unsafe)" > "Allow".
7. Confirm the authorizations with "Allow".
8. Select "Save".

Result
The e-mail settings in IS are configured.
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Testing e-mail settings

Requirement
• You are a member of the Windows user group "SIMATIC Report Administrators".
• "Administration > E-mail settings" is open.
• The e-mail settings are created.

Procedure
Select the "Test settings" button.

Result
A test e-mail is sent to the stored e-mail address.

Resetting e-mail settings to factory defaults

Requirement
• You are a member of the Windows user group "SIMATIC Report Administrators".
• "Administration > E-mail settings" is open.
• The e-mail settings have been configured.

Procedure
Select "Reset".

Result
The original state of the e-mail settings is restored and you can re-enter the settings.

Application Installer

Application Installer

Definition
The Application Installer is a wizard for updating the apps in the Web application. You are 
automatically forwarded to the start page of the Application Installer if you open the Web 
application and an app is not up-to-date. 
If all apps are up to date, the overview provides information about the current versions of the 
apps. 
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Step-by-step instructions

Using the Application Installer

Requirement
• You are a member of the Windows user group "SIMATIC Report Administrators".
• "Administration > Application Installer" is open.

Procedure
Select the "Install or update application".

Result
The application in the Application Installer have been installed and/or updated.

Licensing

Licenses

License types 
The following products are available:

Products for PCS 7
The SIMATIC Information Server provides the following products for PCS 7:

Product Order number (MLFB)
Information Server Basic Package 6ES7652-7EX68-2YB0

6ES7652-7EX68-2YH0
Information Server (1 Client) 6ES7652-7YA00-2YB0

6ES7652-7YA00-2YH0
Information Server (3 Clients) 6ES7652-7YB00-2YB0

6ES7652-7YB00-2YH0
Information Server (5 Clients) 6ES7652-7YC00-2YB0

6ES7652-7YC00-2YH0
Information Server Datasource Access (1 Source) 6ES7652-7YE00-2YB0

6ES7652-7YE00-2YH0
Information Server Datasource Access (3 Sources) 6ES7652-7YF00-2YB0

6ES7652-7YF00-2YH0
Upgrade Package Process Historian and Informa‐
tion Server, V9.0 to V9.1

6ES7652-8AX68-2YE0
6ES7652-8AX68-2YH0
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Products for WinCC
The SIMATIC Information Server provides the following products for WinCC:

Product Order number (MLFB)
Process Historian und Information Server 2020 SP1,
Software Media Package

6ES7652-7AX68-0YT8
6ES7652-7AX68-0YH8

Note
MLFB numbers
MLFB numbers ending with 2YB0/2YE0/2YT8 are goods deliveries. 
MLFB numbers ending with 2YH0/0YH8 are OSD deliveries (downloads). 

Products for PCS neo
The SIMATIC Information Server provides the following products for PCS neo:

Product Order number (MLFB)
Information Server 6DL8906-0AC10-0AB5
Information Server Client Access 6DL8906-0BC10-0AB5

List of clients
The clients include:
• Any browser when connected to the Information Server

License count for client access
Each active client connection of the Information Server requires a license. The number of clients 
depends on the number of PCs, not on the number of applications that are open on a PC. Even 
when multiple report clients are connected to the Information Server from a PC, only one license 
is required.
Assignment of a client license:
• Connection with the Information Server via Internet browser/Web application
• Use of various URLs which the server cannot identify as one source
Release of a client license:
• Logout from the Web application 
• Inactivity after 20 minutes
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Trial license
The setup of the Information Server also installs a trial license. The trial license can be selected 
in the license query.
• 14-day validity
• Start of 14 day period on the day of first use
The trial version becomes a full version when you install a full license. Reinstallation is not 
necessary.

Step-by-step instructions

Check licenses

Requirement
• You are a member of the Windows user group "SIMATIC Report Administrators".
• "Administration > Licensing" is open.

Procedure
Check the status in the table to see if you are using a valid Information Server license.

Result
The present licenses have been checked.

Project configuration

Project configuration

Definition
In the project configuration, you create new projects or edit existing projects that you use as data 
sources in Reporting and Dashboard. When you select a data source in the folder structure, you 
can see the metadata of the data source in the work area, for example, creation date, version or 
project type. 
The following functions are available:
• Create new folder
• Add project
• Rename project
• Delete project
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Note
Project archiving
After selecting an available project, you can see its project type, for example: PCS neo.  
Assign an alias for projects with the same name to be able to assign the data sources during 
report creation.

Synchronization
By synchronizing, you trigger a manual transfer of the data sources stored in the Information 
Server database to the DataHost service. The DataHost service has an independent data archive 
for this data.
Synchronization is necessary, for example, if the configuration data in the Webframe database 
have been modified manually or the DataHost configuration file has been corrupted.

Diagnostics run
The diagnostic run provides the following information:
• DataHost: Checks if the DataHost service installed on the Information Server is working 

correctly. This service is used for the browsing of variables, for example. 
• Trigger Service: Checks if the IS Ready Trigger Service installed on the data source is working 

correctly. This service is used for the creation of variable triggers. 
• Update Service: Checks whether the IS Ready Update service installed on the data source is 

working correctly. This is responsible for detecting configuration changes in the data source 
that need to be communicated to the DataHost service. 

• RuntimeData Service: Checks whether the IS Ready Runtime Data service installed on the 
data source is working correctly. This is used when querying certain runtime data in the 
dashboard. 

• Diagnostics Service: Checks if the diagnostic service installed on the data source is working 
correctly. This is relevant for the evaluation and query of error states.

• Batch: Checks whether the Information Server Batch Stored Procedures required by the 
DataHost have been correctly installed in the HistorianStorage database. 

• Organizational structure consistency: Checks if the referenced project still exists in the 
HistorianStorage database. 

• Performance Monitor Stored Procedures: Checks if the stored procedures required by the 
Performance Monitor DataHost plugin have been installed correctly.

Host change
If you move a project like PH or WinCC to another computer, you have to adjust the host 
accordingly.
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Toolbar in project configuration

Definition
The toolbar contains all functions for project configuration.

Structure
The following functions are available:

① Create new folder (Page 215) Creates a new folder.
② Add project (Page 215) Adds a new project.
③ Rename project (Page 216) Renames the selected project.
④ Delete project (Page 217) Deletes the selected project.
⑤ Start a diagnostics run (Page 217) Starts a diagnostics run.
⑥ Assign authorizations (Page 218) Opens the dialog for configuration of authorizations.
⑦ Change host (Page 218) Opens the dialog box for changing the host.
⑧ Start simulation (Page 214) Synchronizes the entries.

Step-by-step instructions

Start simulation

Requirement
• You have administrative permissions for the Information Server.
• "Administration > Project configuration" is open.

Procedure
Select "Synchronize".

Result
Synchronization is complete.
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Create new folder

Requirement
• You are a member of the Windows user group "SIMATIC Report Administrators" or "SIMATIC 

Report Publishers". This enables you to connect a data source, e.g. Process Historian 
database.

• Users of the "SIMATIC Report Services" group must be created both on the Information Server 
and on the PC on which the data source is located. 
The user must have SIMATIC HMI rights on the PC with the data source.

• The Process Historian has been activated.
• "Administration > Project configuration" is open.

Procedure
1. Select "New folder".
2. Assign a name.
3. Select "Save".

Result
A new folder for the projects is created and visible in the hierarchy.

Add project

Requirement
• You have administrative permissions for the Information Server.
• "Administration > Project configuration" is open.

Procedure
1. Select "Add project".
2. Select a data source type and enter the host name.

Note
Pay attention to the correct selection of the data source type in connection with WinCC 
projects.

Example configuration Data source type to be used Server name
PCS 7/WinCC without Process 
Historian

SIMATIC PCS 7/WinCC Server name of the primary OS

PCS 7/WinCC with Process His‐
torian

SIMATIC Process Historian Server name of the Process His‐
torian
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3. Select "Select project".

Data source type  
SIMATIC PCS 7/WinCC Select the name of the data source.
Other data source types Select the projects you want to add and enter 

their names.

4. Select "Add".

Result
One or more projects are added.

Rename project

Requirement
• You are a member of the Windows user group "SIMATIC Report Administrators" or "SIMATIC 

Report Publishers". This enables you to connect a data source, e.g. Process Historian 
database.

• Users of the "SIMATIC Report Services" group must be created both on the Information Server 
and on the PC on which the data source is located. 
The user must have SIMATIC HMI rights on the PC with the data source.

• The Process Historian has been activated.
• "Administration > Project configuration" is open.

Procedure
1. Select the project you want to rename.
2. Select "Rename".
3. Assign a new name.
4. Save your input.

Result
The project is renamed.
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Delete project

Requirement
• You are a member of the Windows user group "SIMATIC Report Administrators" or "SIMATIC 

Report Publishers". This enables you to connect a data source, e.g. Process Historian 
database.

• Users of the "SIMATIC Report Services" group must be created both on the Information Server 
and on the PC on which the data source is located. 
The user must have SIMATIC HMI rights on the PC with the data source.

• The Process Historian has been activated.
• "Administration > Project configuration" is open.

Procedure
1. Select the project you want to delete.
2. Select "Delete project".
3. Confirm your selection.

Result
The selected project is deleted.

Starting a diagnostic run

Requirement
• You have administrative permissions for the Information Server.
• "Administration > Project configuration" is open.

Procedure
1. Select a project.
2. Select "Start diagnostics".

Note
You can save the log files of the diagnostic run locally using "Download log files".

Result
A table with the results of the diagnostic run opens. The table provides an overview of the 
features and their status.
The diagnostic run is completed.
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Assigning authorizations

Requirement
• You are a member of the Windows user group SIMATIC Report Administrators.
• "Administration > Project configuration" is open.

Procedure
1. Select a project.
2. Select "Authorizations".
3. Select the user to whom you want to assign authorizations for this project in the form of roles. 

By clicking in the text field, a drop-down menu opens in which all users are stored.
4. Select the roles you want to assign to the selected user from the list. By clicking in the text 

field, a drop-down menu opens with all the roles you can assign.
Note
If you want to revoke authorizations from the user, remove the corresponding check marks 
from the role.

5. Select "Save".

Result
The authorizations for the user are assigned.

Changing the host

Requirement
• You have administrative permissions for the Information Server.
• "Administration > Project configuration" is open.

Procedure
1. Select the project for changing the host.
2. Select "Change host"
3. Enter a host name in the field "hostname".
4. Select "OK".

Result
The host has been adjusted. 
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You can view the changed metadata in the overview of the selected project.

User configuration

User configuration

Definition
You use user management to define the properties of the users and groups.
You can see the following information in the overview for the created users:
• Stored e-mail addresses
• Language settings
• Associated Windows user groups

The following functions are available:
• Create new users
• Edit new users
• Configure group authorizations for the Windows user groups.

Note
To manage users and assign them to Windows user groups, use Windows Computer 
Management. 

The Information Server uses the following local Windows user groups: 

Windows user group Rights
SIMATIC Report Services This group should only be assigned to the user under which the 

Information Server services run:
• Information Server Scheduler
• Datahost
• IIS Worker Process.

SIMATIC Report Administrators Unrestricted access to all functions of the Information Server
SIMATIC Report Users Create and configure reports and dashboards
SIMATIC Report Publishers Create and load reports and dashboards
SIMATIC Report Viewers Read access to reports and dashboards
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Note
If you are a member of the "SIMATIC Report Services" Windows user group, assign yourself to 
another user group to use the Information Server.

Mapping of UMC and Windows groups in PCS neo

User groups of the Information Server in PCS neo
The following description applies to the scenario of the initial login to the Information Server via 
PCS neo. 
During this step, the UMC groups which the UMC user is assigned to are once mapped to the 
corresponding groups in the IS. A "SIMATIC PCS neo Runtime Management Engineer" thus 
becomes a "SIMATIC Reporting User". If there are multiple UMC groups that apply, the IS groups 
are assigned additively. This process makes it possible for the user to be assigned to any number 
of groups, whereby the highest-level permissions apply.

Note
The "SIMATIC Report ..." groups do not exist initially. These groups must be created by the 
administrator. 
All information and related links on the topic of user administration are available in the following 
section:
Project administration > User administration > Working with the user administration

Mapping of groups
When the user is a member of one of the following UMC groups, the user is applied to the 
corresponding IS groups.

UMC group Corresponding IS group Description
SIMATIC PCS neo System Adminis‐
trators

SIMATIC Report Administra‐
tors

Predefined UMC group

SIMATIC PCS neo Device Integration 
Engineers

SIMATIC Report Users Predefined UMC group

SIMATIC PCS neo Project Manage‐
ment Engineers

SIMATIC Report Administra‐
tors

Predefined UMC group

SIMATIC PCS neo Runtime Manage‐
ment Engineers

SIMATIC Report Users Predefined UMC group

SIMATIC Report Administrators SIMATIC Report Administra‐
tors

The group must be created by the 
UMC administrator.

SIMATIC Report Publishers SIMATIC Report Publishers The group must be created by the 
UMC administrator.

SIMATIC Information Server
3.4 Functions

SIMATIC Information Server
220 System Manual, 02/2022, A5E51661636-AA



SIMATIC Report Users SIMATIC Report Users The group must be created by the 
UMC administrator.

SIMATIC Report Viewers SIMATIC Report Viewers The group must be created by the 
UMC administrator.

Toolbar in user configuration

Definition
The toolbar contains all functions for user configuration.

Structure
The following functions are available:

① Create user 
(Page 221)

Creates a user.

② Edit user (Page 222) Opens the edit mode of the selected user.
③ Delete user 

(Page 223)
Deletes the selected user.

④ Manage groups Opens the dialog for group management:
• Create user groups (Page 224)
• Edit user groups (Page 224)
• Delete user groups (Page 225)

Step-by-step instructions

Create user

Requirement
• You are a member of the Windows user group SIMATIC Report Administrators.
• "Administration" > "User configuration" is open.

Procedure
1. Select "Create user".
2. Select the user you want to create.
3. Select "Save".
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Note
Alternatively, you can create a user by adding the user to a SIMATIC Report group on your 
computer. When users log on for the first time, they are created as Information Server users. 
Users can then be assigned to other groups in the Web application. 

Result
The user is created and appears in the overview.

Edit user

Requirement
• You are a member of the Windows user group SIMATIC Report Administrators.
• "Administration" > "User configuration" is open.

Procedure
1. Select the user whose settings you want to edit.
2. Make the required settings for the user:

Tab Settings
General • Display name 

• E-mail address 
• Language 
• Locked
• Delete all status data of the application

Notifications Select notifications
Groups/Permissions • Groups

• Additional permissions
Effective permissions Overview of permissions

3. Select "Save".

Result
The user is edited.
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Activate / deactivate user

Requirement
• You are member of a Windows user group or registered as local user in the domain.
• "Administration" > "User configuration" is open.

Procedure
1. Select the user you want to activate / deactivate.
2.  Select "Activate / deactivate user".
3. Confirm the selection with "Continue".

Result
The user is activated / deactivated.

Delete user

Requirement
• You are a member of the Windows user group SIMATIC Report Administrators.
• "Administration" > "User configuration" is open.
• At least one user has been created.

Procedure
1. Select the user you want to delete.
2. Select "Delete user".
3. Select "Save".

Result
The user has been marked as deleted in the database, but not completely removed. 
This results in the user no longer appearing in the overview.

Note
Restore user
• If the user was not deactivated before deletion, he can restore his account by logging in again.
• An administrator can manually restore the account via "Create user".
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Creating a user group

Requirement
• You are a member of the Windows user group SIMATIC Report Administrators.
• "Administration" > "User configuration" is open.

Procedure
1. Select "Manage groups".
2. Select "Add".
3. Enter a name and a description for the group.
4. Activate the permissions for the group.
5. Select "Save".

Result
The user group has been created and appears in the overview.

Editing a user group

Requirement
• You are a member of the Windows user group SIMATIC Report Administrators.
• "Administration" > "User configuration" is open.

Procedure
1. Select "Manage groups".
2. Select a group.
3. Select "Edit".
4. Edit the name and description of the group.
5. Activate or deactivate permissions for the selected group.
6. Select "Save".

Result
The user group is edited.
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Deleting user groups

Requirement
• You are a member of the Windows user group SIMATIC Report Administrators.
• "Administration" > "User configuration" is open.

Procedure
1. Select "Manage groups".
2. Select a group.
3. Select "Delete".
4. Select "Save".

Result
The user group is deleted.

3.4.3 Office add-in

3.4.3.1 Excel Office add-in

Definition
Within the Excel Office add-in, you can insert, create and edit reports.
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Structure
The Excel Office add-in consists of the following areas: 

① Toolbar 
(Page 228)

Provides access to the features of the Excel Office add-in.

② Footer 
(Page 255)

Shows the connection status of the Office add-in.

③ Work area Shows the added reports, messages and tags.

3.4.3.2 Report types in the Office add-in

Definition
There are two types of reports in the Office add-in:
• Report template

You can create a report on the Information Server and insert it as a graphic in an Excel file. 
Report generation corresponds to the procedure in the Web application of the Information 
Server.

• Excel report templates
You can create report templates for Excel. Process values or messages are inserted into the 
cells of an Excel worksheet. When relative times are used, you can update the cell contents. 
You use the Excel functions to process the data. For example, you can use the Excel graphics 
function to visualize process value trends.
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3.4.3.3 Subscriptions for report templates in Excel

Definition
You can subscribe to reports from report templates created with Excel and stored on the 
Information Server. The formulas and diagrams contained in the reports are automatically 
updated.
The difference between the templates you create in Excel and the templates from the Web 
application is that the Excel templates in the Information Server are generated either by MS Excel 
or via Open XML, while the Web application templates are generated via the MS Report Server.

Note
To support the automatic update of formulas and charts, MS Excel must be installed on the 
server. The Information Server attempts to generate Excel reports via MS Excel. If Excel is not 
available on the server, the reports are generated via Open XML and some formulas and 
diagrams may not be automatically updated.

3.4.3.4 Step-by-step instructions

Open Office add-in

Requirements
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A connection to the Information Server is established.

Procedure
1. Open the Office add-in. 
2. Navigate to the "Information Server" tab.

Result
The Office add-in is opened.
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3.4.3.5 Toolbar in Excel

Definition
The toolbar gives you access to the functions of the Office add-in. 

Layout 
The toolbar consists of the following areas: 

① Create (Page 229) Create a report in Excel
② Tags • Create tags

• Configure tags
• Delete tags

③ Messages • Create messages
• Configure messages
• Delete messages

④ Update (Page 244) Update the Excel workbook.
⑤ Open • Open locally saved Excel reports

• Open Excel reports from the Information Server
⑥ Save • Save Excel report templates locally

• Save Excel report templates to the Information Server
⑦ Server (Page 245) Open the server settings
⑧ About / Help Open the information about the Information Server add-in.
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Step-by-step instructions

Creating a report in Excel

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• The Information Server tab is open in Microsoft Excel.
• A connection to the Information Server is established.

Procedure
1. Select "Create" in the "Reports" section. 
2. In the "Create report" dialog, navigate to "Report templates > Templates" in the folder tree.
3. Select the report template that you use to create the report. 
4. Configure the report template or apply a saved parameter default under "Parameter 

defaults", if available.
Note
Creating, applying or deleting parameter defaults
Here, you can accept parameter presets that you have already created in the Web application, 
create new parameter presets with the "+" button or delete existing ones. 
You can find information about creating parameter presets in Excel under: Parameter 
defaults in Excel (Page 253)
You can find information about creating parameter presets in the Web application 
under: Creating parameter preset (Page 162)

5. Select "Create report". 

Note
Display of queries with multiple-page results
For queries with multiple-page results, only the first page is displayed.

Result
A report has been created.
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Opening locally saved Excel reports

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• The Information Server tab is open in Microsoft Excel.
• A connection to the Information Server is established.

Procedure
1. Select "Select the local file" in the "Configuration" area.
2. Select a report in the local repository and confirm the dialog.

Note
File format
The following file format is required for the import: .ert
Create folder
You can create a new order in the hierarchy using the keyboard shortcut "Ctrl+N" or the shortcut 
menu.
Delete folder
You can delete a selected folder in the hierarchy using the "Del" key or the shortcut menu.
The folder must be empty to perform the operation successfully. 

Result
A report template is open.
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Open Excel reports from the Information Server

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A connection to the Information Server is established.
• The Information Server tab is open in Microsoft Excel.

Procedure
1. Select "Open" in the "Configuration" area.
2. In the Information Server repository, select the report to be imported and confirm the dialog.

Note
File format
The following file format is required for the import: .ert
Create folder
You can create a new order in the hierarchy using the keyboard shortcut "Ctrl+N" or the shortcut 
menu.
Delete folder
You can delete a selected folder in the hierarchy using the "Del" key or the shortcut menu.
The folder must be empty to perform the operation successfully. 

Result
A report template is imported.
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Saving Excel report templates locally

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A connection to the Information Server is established.
• A report template is configured.

Procedure
1. In the "Configuration" area, select the option to save locally.
2. Select a storage location for the report and confirm the dialog for saving.

Note
Create folder
You can create a new order in the hierarchy using the keyboard shortcut "Ctrl+N" or the shortcut 
menu.
Delete folder
You can delete a selected folder in the hierarchy using the "Del" key or the shortcut menu.
The folder must be empty to perform the operation successfully.

Result
A report template is saved.

Save Excel report templates to the Information Server

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A connection to the Information Server is established.
• A report template is configured.
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Procedure
1. Select "Save" in the "Configuration" area.
2. Select a location on the Information Server for the report and confirm the dialog.

Note
Create folder
You can create a new order in the hierarchy using the keyboard shortcut "Ctrl+N" or the shortcut 
menu.
Delete folder
You can delete a selected folder in the hierarchy using the "Del" key or the shortcut menu.
The folder must be empty to perform the operation successfully.

Result
A report template is exported.

Creating a subscription in Excel

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A connection to the Information Server is established.
• The Information Server tab is open in Microsoft Excel.

Procedure
1. Select "Save".
2. Select a folder to which to save the template in the "Save" dialog.
3. Name the template.
4. Enter a description for the template.
5. Select "Save".
6. Open the Web application of the Information Server.
7. In Reporting, navigate to the selected template location.
8. Open the Edit mode for the Excel report template.
9. Configure the Excel report template.
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10.Select "Create subscription".
Note
These subscriptions only generate reports in Microsoft Excel format. The generated reports 
appear in the "Reports" overview of the created template in Reporting.
Details on configuration of subscriptions:
Creating a subscription (Page 175)

11.Save your entries.

Result
A subscription is created.

Create tag

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A connection to the Information Server is established.
• The Information Server tab is open in Microsoft Excel.

Procedure
1. Select "Tags" in the "Excel Workbook" area.
2. In the "Add or edit tags" dialog, select a project.

Note
Project selection
The last selected project is automatically selected the next time the dialog is opened.
Select the "Update" button to update the selection of projects in the drop-down list.

3. Navigate to an archive and add one or more tags to the "Selected tags" overview by double-
clicking or using drag-and-drop.
Note
Displaying newly added tags
If you have added new tags to the selection and want to edit them, close the Excel worksheet 
and reopen the dialog to create or edit the tags.

4. Confirm the input with "OK".
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Result
The tag is created.

Configuring tag

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A connection to the Information Server is established.
• The Information Server tab is open in Microsoft Excel.

Procedure
1. Select "Tags" in the "Excel Workbook" area.
2. In the "Add or edit tags" dialog, select a project.

Note
Project selection
The last selected project is automatically selected the next time the dialog is opened. 
Select the "Update" button to update the selection of projects in the drop-down list.
Tags
The last configured tags are displayed in the table.

3. Select the tag you want to edit in the "Selected tags" overview.
Note
Displaying newly added tags
If you have added new tags to the selection and want to edit them, close the Excel worksheet 
and reopen the dialog to create or edit the tags.

4. You configure the following standard parameters independently of the mode selected in the 
line of the tag:
Editing standard parameters of the tag (Page 236)
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5. In the "Mode" column, select one of the configuration modes and make the settings for the 
selected mode.
Setting the configuration mode for tags (Page 237)

6. Confirm the input with "OK".
Note
Enable maximum number
If the maximum number of values is set, values are output from the beginning of the time 
interval up to the maximum number. If the maximum number is greater than the number of 
values present in the time interval, the "Max. number" setting is ignored. 

Result
The tag is configured.

See also
Time information (Page 157)

Configuring the standard parameters of the tag

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A connection to the Information Server is established.
• The Information Server tab is open in Microsoft Excel.
• The tag you want to edit is selected in the "Selected tags" overview.

Procedure
Configure the following standard parameters directly in the line of the tag:

Parameter Description
Start Select a start date for the tag.

You can enter absolute and relative times here. The released time information 
and examples can be found in the section "Time information" (Page 157). 

End Select an end date for the tag.
You can enter absolute and relative times here. The released time information 
and examples can be found in the section "Time information" (Page 157).
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Parameter Description
Cell reference Select the target cell for the tag in the Excel worksheet.

You can click on the button in the "Cell reference" row. The dialog collapses so 
that you can directly select a cell and the value is applied. Alternatively, enter 
the value of a cell directly.

Sheet orientation Select the orientation of the form.
• Horizontal
• Vertical

Labeling Specify whether and which labels the cells have in the Excel worksheet. The 
labeling position depends on the sheet orientation (horizontal/vertical).
• No label
• Above (vertical): The names of the columns are above the values.
• Below (vertical): The names of the columns are below the values.
• Right (horizontal): The names of the columns are to the right of the values.
• Left (horizontal): The names of the columns are to the left of the values.

Time stamp Specify whether the values have a time stamp.
• No label
• Left: The time stamp is located to the left of the values.
• Right: The time stamp is located to the right of the values.

Quality Code Select the position of the quality identifier.

Result
The default parameters of the tags are configured.

Setting the configuration mode for tags

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A connection to the Information Server is established.
• The Information Server tab is open in Microsoft Excel and the "Add or edit tags" dialog is 

displayed.

Procedure
In the "Mode" column, select one of the following configuration modes and make the settings 
for the selected mode.
• Single value: A tag value is displayed according to the selected mode.
• Time series: The tag values are displayed unchanged or interpolated in a time series.
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Configuration 
mode

Value mode Description

Single value Original
 
 

"Back" limit mode: "Back" mode searches backwards for the first incoming single 
value from the specified point in time. The specified time must be specified to the 
nearest millisecond. The function searches the last 30 minutes from the specified 
time. If there is no value in this time interval, an empty line is output.
"Next" limit mode: "Next" mode searches forward for the first incoming single 
value from the specified point in time. The function searches a maximum of 30 
minutes from the specified time. If there is no value in this time interval, an empty 
line is output.

Interpolated "Interpolated" mode calculates the value from the previous and the following 
value at the selected point in time. If there is a value at the selected time, there is 
no need to select the mode.

Current The "Current" mode updates the fixed value in the table for the specified cycle (unit 
seconds).
If the value is set to "0", update the value via "Run". 

Time series Original "Inside" limit mode: Contains the values in the specified time interval.
"Outside" limit mode: Contains the last value before the time interval begins and 
the next value after the end of the time interval.
"Back" limit mode: "Back" mode searches backwards for the first incoming single 
value from the specified point in time. The specified time must be specified to the 
nearest millisecond. The function searches the last 30 minutes from the specified 
time. If there is no value in this time interval, an empty line is output.
"Next" limit mode: "Next" mode searches forward for the first incoming single 
value from the specified point in time. The function searches a maximum of 30 
minutes from the specified time. If there is no value in this time interval, an empty 
line is output.

Interpolated "Interpolated" mode calculates the value from the previous and the following 
value at the selected point in time. If there is a value at the selected time, there is 
no need to select this mode. For example, The time interval is one minute, the time 
interval for interpolation is ten seconds, i.e. six interpolated values, one value per 
ten seconds. 

Calculated "Max" calculation method: Determines the maximum value per interval. Select 
one of the modes under "Time stamp": Start of the interval min/max time stamp.
"Min" calculation method: Determines the minimum value per interval. Select one 
of the modes under "Time stamp": Start of the interval min/max time stamp.
"Mean value" calculation method: forms the arithmetic mean
"Integral (linear)" calculation method: Forms the integral via the linear interpola‐
tion function of the tag
"Integral (Sample-and-Hold)" calculation method: Forms the integral via the sam‐
ple-and-hold interpolation function of the tag
"Sum" calculation method: Calculates the sum of all tag values per interval.

Result
Configuration mode is set.
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Deleting a tag

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A connection to the Information Server is established.
• The Information Server tab is open in Microsoft Excel.
• A report template is open and contains a tag.

Procedure
1. Select "Tags".

The "Add or edit tags" dialog opens.
2. Select the tag you want to delete from the "Selected tags" overview.
3. Select the "Remove" button.

Result
The tag is deleted.

Create message

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A connection to the Information Server is established.
• The Information Server tab is open in Microsoft Excel.
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Procedure
1. In the "Excel Workbook" area, select the "Messages" option. 
2. Select a project in the "Add or edit messages" dialog. 

Note
Project selection
The last selected project is automatically selected the next time the dialog is opened. 
Select the "Update" button to update the selection of projects in the drop-down list.

3. To create a default filter for a message, select the "Add message configuration" button.
Note
The filter for the message appears in the "Message configurations" list. One output per filter 
appears in the Excel worksheet. If you select a filter for a message in the "Message 
configurations" overview, you can configure the filter directly in the line. 

4. Repeat the procedure from step 3 until you have inserted all the desired filters for the 
messages. 

5. Confirm the dialog with "OK". 
Note
When you move the mouse pointer over the text field for values in the Excel worksheet, a 
tooltip informs you of the name of the message block. 

Result
The message is created.

Configuring a message

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A connection to the Information Server is established.
• The Information Server tab is open in Microsoft Excel.
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Procedure
1. In the "Excel Workbook" area, select the "Messages" option. 
2. Select a project in the "Add or edit messages" dialog. 

Note
Project selection
The last selected project is automatically selected the next time the dialog is opened.
Select the "Update" button to update the selection of projects in the drop-down list.
Messages
The last configured messages are displayed in the table. 

3. From the "Message configuration" overview, select the filter for the message that you want 
to edit.

4. You configure the following standard parameters independent of the mode selected in the 
message line:
Configuring the standard parameters of the message (Page 242)

5. Select one or more attributes for the message in the "Selected attributes" column. 
Note
The attributes are project-dependent. The order of the attributes in the table is referenced by 
the order of the selection. If you change the order, remove the entire selection and enable it 
again in the desired order.

6. Use the message filter to select additional filter criteria for the message attributes. 
Configuring a message filter (Page 246)
Note
You can use the message filter to define additional criteria for the attributes of the messages. 
The criteria limit the number of messages displayed.
You have the possibility to configure any number of filters. Select the attribute, operand, and 
value for one filter per line. You can also use the selection box to define the dependencies 
between the individual filters. 

7. If needed, enable the "Maximum number" option and enter a number.
Note
If the maximum number of values is set, values are output from the beginning of the time 
interval up to the maximum number. If the maximum number is greater than the number of 
values present in the time interval, the "Max. number" setting is ignored.
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8. Repeat the procedure from step 5 until you have inserted all the desired filters for the 
messages.
Note
When you move the mouse pointer over the text field for values in the Excel worksheet, a 
tooltip informs you of the name of the message block.

9. Confirm your changes with "OK". 

Result
The message is configured.

See also
Time information (Page 157)

Configuring the standard parameters of the message

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A connection to the Information Server is established.
• The Information Server tab is open in Microsoft Excel.
• The message that you want to edit is selected in the "Message configuration" overview.

Procedure
Edit the following standard parameters directly in the line of the message:

Parameter Description
Name Name of the message configuration
Start Select a start date for the message.

You can enter absolute and relative times here. The released time information 
and examples can be found in the section "Time information" (Page 157).

End Select an end date for the notification.
You can enter absolute and relative times here. The released time information 
and examples can be found in the section "Time information" (Page 157).

Cell reference Select the target cell for the message in the Excel worksheet.
You can click on the button in the "Cell reference" row. The dialog collapses so 
that you can directly select a cell and the value is applied. Alternatively, enter 
the value of a cell directly.
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Parameter Description
Sheet orientation Select the orientation of the form.

• Horizontal
• Vertical

Labeling Specify whether and which labels the cells have in the Excel worksheet. The 
labeling position depends on the sheet orientation (horizontal/vertical).
• No label
• Above (vertical): The names of the columns are above the values.
• Below (vertical): The names of the columns are below the values.
• Right (horizontal): The names of the columns are to the right of the values.
• Left (horizontal): The names of the columns are to the left of the values.

Result
The standard parameters of the messages are edited.

Delete message

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A connection to the Information Server is established.
• The Information Server tab is open in Microsoft Excel.

Procedure
1. Select "Messages".

The "Add or edit messages" dialog opens.
2. In the "Add or edit messages" dialog, select the message you want to delete from the 

"Selected messages" overview.
3. Select the "Remove" button in the "Selected messages" overview.

Result
The message is deleted.
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Updating an Excel workbook

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A connection to the Information Server is established.
• The Information Server tab is open in Microsoft Excel.
• A tag or message is inserted in the Excel worksheet.

Procedure
In the "Excel Workbook" area, select the "Run" option to retrieve archive data.

Result
For the configured tags and/or messages, data from the connected data sources are retrieved 
and displayed.

Display process values graphically

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A connection to the Information Server is established.
• The Information Server tab is open in Microsoft Excel.
• An Excel worksheet is opened in which process values are available.

Procedure
1. Select the process values and the corresponding time stamps that you want to evaluate 

graphically.
2. Navigate to the "Insert" tab.
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3. In the "Charts" area, select the chart type with which you want to graphically display the 
process values.

4. Place the inserted chart at the desired position.
Note
If you have selected relative time data, choose "Run" and the process values in the chart are 
updated.

Result
The process values are displayed graphically.

Configuring server settings

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• The Information Server tab is open.

Procedure
1. Select the "Server" option in the "Configuration" area. 
2. Enter the Information Server name or IP address.
3. Select "Save".

Result
The server settings are configured.

3.4.3.6 Message filters

Message filters

Definition
The selection of messages from the defined time range can be further limited by message 
filters. These can be created through message configuration using the "Add" button in the 
"Message filter" column. In the following dialog, filters can be specified for individual message 
attributes; a comparison operator and a comparison value is stored for each of these attributes.
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Logic operations
By default, these filters are linked with a logical "AND". Alternatively, a logical "OR" can be 
selected by adapting the type of link between two filters in the "And/Or" column.

Grouping
You have the option of logically grouping sequences of filters. To do this, place a check mark in 
the first column for the required filters and then press the button labeled "{=" in the column 
heading.

Note
The grouping is only possible for filters which are directly above one another. 
The grouping can be canceled by pressing the "X" button in the colored group marker.

Step-by-step instructions for message filters

Configuring a message filter

Requirement
• You are a member of one of the following Windows user groups:

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• A connection to the Information Server is established.
• The Information Server tab is open in Microsoft Excel.
• The "Add or edit messages" dialog is opened and a message is created.

Procedure
1. Open the dialog in the Message filter column.
2. In the "Attribute" column, select an attribute as filter criterion.
3. Make the desired entries in the "Operator" and "Value" columns.
4. Link several attributes with operands.

Note
You use conditions to restrict the attributes that are output.

5. Select "Apply" to apply the filter settings for the message block.
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Result
The message filter is configured. 

3.4.3.7 Simplified operation

Simplified operation

Definition
The following tips to make operation more simple apply to the tables in the dialogs "Add or edit 
tags" and "Add or edit messages".

Filters for the "Message configurations" and "Selected tags" tables
You have the option to filter the tables by name, cell reference or project.
Filter table (Page 248)

Replace tag 
The previously added tag in the list is replaced by the selected tag from the overview. 
Replace tag (Page 249)

Select multiple messages / tags
There are several ways to select multiple messages and tags at the same time.
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Select multiple messages/tags (Page 253)

Transfer parameters for several fields in the table
You can match up the parameters for several messages / tags in one step.
Apply parameters (Page 249)

Layout of the buttons for simplified operations
The buttons in the dialogs "Add or edit tags" and "Add or edit messages" are located below the 
tables and are structured as follows:

① Copy (Page 250) The message / tag or its configuration is deleted.
② Paste (Page 251) The completely copied message / tag is inserted.
③ Transfer configura‐

tion (Page 251)
The configuration of the copied message / tag is transferred to the selected 
message / tag. The name of the message / tag is retained.

④ Delete (Page 252) The message / tag is deleted. You can select several lines by holding down the 
Shift key and delete them all at one time.

Step-by-step instructions for simplified operation

Filter table

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• The Information Server tab is open in Microsoft Excel.
• A connection to the Information Server is established.
• Several messages / tags are created in the "Add or edit tags" or "Add or edit messages" dialogs.

Procedure
Enter the term you want to filter by in the row: 
• Name
• Cell reference
• Project
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Result
The filtered results are displayed in the table.

Replace tag

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• The Information Server tab is open in Microsoft Excel.
• A connection to the Information Server is established.
• At least one tag is created in the "Add or edit tags" dialog.

Procedure
1. Select a tag from the list of tags that have already been added.
2. In the overview, select a new tag that you want to use to replace the selected tag in the list.
3. Click "Replace". 

Result
The previously added tag in the list is replaced by the selected tag from the overview. 

Apply parameters

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• The Information Server tab is open in Microsoft Excel.
• A connection to the Information Server is established.
• Several messages / tags are created in the "Add or edit tags" or "Add or edit messages" dialogs.
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Procedure
1. Select the row in the table for which you want to adapt the parameters.
2. Change a parameter of the message/tags and draw a blue frame in the lower right corner 

around the field for all fields that adopt the same value.

Result
The input value is copied for the selected fields.

Copy message/tag or its configuration

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• The Information Server tab is open in Microsoft Excel.
• A connection to the Information Server is established.
• Several messages / tags are created in the "Add or edit tags" or "Add or edit messages" dialogs.

Procedure
1. Select a message / tag.

Note
Multiselection
You can select several lines for this action by holding down the Shift key.

2. Select the "Copy" button.

Result
The message / tag or its configuration is copied.
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Insert copied message/tag

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• The Information Server tab is open in Microsoft Excel.
• A connection to the Information Server is established.
• Several messages / tags are created in the "Add or edit tags" or "Add or edit messages" dialogs.

Procedure
1. Select a message / tag.

Note
Multiselection
You can select several lines for this action by holding down the Shift key.

2. Select the "Paste" button. 

Result
The completely copied message / tag is inserted.

Transfer configuration of the copied message/tag

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• The Information Server tab is open in Microsoft Excel.
• A connection to the Information Server is established.
• Several messages / tags are created in the "Add or edit tags" or "Add or edit messages" dialogs.
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Procedure
1. Select a message / tag.

Note
Multiselection
You can select several lines for this action by holding down the Shift key.

2. Select the "Insert content" button. 

Result
The configuration of the copied message / tag is transferred to the selected message / tag. The 
name of the message / tag is retained.

Delete message/tag

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• The Information Server tab is open in Microsoft Excel.
• A connection to the Information Server is established.
• Several messages / tags are created in the "Add or edit tags" or "Add or edit messages" dialogs.

Procedure
1. Select a message / tag.

Note
Multiselection
You can select several lines for this action by holding down the Shift key.

2. Select the "Delete" button. 

Result
The message / tag is deleted. 
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Select multiple messages/tags

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• The Information Server tab is open in Microsoft Excel.
• A connection to the Information Server is established.
• Several messages / tags are created in the "Add or edit tags" or "Add or edit messages" dialogs.

Procedure
You can select multiple messages / tags at the same time:
• Hold the Shift key to select multiple rows at once.
• Mark the rows using the rubber band selection with the mouse.

Result
The messages / tags are selected.

3.4.3.8 Parameter defaults in Excel

Parameter defaults in Excel

Definition
You have the following options:
• Accept parameter defaults that are already created in the Web application
• Create new parameter presets with the "+" button
• Delete existing parameter presets

Application recommendations
The following functions are available:
Creating parameter presets in Excel (Page 254)
Reusing parameter presets in Excel (Page 254)
You can find information about creating parameter presets in the Web application under:
Parameter presets (Page 161)
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Step-by-step instructions for parameter presets in Excel

Creating parameter presets in Excel

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• The Information Server tab is open in Microsoft Excel.
• A connection to the Information Server is established.

Procedure
1. In the "Create report" dialog, navigate to "Report templates > Templates" in the folder tree.
2. Select the report template for which you want to create the parameter preset. 
3. Configure the report.
4.  Select "Add".
5. Select a name.
6. Select "OK".

Result
The parameter preset has been created.

Reusing parameter presets in Excel

Requirement
• You are a member of one of the following Windows user groups: 

– SIMATIC Report Publishers
– SIMATIC Report Users
– SIMATIC Report Administrators

• The Information Server tab is open in Microsoft Excel.
• A connection to the Information Server is established.
• A default parameter setting has already been created for the report.
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Procedure
1. In the "Create report" dialog, navigate to "Report templates > Templates" in the folder tree.
2. Select the report template for which you want to copy the parameter settings.
3. From the drop-down list next to "Parameter presets", select the preset.
4. Confirm your selection.

Result
The parameter preset is included in Excel.

3.4.3.9 Footer in Excel

Connection status
The footer shows the connection status of the Office add-in. 
There are three different states:
• Connecting: The connection is being established.
• Connected: The connection is established.
• Connection failed: The connection has failed.

Footer in Excel

Definition
The footer shows the connection status of the Office add-in. 
There are three different states:
• Connecting: The connection is being established.
• Connected: The connection is established.
• Connection failed: The connection has failed.

Layout
Check the connection status at the left of the footer.

Checking the connection status (Page 256)
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Step-by-step instructions

Checking the connection status

Requirement
• You are a member of one of the following Windows user groups:  

– SIMATIC Report Publishers 
– SIMATIC Report Users 
– SIMATIC Report Administrators

Procedure
Check the connection status in the footer.
• Connecting: The connection is being established. 
• Connected: The connection is established. 
• Connection failed: The connection has failed. 

Note
No connection to the Information Server 
If there is no connection to the Information Server, check if an appropriate license is available or 
if there are network problems. If necessary, repeat the connection procedure. 
If there is no connection to the Information Server, the commands in the multifunction toolbar 
are not activated.

Result
The connection status is checked.
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